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Introduction

Objectifs

Ce guide a pour but de permettre a I'utilisateur du logiciel Outils Client AccXES
(ACT) d'effectuer ce qui suit :

Se connecter & un scanner et a une imprimante supportée par AccXES en
utilisant I'outil Gestionnaire de périphériques.

Utiliser I'outil Récupération de document pour récupérer et enregistrer les
documents numérisés.

Créer, imprimer et enregistrer des jeux de documents avec I'outil
Soumission de document.

Visualiser et annuler un travail soumis en utilisant I'outil File d’attente de
I'imprimante.

Attribuer des identifications de compte et utilisateur a des travaux
d’'impression et des documents numérisés pour pouvoir enregistrer
I'utilisation de supports dans le contrdleur. Pour le micrologiciel AccXES
version 7.0 et plus récente, ces données seront récupérées et traitées par
I'outil Gestion de comptes AccXES (AMT) ou un autre serveur externe de
facturation.

Sélectionner des options couleur pour I'impression d'images couleur.

Contenu du Guide de l'utilisateur

Ce guide de I'utilisateur contient la configuration minimum requise du systéme ainsi
gue les instructions pour installer et désinstaller le logiciel.

Une initiation rapide est présentée pour faciliter I'utilisation des fonctions principales
du logiciel Outils Client AccXES et pour apprendre les étapes de navigation de base
entre les différents dialogues d’onglet. Chaque oultil est ensuite expliqué en détail et
une rubrique pratique “Utilisation de I'outil...“ se trouve dans chaque section de ce
guide.

Des tableaux récapitulatifs des différentes barres d’outils Soumission de document
et Récupération de document sont donnés, ainsi que des écrans d’aide. Pour plus
de détails, I'utilisateur trouvera une annexe qui récapitule les réglages par défaut et
les acces de navigation pour obtenir les fonctions du logiciel Outils Client AccXES.

Guide de I'utilisateur Outils Client AccXES
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Configuration minimum requise

Un contrdleur AccXES avec micrologiciel de contréleur v 4.0 ou plus avancé, une
imprimante et un scanner supportés par AccXES (pour la numérisation au réseau).
Un rouleaux compatibles avec AccXES et une touche de fonction Numérisation au
réseau couleur. Un disque dur de contréleur 9Go ou supérieur est vivement
recommandé car la numérisation de documents couleur de surface importante
donne des fichiers volumineux qui consomment rapidement I'espace disque. Un
Synergix Scan System peut demander de récupérer les images numérisées du
Répertoire de numérisation pour libérer de la mémoire afin de numériser d’autres
images couleur.

¢ Logiciel Outils Client AccXES.

*  Une station de travail opérant sous Windows 2000/XP ou NT 4.0 (service pack 3
et couleur 16 bits au minimum) ou RedHat Linux dotée d’'un Pentium Intel 90
MHz ou plus (233 MHz recommandés) ou Mac OS X 10.2.x avec Apple
G3/G4/G5 ou une station de travail Sun Sparc opérant sous Solaris v2.6, 2.7,
ou 2.8.

REMARQUE : Le logiciel Outils Client AccXES ne fonctionne pas sur un
réseau Novell.

e Pré-requis supplémentaires du systeme :
- 64 Mo de mémoire
- 30 Mo d’espace libre sur le disque
- Lecteur de CD-ROM (non-requis pour installation a partir du site web XES)
- Souris ou autre dispositif de pointage
- Résolution d’écran : 800x600 ou plus

* Des protocoles et des ports appropriés activés a la fois sur I'imprimante et sur
la station de travail, avec une connexion établie par I'intermédiaire du réseau ou
directement entre 'imprimante et la station de travail.

REMARQUE : Les imprimantes AccXES supportent les types de fichiers
suivants : CalComp, Calsl, Cals2, NIRS, HPGL, HPGL/2, CGM, TIFF, JPEG,
PDF (optionnel), PostScript (option). Ces types de fichiers sont aussi listés sur

I'onglet Configuration > section Format de fichier des options de document
individuel et de document par défaut.



Présentation

L’application Outils Client AccXES (ACT) fonctionne sur PC ou sur station de travail
Solaris. Les outils sont utilisés pour numériser et imprimer des jeux de documents
et une imprimante et un scanner supportés par AccXES. Les outils incluent
Soumission de document, File d'impression, Récupération de document et le
Gestionnaire de périphériques. La fonctionnalité de I'onglet Facturation n’est
disponible que si 'imprimante, avec laquelle le logiciel Outils Client AccXES
interagit, utilise une version du micrologiciel AccXES antérieure & 7.0. Voir les
REMARQUES ci-dessous.

Tous les outils sont installés en méme temps a l'aide du logiciel Install Anywhere.
L’'accés aux outils individuels, apres installation, se fait en sélectionnant un des
onglets indiqués ci-dessous.

[IE2 AccES Chent Tools o [=] B3
‘ Fichier Modifier Affichage Travail Document pérer Gnce Ride
[Soumission de [File i ion | F | Récunération de | Gestionnaire de périnhé |

Sur chaque page d’onglet, I'utilisateur peut sélectionner les boutons et menus de
barre d'outils, ainsi que les options d’écran de dialogue pour personnaliser comment
les documents sont soumis a I'imprimante et récupérés a partir de I'imprimante.
L’onglet File d'impression permet de visualiser la File d'impression.

REMARQUES :

Pour le micrologiciel AccXES version 7.0 et plus récente, I'outil Gestion de
comptes AccXES (AMT) gere les utilisations de supports numérisés ou imprimés
de plusieurs imprimantes. AMT n’est chargé que sur un seul ordinateur.

Tout au long ce guide de I'utilisateur, I'outil Gestion de comptes AccXES
sera utilisé comme exemple de serveur de facturation externe.

Pour les versions de micrologiciel AccXES antérieures a 7.0, I'utilisation des
supports peut étre visualisée sur I'onglet Facturation.

Pour I'accés a certains outils seulement, il suffit de passer au menu Affichage et de
sélectionner les onglets désirés. L'affichage choisi influence les options disponibles
dans 'onglet Gestionnaire de périphériques. L'affichage, ainsi que plusieurs autres
réglages sélectionnés, restent identiques d’une session a l'autre, jusqu’a ce qu'ils
soient modifiés ; comme par exemple, les parametres de réglage de périphérique

sur I'onglet Gestionnaire de périphériques, les préférences de I'onglet Facturation et
les préférences Récupération de document en sont des exemples.

REMARQUE : Plusieurs des options Outils Client AccXES (ACT) peuvent aussi
étre choisies sur le Web PMT ; par exemple, la Composition de page,
I'emboitement de tracé et les étiquettes ou les tampons. Les choix d'option ACT,
s'ils sont différents des sélections d’option Web PMT, sont prioritaires.

L'onglet Gestionnaire de périphériques affiche tous les périphériques
disponibles pour communiquer du PC local au scanner et a I'imprimante
fonctionnant avec AccXES. Les périphériques acceptés par I'outil Soumission de
document sont le réseau, les ports de série, les ports paralléles et Imprimer dans
un fichier. L'outil Récupération de document, la File d'impression et Facturation
utilisent le réseau. L'utilisateur peut ajouter, modifier ou supprimer des
périphérigues de la liste. Le Gestionnaire de périphériques se trouve la ou
I'utilisateur indique quels périphériques, parmi les périphériques affichés, sont
utilisés comme imprimante et scanner par défaut.

L'onglet Récupération de document fournit a l'utilisateur les options pour
récupérer les images numérisées (les fichiers TIF, CALS, ou PDF) a partir du
contrbleur AccXES, ainsi que d’ajouter celles-ci a un jeu de document et de les
enregistrer sur le systéme de fichiers de I'utilisateur. Pour utiliser uniqguement I'outil
Récupération de document, sélectionner Récupération de document sur le menu
Affichage.

REMARQUE : Le fichier de prévisualisation, alors qu'il est toujours placé dans la
mémoire du scanner, est un fichier JPG. Lorsqu'il est sauvegardé a un fichier
systéme, il devient un fichier PJPG.

L’onglet Soumission de document se trouve la ou l'utilisateur crée un jeu de
document en ajoutant des fichiers a la fenétre Soumission de document.
L'utilisateur peut éditer des options de document par défaut, des Options Travail
associées au jeu complet ou des options d'impression de document individuel. Le
jeu de document est envoyé a I'imprimante a partir de la fenétre Soumission de
document. Les jeux de documents peuvent étre enregistrés sous forme de fichier
unique. Pour utiliser seulement I'outil Soumission de document, sélectionner
Soumission de document sur le menu Affichage.

Guide de I'utilisateur Outils Client AccXES
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REMARQUE : Les imprimantes AccXES supportent les types de fichiers
suivants : CalComp, Calsl, Cals2, NIRS, HPGL, HPGL/2, CGM, TIFF, JPEG,
PDF (optionnel), PostScript (option). Ces types de fichiers sont aussi listés sur
I'onglet Configuration > section Format de fichier des options de document
individuel et de document par défaut.

L'onglet File d’'impression permet d’afficher I'état du travail soumis dans la File
d’impression, de changer une priorité de travail et d’annuler un travail d’impression
qui est en cours de transmission. Les travaux discordants sont indiqués en rouge
dans la File d’'impression et sont résolus selon les options sélectionnées dans
Options Travail du logiciel Outils Client AccXES. Pour utiliser seulement I'outil File
d’impression, sélectionner File d'impression sur le menu Affichage.

L’onglet Facturation n’est disponible que si 'imprimante avec laquelle AccXES
Client Tools est en interaction, utilise le micrologiciel AccXES version antérieure a
7.0.

Pour le micrologiciel AccXES versions 7.0 et plus récentes, I'onglet Facturation est
désactivé. Un Serveur de facturation externe suit I'utilisation des supports pour les
multiples imprimantes, d’apres I'ID de I'utilisateur et I'lD de compte spécifiées par
I'utilisateur sur le scanner et I'outil Soumission de document.

Si l'accés a une imprimante se fait par le biais d'un micrologiciel AcCXES version
antérieure a 7.0, I'onglet Facturation est utilisé pour interroger le disque dur du
Contréleur AccXES afin d’obtenir les données d'utilisation des supports pour tous
les travaux imprimés et numérisés. Les résultats peuvent étre affichés dans la
fenétre Facturation du logiciel Outils Client AccXES et sauvegardés dans le
systeme de fichiers. Pour assigner I'utilisation des supports a des comptes
spécifiques, utiliser les numéros de comptes créés sur le WebPMT, l'interface
utilisateur d’'imprimante ou le scanner.




Outils Client AccXES — Présentation du fonctionnement

Le diagramme suivant illustre 'interaction du logiciel Outils Client AccXES avec le systeme de fichiers, le contréleur AccXES, le scanner et I'imprimante adéquats.

SYSTEME DE
FICHIERS

Mémorise les images
extraites enregistrées,
jeux de documents,
options de document
et données d'utilisation
du support

Outils Client AccXES

(chargé sur un PC ou Solaris)

OUTIL GESTIONNAIRE DE PERIPHERIQUES
«  Connecte le PC au scanner et a 'imprimante, via le

contrdleur.

OUTIL RECUPERATION DE DOCUMENT (DRT)

*  Extrait les images numérisées du contrdleur.

¢ Sauvegarde les images extraites dans le systeme
de fixhiers.

*  Envoie les images extraites a I'outil Soumission de
document qui feront partie d’un jeu de document.

OUTIL SOUMISSION DE DOCUMENT (DST)

«  Crée un jeu de document de fichiers uniques sur

le systéme de fichiers ou d'images envoyées par
I'outil Récupération de document.

«  Envoie des jeux de documents a I'imprimante.

*  Sauvegarde un jeu de document sous forme de
fichier unique.

¢ Sauvegarde les options de document sur un
fichier.

e Sélection des options de couleur d'impression.

OUTIL FILE D'IMPRESSION

«  Affiche I'état des travaux dans la File
d’impression.

*  Annule un travail étant transmis a I'imprimante ou
change les priorités d'impression.

OUTIL COMPTABILISATION

¢ (utilisé uniquemment pour les versions antérieures
a 7.0 pour interroger et enregistrer les données
d'utilisation de supports.) Avec le micrologiciel

Contrbleur AccXES

Commande le scanner et
limprimante AccXES.

Enregistre les images
numérisées pour une période
de temps déterminée.

Sauvegarde les données
d'utilisation du support du
scanner de I'imprimante.

Envoie les données de
facturation a I'outil Facturation

Envoie les images
enregistrées au DRT.

Recoit les jeux de documents
du DST et les envde a
l'imprimante.

Envoie les informations d'état
de File d'impression & l'outil
File d'impression.

Guide de I'utilisateur Outils Client AcCXES

Scanner acceptant AcCXES

*  Numérise les images a récupérer a partir
du réseau.

¢ Numérise les images a l'imprimante.

*  Envoie les données d'utilisation de support
numérisées au contréleur.

'

Imprimante acceptant AccXES
¢ Imprime les images numérisées.

¢ Imprime les images/documents envoyés
du DST.

*  Envoie les données d'utilisation de support
au controleur.
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Avant de commencer
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Configuration des connexions réseau

Vérification du protocole

Avant l'installation du logiciel Outils Client AccXES (ACT), s'assurer que le
protocole TCP/IP est utilisé A LA FOIS sur la station de travail et sur limprimante.
Vérifier les protocoles qui sont actuellement activés a la station de travail.
Windows 2000/XP : Cliquer a I'aide du bouton droit de la souris sur Mes
emplacements de réseau. Sélectionner Propriétés. Cliquer a I'aide du
bouton droit de la souris sur Connexion réseau local. Sélectionner
Propriétés.
NT 4.0 : Cliquer a I'aide du bouton droit de la souris sur Voisinage réseau.
Sélectionner Propriétés, puis cliquer a I'aide du bouton gauche de la souris sur
I'onglet Protocoles.
Pour modifier les protocoles & partir d'une configuration de travail existante ou pour
configurer un nouveau protocole, se reporter aux instructions étapes par étapes
données dans le Guide de I'administrateur réseau disponible sur le site Web Xerox
al'adresse suivante : www.xerox.com. (Ne peut se lire qu'avec Adobe Acrobat 3.0
ou une version plus récente).

REMARQUE : Les serveurs d'impression externes (tels que le serveur d'impression
externe Xerox), ne possédant pas de communications bidirectionnelles, sont
utilisés pour la soumission de travaux d’'impression uniguement. Les autres
fonctions du logiciel Outils Client AccXES, telles que la facturation des travaux, la
file d’'impression et la récupération de document ne fonctionneront pas. Ces
serveurs d'impression s ont uniqguement recommandés pour le support
d’environnements réseau autres que TCP/IP.

Sur l'interface utilisateur d’'imprimante ou gestionnaire d’'imprimante Web PMT,
vérifier si les réglages Masque de sous-réseau, Adresse IP et Gateway sont
corrects. Ces réglages sont nécessaires pour que la station de travail puisse
communiquer avec I'imprimante et le scanner acceptant AccXES.

Sur le Gestionnaire d'imprimante Web PMT, sélectionner Valeurs par défaut
de I'imprimante > Réseau > TCP/IP.

Sur linterface utilisateur d'imprimante, sélectionner Configuration ports E/S >
Ethernet TCP/IP > Masque, Passerelle et Adresse TCP/IP.




Installation du logiciel Outils Client
AccXES

REMARQUES :

Pour l'installation sur un réseau, s’assurer que I'unité(par exemple, G:\) ou le logiciel
sera installé est mappée. Sinon ACT sera installé sur le disque C ou un dossier
AccXES sera créé dans les fichiers du programme.

Si le logiciel Outils Client AccXES doit étre utilisé par plusieurs ordinateurs, chaque
ordinateur doit étre mappé a la méme unité.

ACT et AMT peuvent étre installés & partir du méme logiciel d’installation. Les deux
sont désinstallés en méme temps.

Installation pour Windows

A partir du CD-ROM

e Démarrer Windows sur le PC.

* Insérer le CD-ROM Ouitils Client AccXES dans le lecteur. Sélectionner
setup.exe pour commencer l'installation. Le logiciel Installer n'importe ot va
étre chargé.

* Sur I'écran Outils Client AccXES, sélectionner la langue.
Cliquer sur OK.

* Pour installer uniquement le logiciel Outils Client AccXES, il suffit de cliquer
sur SUIVANT sur I'écran Mot de passe. Un mot de passe n’est nécessaire
que pour procéder a l'installation de I'outil de gestion de compte, qui est
expliquée dans le Guide du Responsable de 'Outil de gestion de compte
AccXES.

Guide de I'utilisateur Outils Client AcCXES

* Lire I'Introduction les informations et le contrat de licence, puis cliquer sur
Suivant pour changer d’écran.

*  Sur I'écran “Sélection du dossier d'installation”, cliquer sur Sélectionner pour
sélectionner I'endroit d'installation du logiciel. L'installation par défaut se fait sur
C:\Fichiers de programme\ AccXES. Cliquer sur Suivant.

*  Sur I'écran “Sélection de I'emplacement du raccourci, sélectionner Sur le
bureau, pour pouvoir accéder au raccourci Outils Client AccXES directement a
partir du bureau. (Sinon, chaque fois que le logiciel doit étre utilisé, il faut
sélectionner Démarrer > Fichiers de programme > AccXES>Outils AccXES)
Cliquer sur le bouton Suivant.

*  Sur I'écran “Sélection du jeu d'installation”, sélectionner Outils Client AccXES
puis cliquer sur le bouton Suivant.

e Sur I'écran Installation terminée, cliquer sur le bouton Terminé.

e Siun raccourci a été créé pendant le processus d'installation, il apparait
comme indiqué ici, sur le bureau. L'acces au logiciel peut alors se faire en
cliguant deux fois sur ce raccourci.

REMARQUE : Si ce raccourci n'a pas été créé, il est possible de le faire en
cliqguant a I'aide du bouton droit de la souris sur le bureau Windows. Sélectionner
Nouveau > Raccourci. Sélectionner le bouton Parcourir, puis C:\Fichiers de
programme\AccXES\AccXESTools.exe. Sélectionner le bouton Ouvrir.
Sélectionner Suivant, puis Terminer.
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A partir du Internet

* Désinstaller tout d'abord toute version présente du logiciel Outils client AccCXES
sur le PC.

Télécharger Outils client AccXES du site web de Xerox de la maniére suivante.
e Aller a http://www.xerox.com.

¢ Choisir Support & Pilotes.

¢ Aller a la section Grand format.

e Sélectionner le lien hypertexte qui se rapporte a “AccXES 88xx/ X2-Tech/ 510/
721P".

¢ Sous Type de pilote, sélectionner Pilotes et téléchargements.

e Sélectionner le systéeme d'exploitation et la langue. Appuyer sur le bouton Aller.

* Dans la section Utilitaires & Applications, choisir le lien hypertexte “Outils
client AccXES (ACT) & Outil de gestion de compte AcCXES (AMT).

*  Sélectionner le bouton Démarrer.

e Sélectionner le bouton Ouvrir ou Sauvegarder pour lancer le téléchargement du
fichier comprimé, ce qui peut prendre une heure.

e Cliquer deux fois sur le fichier comprimé téléchargé. Pour Windows, cliquer
deux fois sur le fichier install.exe qui est listé. Le fichier d'installation pour
Solaris est install.bin et pour RedHat, c'est le fichier setup.bin. Sélectionner
OK.

e Sur I'écran Outils client AccXES, sélectionner la langue et OK, puis suivre les
invites de I'écran.

¢ Voir la section CD-ROM ci-dessous pour les détails d'instruction d'installation.

Si Créer une icone sur le bureau n'a pas été sélectionné pendant le processus
d’installation, une icone de raccourci peut encore étre crée sur le bureau. Pour ce
faire, cliquer a I'aide du bouton droit de la souris sur le bureau. Sélectionner
Nouveau> Raccourci. Sélectionner le bouton Parcourir, puis Fichier
programme> AccXES> AccXESTools.exe. Sélectionner Suivant, puis
Terminer.
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Nettoyer installation

Pour procéder a une installation du logiciel Outils Client AccXES, I'application ACT
doit étre désinstallée et le répertoire des préférences Act doit étre retiré
manuellement. Le répertoire des préférences Act a été créé en utilisant TACT
installé précédemment, le désinstallateur ne I'enleve pas.

Le tableau suivant décrit I'emplacement du répertoire des préférences ACT sur les
différentes plate-formes.

REMARQUE : L'enléevement du répertoire cause la perte de tous les réglages de
périphérique de I'utilisateur ’ACT.

Type de plate- Emplacement du répertoire des

forme préférences XES

Windows NT C:\WINNT\Profiles\<User Name>\XES\Act

Windows 2000/XP  C:\Documents and Settings\<User
Name>\XES\Act

Solaris <home directory>/.XES/Act

RedHat Linux 8.0 <home directory>/.XES/Act

Mac OS X 10.2.x <home directory>/.XES/Act

REMARQUE : Windows 95/98 ne sont plus officiellement supportés.



Installation pour UNIX

La procédure d'installation suivante est requise pour I'environnement Solaris 2.6,
2.7, ou 2.8 de UNIX.

Outils Client AccXES, Version 10.0: Avec Solaris, il est nécessaire de
télécharger les versions provisoires pour JVM 1.3 a partir d’Internet. Se reporter a
I'adresse suivante : http://java.sun.com/products/archive/j2se/1.4.0/index.html. Il est
trés important d’installer le numéro de version provisoire 105633 afin que les polices
s’affichent correctement.

A partir du CD-ROM

¢ Démarrer la station de travail UNIX et ouvrir une session sur le bureau.

* Insérer le CD-ROM Outils Client AccXES dans le lecteur.

¢ Dans la fenétre de commande, taper:
cd <cd+om mount point>
Jsetup.bin

REMARQUE : Dans tous les cas <endroit ou le CD-ROM est monté>
correspond au répertoire ou le CD-ROM est monté.

¢ Le logiciel Installer n'importe ou se charge.

*  Sur I'écran Outils Client AccXES, sélectionner la langue.
Cliquer sur OK.

¢ Pourinstaller uniqguement le logiciel Outils Client AccXES, cliquer sur SUIVANT
sur I'écran Mot de passe. Un mot de passe n’est requis que lors de l'installation

de I'outil Gestion de comptes, qui est expliqguée dans le Guide de l'utilisateur du

Gestionnaire d'imprimante Web PMT.

e Lire I'Introduction, le contrat de licence et les écrans d'information, puis cliquer
sur Suivant pour changer d’écran.

*  Sur I'écran “Sélection du dossier d'installation”, cliquer sur Sélectionner pour
choisir I'endroit d'installation du logiciel. Cliquer sur Suivant.
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*  Sur I'écran “Sélection de I'emplacement du raccourci”, sélectionner
I'emplacement du raccourci. Sur Unix, il ne peut étre placé sur le bureau.
Cliquer sur Suivant.

e Sur I'écran “Sélection du jeu d'installation”, sélectionner le bouton Outils client
AccXES et cliquer sur le bouton Suivant. Sur I'écran Installation terminée,
cliquer sur le bouton Terminé.

* Retirer le CD-ROM Outils Client AccXES.
REMARQUES :

Le logiciel Outils Client AccXES ne supporte pas de port paralléle sur Solaris; il
ne sera donc pas listé sur I'onglet Gestionnaire de périphériques.

Lorsque le logiciel Outils Client AccXES est utilisé sous Solaris version 2.6 et
2.7, les touches fléchées fonctionnent & l'aide des touches de direction du
clavier numérique au lieu des touches fléchées du clavier.

A partir du Internet

Pour installer I'application sur un systéme Solaris avec un navigateur web :
e Démarrer la station de travail UNIX et ouvrir une session sur le bureau.

e Télécharger le logiciel Outils Client AccXES a partir du site Xerox, a I'adresse
http://www.xerox.com. (Consulter les instructions dans la section Windows,
intitulée “A partir du internet”.)

*  Choisir le répertoire pour le téléchargement du fichier.
*  Accéder au répertoire ou le téléchargement a été effectué.
* Dans une fenétre de controle, taper ./install.bin

e Suivre les instructions sur I'écran pour terminer I'installation. Le logiciel
d'installation affiche un écran de garde et demande un répertoire d'installation
pour le logiciel Outils Client AccXES et les fichiers associés.

e  Pour ouvrir le logiciel Outils Client AccXES, taper AccXESToolsdans le
répertoire ou le logiciel est installé.
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Installation pour Mac OS X

14

Installation pour RedHat

A partir du CD-ROM

Pour installer cette application sur un systeme MacOSX, insérer le CD-ROM dans
le lecteur de CD-ROM et entrer les commandes suivantes :

* Au niveau supérieur du CD d'installation, cliquer a droite sur "setup.zip".
* Sélectionner "Copier "setup.zip".

* Cliquer a droite sur le Bureau et sélectionner "Coller I'élément".

* Cliquer deux fois sur "setup.zip" sur le bureau.

* Apres avoir étendu l'archive, cliquer deux fois sur “installer” sur le bureau.

Pour installer I'application sur un systéme MacOSX a l'aide d'un navigateur web,
insérer le CD-ROM dans le lecteur de CD-ROM et charger /AccXES/install.htm
dans le navigateur. Suivre les instructions sur la page web. (Dans tous les cas est
le répertoire ou le CD-ROM est installé. Noter que ces commandes peuvent différer
de celles indiquées ci-dessous, selon la version de MacOSX utilisée. Les
commandes indiquées ici sont pour MacOSX 10.3.x.)

A partir du Internet

e Télécharger le logiciel Outils Client AccXES a partir du site Xerox, a
I'adresse http://www .xerox.com. (Consulter les instructions dans la section
Windows, intitulée “A partir du internet”.)

A partir du CD-ROM

Pour installer une application sur un systeme RedHat 8, insérer le CD-ROM dans le
lecteur de CD-ROM et entrer les commandes suivantes :

* cd /AccXES/InstData/Linux/VM/

* Jinstall.bin

ou

*cd

* Isetup.bin
Pour installer I'application sur un systéeme Linux a l'aide d'un navigateur web, insérer
le CD-ROM dans le lecteur de CD-ROM et charger /AccXES/install.htm dans le
navigateur. suivre les instructions sur la page web. (Dans tous les cas est le
répertoire ou le CD-ROM est installé. Noter que ces commandes peuvent différer de
celles indiquées ci-dessous, selon la version de Linux utilisée. Les commandes
indiquées ici sont pour un systéme RedHat 8.)

REMARQUE : Pour installer une version d'une autre langue de I'application ACT-
AMT au méme répertoire, il faut tout d'abord désinstaller I'application ACT- AMT
existante.

A partir du Internet

Télécharger le logiciel Outils Client AccXES a partir du site Xerox, a I'adresse
http://www.xerox.com. (Consulter les instructions dans la section Windows,
intitulée “A partir du internet”.)



Désinstallation du logiciel Outils Client
AccXES

REMARQUES : Fermer le logiciel Outils Client AccXES et I'Outil de gestion de
comptes, avant de démarrer le logiciel de désinstallation. Le programme de
désinstallation doit toujours étre exécuté en dehors des répertoires d'installation. La
désinstallation du logiciel Outils Client AccXES supprime seulement les fichiers qui
ont été installés par le logiciel. Les fichiers, images, données, préférences
utilisateur, etc. qui ont été créés par I'utilisateur ou I'application ne sont pas
supprimés. L'Outil de gestion de comptes va également étre désinstallé, s'il se
trouve sur la station de travail, mais les fichiers de la base de données sont
préservés.

Windows
Pour désinstaller le logiciel Outils Client AccXES pour Windows 2000/XP et NT 4.0 :

e Sélectionner Démarrer > Réglages > Panneau de configuration >
Ajout/Suppression de programmes.

* Dans laliste du logiciel, sélectionner AccXES. Cliquer sur Ajouter/Supprimer.

* Le programme de désinstallation InstallAnywhere s’affiche. Cliquer sur
Désinstaller.

¢ Un message ‘Désinstallation terminée” s’affiche une fois le logiciel désinstallé.
Cliquer sur Quitter.

REMARQUE : Le programme de désinstallation supprime le répertoire de
travail en cours, les Outils client AccXES et le logiciel d’Outil de gestion de
comptes du PC.

¢ Sils ne sont plus utilisés, il est aussi possible de supprimer les dossiers dans
lesquels les fichiers ont été enregistrés. (Se reporter a la section “Nettoyer
installation “ de ce guide, pour plus de détails.)
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UNIX

Le programme de désinstallation doit toujours étre exécuter en dehors des
répertoires d’installation. Si le programme Uninstall_AccXES est exécuté dans le
répertoire AccXES/UninstallerData de Unix, le répertoire de travail AccXES et le
sous-répertoire ouverts seront supprimés. Les fonctions normales du répertoire ne
pourront plus étre utilisées (c-a-d., Is ou cd).

Pour désinstaller le logiciel Outils Client AccXES :

* Dans une fenétre de commande, exécuter les commandes suivantes :
cd<application install directory>/Uninstaller Data/ ./Uninstall_AccXES
ou <application install directory> correspond au répertoire dans lequel
I'application ACT était placée a I'origine.

REMARQUE : Le programme de désinstallation supprime le répertoire de
travail en cours, les Outils client AccXES et le logiciel d’Outil de gestion de
comptes du PC.

e Il est aussi possible de supprimer les dossiers dans lesquels les fichiers ont
été enregistrés s'’il n’est plus nécessaire d'y accéder. (<home
directory>/.XES/Act).
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MacOSX

Pour désinstaller I'application sur un systéme APple G3/G4/G5, exécuter les
commandes suivantes :

cd /UninstallerData/

* /Uninstall_AccXES

ou

* Naviguer vers le répertoire d'installation AccXES en utilisant l'interface
utilisateur OSX de Apple.

* Cliquer deux fois sur l'icone "Uninstall_AccXES" dans UninstallerData.

(Ou est le répertoire dans lequel InstallAnywhere a placé I'application Java a l'origine.

Noter que ces commandes peuvent différer de celles indiquées ci-dessus, selon la
version MacOSX utilisée. Les commandes indiquées ici sont pour le systeme
MacOSX 10.2.8.)
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RedHat

Pour désinstaller I'application sur un systeme RedHat Linux, exécuter les
commandes suivantes :

* cd /UninstallerData/
* /Uninstall_AccXES

(Ou est le répertoire dans lequel InstallAnywhere a placé I'application Java a I'origine.
Noter que ces commandes peuvent différer de celles indiquées ci-dessus, selon la
version de Linux utilisée. Les commandes indiquées ici sont pour un systeme
RedHat 8.0.)



Imprimer une impression test
Configuration

e Pour vérifier les parametres de communication de I'imprimante, imprimer une
impression test CONFIGURATION a partir de l'interface utilisateur de
limprimante ou du Web PMT en sélectionnant le bouton Valeurs par défaut
de I'imprimante>Impression test>Minimal. Les données d'impression test
vont refléter le matériel installé, les touches de fonctions installées et la version
du micrologiciel AccXES..

e L’acceés a la fonction Facturation nécessite un permis d'utilisation Facturation
des travaux. Un permis d’utilisation Numérisation au réseau est nécessaire
pour numériser les documents au réseau et pour les récupérer a I'aide de I'outil
Récupération de document. Les fonctions Facturation et Numérisation au
réseau doivent aussi étre activées sur I'imprimante. Un code de licence de
fonction Couleur est nécessaire pour numériser des images couleur.

e Se reporter a la zone supérieure gauche de I'impression test pour localiser la
version du micrologiciel AccXES utilisée par I'imprimante. Cette version est
également visible dans la section Identification de I'imprimante de I'onglet
Gestionnaire de périphériques.
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Initiation rapide

Généralités

Une fois le logiciel Outils Client AccXES installé, une imprimante et un scanner
accommodant AccXES doivent étre connectés en utilisant I'outil Gestionnaire de
périphériques. Il est alors possible de numériser et de récupérer des documents en
utilisant I'outil Récupération de document. Les documents numérisés et récupérés
peuvent étre pré-affichés, enregistrés sur le systeme de fichiers ou ajoutés a un jeu
de document. Un jeu de document peut étre créé en ajoutant des documents
individuels a I'outil Soumission de document, il peut ensuite étre envoyé a
I'imprimante ou enregistré sous forme de fichier unique sur le systeme de fichiers.
L’état du travail envoyé a I'imprimante peut étre visualisé en utilisant I'outil File
d’impression.

Pour utiliser la fonction Facturation, la facturation du travail doit étre activée. Pour le
micrologiciel AccXES, version 7.0 et plus récente, I'onglet Facturation est
désactivé. L'outil Gestion de comptes AccXES geére les utilisations de supports de
plusieurs imprimantes, en fonction des identifications de comptes et utilisaeur
spécifiées au scanner et sur I'outil Soumission de document.

L'initiation rapide qui suit représente une introduction ainsi qu’un apprentissage de
chacune des fonctions de base du logiciel.
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Initiation rapide par étapes

Installer le logiciel Outils Client AccXES
* Utiliser le CD-ROM ou le télécharger a partir du site web xerox.com.

Configurer les connexions de réseau a l'interface utilisateur d'imprimante ou au
Gestionnaire d'imprimante Web PMT, afin que les réglages Masque de sous-
réseau, Adresse IP et Passerelle soient corrects. (Se reporter a la section
“Configurer les connexions de réseau” de ce guide pour plus de détails.)

Ouvrir le logiciel Outils Client AccXES de la fagon suivante.

¢ Cliquer deux fois sur I'icone du bureau ou sélectionner Démarrer >
Programmes > AccXES > Outils AccXES.

¢ Parcourir chacune des Initiations rapides pour connaitre les rudiments de
chaque outil. Pour une aide plus détaillée, se reporter aux sections
“Utilisation de I'outil...” de ce guide de I'utilisateur. Voir également Annexe 5
pour la liste des fonctions et leur emplacement.



Initiation rapide — Outil Gestionnaire de périphériques

Sélectionner I'onglet Gestionnaire de périphériques.

Cliquer sur le Nom de périphérique de I'imprimante et du scanner acceptant
AccXES et avec lesquels la communication avec le PC sera établie.

Dans les colonnes Imprimante par défaut et Scanner par défaut, sélectionner
les périphériques par défaut qui seront utilisés par le logiciel Outils Client
AccXES.

;‘é Si le périphérique avec connexion & I'imprimante et au scanner réseau

n'est pas listé, sélectionner le bouton de la barre d’outils Créer un nouveau
périphérique. Dans la section Réseau au bas de I'écran, taper le nom choisi
pour le périphérique et son adresse IP .

ﬁ
.—E Sélectionner le bouton de la barre d’outils Accepter les parametres
de périphérique pour I'enregistrer dans la liste de périphériques, puis le
sélectionner comme imprimante par défaut. Sélectionner également le scanner
par défaut. Les informations sur le nom du périphérique, I'adresse IP et
I'identification d’imprimante apparaissent dans les sections inférieures de
I'écran.

Pour une aide plus détaillée, se reporter a la section “Utilisation de I'outil
Gestionnaire de périphériques*” de ce guide.

Guide de I'utilisateur Outils Client AcCXES

Initiation rapide — Outil Récupération de document

Avant d'utiliser cet outil, configurer les connexions de réseau. Sélectionner le
scanner par défaut sur I'onglet Gestionnaire de périphériques. Disposer des
informations d'identification du répertoire de numérisation du contréleur. (Pour le
micrologiciel AccXES versions antérieures a 7.0, le répertoire de numérisation est le
numéro de compte et de sous-compte.) Activer Créer apercu, sur le scanner.

REMPLIR |IES OPTIONS DE RECUPERATION

Sélectionner I'onglet Récupération de document.

Dans la zone Répertoire de numérisation, taper l'identificateur de répertoire qui
sera utilisé avec le scanner lors de la numérisation d'images (pour les versions
du micrologiciel AccXES antérieures a 7.0, entrer le numéro de compte). Ceci
permet d’extraire les images numérisées qui ont été attribuées a ce répertoire
bien précis.

Dans la zone Préfixe de fichier, ajouter le préfixe qui apparaitra au début de
chaque nom de fichier créé au cours de I'extraction d’une image numérisée.
“MYSCAN?” est le préfixe par défaut.

Dans la zone Répertoire de récupération, utiliser le bouton Parcourir pour
localiser le répertoire et le dossier, dans le systéme de fichiers, dans lesquels
les images récupérées seront enregistrées.

NUMERISATION DES IMAGES/DOCUMENTS

Avant de numériser les images, si I'utilisation des supports doit étre chargée a
un compte spécifique afin d’en garder le suivi par le Serveur de facturation
externe, Facturation doit tout d’abord étre défini sur “Facultatif’ ou “Activé” sur
I'écran Facturation du Web PMT ou sur le scanner ou l'interface utilisateur de
'imprimante.

Pour sélectionner le format de fichier pour une numérisation en couleur,
appuyer sur le bouton Mode pour sélectionner "Mode de numérisation™.
Passer & Qualité d’'image sur le panneau de commande du scanner et
sélectionner Photo & Normal. Sur I'écran du panneau de commande du
scanner, sélectionner la touche Suivant > Format > la touche Entrer >JPEG
ou TIFF > la touche Entrer.
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Au scanner, entrer une ID utilisateur et une ID de compte. (Pour le
micrologiciel AccXES versions antérieures a 7.0, entrer le numéro de compte et
de sous-compte).

Appuyer sur le bouton Mode pour sélectionner "Mode de numérisation®.

Pour le micrologiciel AccXES 7.0 ou plus récent, entrer le nom du Répertoire
de numérisation.

Numeériser plusieurs images. Elles seront temporairement stockées dans le
répertoire de numérisation spécifié sur le disque dur du Controleur, jusqu’'a ce
qu’elles soient récupérées sur I'ordinateur.

RECUPERATION ET SAUVEGARDE DES DOCUMENTS NUMERISES

Aller a 'ordinateur.

@:’ Si des images JPEG ont été numérisées a partir du scanner,
sélectionner le bouton de barre d’outils Options de récupération. A partir du
menu déroulant, sélectionner I'extension de fichier attachée aux images JPEG
qui seront récupérées du scanner. Sélectionner le bouton OK.

III Sur I'onglet Récupération de document, sélectionner le bouton de la
barre doutils “Lister I'image...". Les titres des images qui sont numérisées
seront listés dans la fenétre Image. Elles restent encore dans le contrdleur.

Sélectionner le bouton de la barre d'outils “‘Récupération de toutes les
images numérisées ...". Les images s eront extraites du contrleur, avec un
apercu de chacune si I'option par défaut du scanner “Créer un apergu” est
sélectionnée et si le réglage de récupération par défaut “Apercu automatique”
du logiciel Outils Client AccXES est activé.

Cliquer avec le bouton droit de la souris sur un nom de fichier retrouvé et
sélectionner Renommer pour lui redonner un nom.

Cliquer avec le bouton droite de la souris sur un autre nom de fichier extrait et
sélectionner Supprimer.
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LB sélectionner le bouton de la barre d'outils “Enregistrer toutes les
images...”. Toutes les images listées dans la fenétre Récupérer qui ont été
enregistrées dans le systeme de fichiers a 'emplacement choisi dans la zone
Répertoire. Elles y ont été enregistrées lorsqu’elles sont entrées dans la fenétre
Récupérer. Les fichiers de prévisualisation .jpg seront modifiés en fichiers .pjpg
lorsqu'ils seront sauvegardés au systeme de fichiers.

Pour un apprentissage plus précis, se reporter a la section “Utilisation de I'outil
Récupération de document” de ce guide.

Passer au tableau “Bouton de barre d’outils DRT et choix de menus* dans ce
guide pour s'initier rapidement aux fonctions DRT.

Se reporter a ’Annexe pour le tableau des réglages par défaut et des accés de
navigation aux différentes options du logiciel Outils Client AccXES.



Initiation rapide — Outil Soumission de document

Avant d'utiliser cet outil, configurer les connexions de réseau. Sélectionner
imprimante par défaut sur I'onglet Gestionnaires de périphériques. Il est nécessaire
d’avoir a disposition les informations ID utilisateur et ID de compte. (Pour le
micrologiciel AccXES versions antérieures a 7.0, disposer d’'un numéro de compte
et de sous-compte.)

Sélectionner I'onglet Soumission de document.

i'_l;'h Cliquer sur le bouton de la barre d’outils Ajouter un document pour
passer a la fenétre Ajouter un document. Dans le menu déroulant “Regarder
dans”, sélectionner le disque et le dossier ou se trouvent les fichiers
correctement formatés (voir Remarque ci-dessous). Sélectionner chaque nom
de fichier a ajouter a I'’écran Soumission de document, en cliquant pour chacun
sur le bouton Ajouter. Pour sélectionner plusieurs documents, maintenir
appuyées les touches Maj et CTL tout en sélectionnant les fichiers dans I'ordre
dans lequel ils sont listés dans la fenétre. Cliquer sur Terminer quand les
sélections sont terminées. Les fichiers seront listés dans la fenétre Soumission
de document.

REMARQUE : Les imprimantes AccXES supportent les types de fichiers
suivants : CalComp, Calsl, Cals2, NIRS, HPGL, HPGL/2, CGM, TIFF, JPEG,
PDF (optionnel), PostScript (option). Ces types de fichiers sont aussi listés sur
I'onglet Configuration > section Format de fichier des options de document
individuel et de document par défaut.

Passer a la section Travail au bas de I'écran. Entrer I'ID utilisateur et I'ID de
compte auxquels le travail d'impression sera rattaché. L’outil Gestion de
comptes AccXES obtiendra les informations d’ouverture de session du disque
dur du Controleur. (Pour le micrologiciel AccXES versions antérieures a 7.0,
seule la zone ID de compte s’affiche pour pouvoir entrer le numéro de compte et
de sous-compte. Sélectionner 2 copies, Ordre d'impression inverse et
Assemblage inverse si les documents sont chacun sur une seule page. Deux
jeux de documents assemblés sont ainsi obtenus avec les documents empilés
dans I'ordre correspondant a celui de la liste de la fenétre Soumission de
document.

Voir Annexe 3 pour consulter les résultats d’un choix de différentes
combinaisons d’Assembler et Ordre d'impression inverse pour des documents
contenant plus d'une page. Voir Annexe 4 pour consulter les résultats d’'une
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impression de fichiers PostScript avec réglages pour les options d’assemblage
et de finition.

B3 |
= Sélectionner le bouton de la barre d’outils “Imprimer un jeu de

document” pour envoyer ce jeu de document a I'imprimante sous forme de
travail d'impression unique.

Cliquer deux fois sur un nom de fichier de la fenétre Soumission de document.

Changer certaines de ses options sur les différents onglets. Sur 'onglet

Configuration, dans la zone Description, taper a titre de référence les

changements effectués. Ceci apparaitra dans la colonne Options de la fenétre

Soumission de document, a coté du fichier dans lequel les options ont été

changées. Un “X” signifie que la colonne est modifiée. Les changements ne

s’appliquent qu’au document sélectionné.

Essayer de copier les mémes changements d’option dans un autre document

listé. Pour ce faire, mettre en évidence le document modifié. Sélectionner le

menu de la barre d’'outils Document > Options Copier. Mettre en évidence le

document dans lequel les options seront copiées. Sélectionner Document >

Options Coller.

Cliquer deux fois sur un document, dans la fenétre Soumission de document,

ayant un X a coté dans la colonne par défaut. Noter quelques réglages d’option.

Fermer les écrans de dialogue.

Sélectionner le bouton de la barre d’outils Modifier les options par
défaut et effectuer quelques changements. Retourner au méme document.
Remarquer que les options modifiées dans les options du document par défaut
changent aussi pour ce document qui utilise les réglages par défaut. Les
changements apparaitront dans tous les documents listés qui utilisent les
options par défaut. Ces changements s'appliquent aussi a tous les nouveaux
documents ajoutés au jeu. Pour vérifier ceci, ajouter un autre document, puis
cliquer deux fois sur celui-ci dans la fenétre Soumission de document.
Remarquer que les mémes changements sont présents.

&)

Sélectionner le bouton de la barre d’outils Options Travail. Toutes les
zones qui se trouvent sur I'onglet Configuration se trouvent également sur
I'onglet Soumission de document. Si des entrées sont effectuées dans 'un de
ces deux emplacements, ces entrées auront également lieu dans l'autre
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emplacement. Effectuer d’autres changements au travail d'impression, comme
par exemple en sélectionnant Assembler ou en changeant le nombre
d’exemplaires. Sélectionner OK pour Enregistrer les changements.

Oy |
= Sélectionner le bouton de la barre d’outils Imprimer un jeu de
document pour envoyer ce jeu de document révisé a I'imprimante comme un
seul travail d’impression. Remarquer les résultats des options de document et
de travail par défaut modifiées lors de la réception du jeu de document aprés
impression.

Se reporter a la section Outil Facturation de cette Initiation rapide pour savoir
comment récupérer les données d'utilisation de support pour les travaux
envoyés.

Pour Enregistrer le jeu de document, sélectionner Fichier > Enregistrer pour
choisir le répertoire, le dossier et le nom de fichier.

Sélectionner Fichier > Nouveau pour annuler la fenétre Soumission de
document afin d’essayer de créer un autre jeu de document ou d’ouvrir un jeu
déja créé.

Pour un apprentissage plus précis, se reporter a la section “Utilisation de I'outil
Soumission de document“ de ce guide.

Passer au tableau “Bouton de barre d'outils DRT et Choix de menus dans ce
guide pour s'initier rapidement aux fonctions de I'outil Soumission de document.

Se reporter a I'’Annexe pour le tableau des réglages par défaut et des acces de
navigation aux différentes options du logiciel Outils Client AccXES.
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Initiation rapide — Outil File d'impression

Avant d'utiliser cet outil, configurer les connexions de réseau. Sélectionner
imprimante par défaut sur I'onglet Gestionnaire de périphériques.

Sélectionner 'onglet File d'impression.

l Sélectionner le bouton de la barre d’outils Obtenir la liste des travaux
actifs et terminés dans la file d’attente. La liste des travaux actifs et
terminés s'affiche. Au bas de I'écran se trouvent les informations sur la largeur,
le type et I'état du support pour chaque rouleau se trouvant dans I'imprimante.

Soumettre un travail d'impression a partir de la fenétre Soumission de
document, puis sélectionner rapidement I'onglet File d'impression.

n' Appuyer sur le bouton de la barre d’outils “Obtenir la liste des
travaux actifs dans la file d’attente” pour voir I'état du tavail envoyé. L'état
sera mis & jour chaque fois qu'un des deux boutons ‘Obtenir..." est appuyé.

@ ‘ Soumettre un autre travail d'impression, puis sélectionner rapidement

I'onglet File d'impression. Appuyer sur le bouton de barre d’outils ‘Obtenir la
liste des travaux actifs dans la file d’attente” pour connaitre I'état du travail
envoyé. Annuler le travail en appuyant sur le bouton de la barre d'outils Annuler
le travail d’'impression sélectionné. Un message au bas de I'écran donne
des informations sur la transmission du travail a I'imprimante. Si le travail est
déja dans I'imprimante, il faudra I'annuler a l'interface utilisateur ou a partir de la
page principale du Gestionnaire d’imprimante Web PMT en sélectionnant le titre
du travail afin d’obtenir la fenétre Annuler.

Pour un apprentissage plus précis, se reporter a la section “Utilisation de I'outil
File d'impression“ de ce guide.



Initiation rapide — Outil Facturation

Se reporter a la section Identification de I'imprimante de I'onglet Gestionnaire de
périphériques pour savoir quelle est la version d’imprimante (micrologiciel AccXES)
sélectionnée par le périphérique.

Pour le micrologiciel AccXES versions 7.0 et plus récentes, I'outil de
facturation du logiciel Outils Client AccXES est désactivé. Par contre, I'outil Gestion
de comptes (AMT) sera installé sur un seul ordinateur pour suivre I'utilisation des
supports de plusieurs imprimantes. L’Administrateur AMT génere les détails
d'utilisation des supports pour tous les supports imprimés et les images
numeérisées. Ceci est effectué d’aprés I'ID utilisateur et I''D de compte spécifiées au
scanner ou lors de I'utilisation de I'outil Soumission de document. Ces informations
sont mémorisées temporairement sur le disque dur du Contréleur. L’outil Gestion de
comptes récupeére les informations du Contréleur. Il est néanmoins possible de
visualiser le nombre total de dossiers actuellement mémorisés en consultant la
page de facturation du Web PMT, dans la zone Nombre d’enregistrements.
L’Administrateur AMT doit se reporter au Guide de I'utilisateur de I'Outil de gestion
de comptes pour savoir comment installer et utiliser I'outil.

e Pour les versions du micrologiciel AccXES antérieures a 7.0, utiliser
I'onglet Facturation comme suit. A partir de l'interface utilisateur d’imprimante,
du Gestionnaire d'imprimante Web PMT, ou de I'interface utilisateur du
scanner, régler Mode de facturation sur “Activé” ou “Facultatif’. La sélection

“Activé” nécessite I'entrée d’'un numéro de compte pour chaque impression ou
numeérisation.

¢  Sélectionner I'onglet Facturation du logiciel Outil client AccXES.

¢ Dans la zone Mot de passe, taper un mot de passe si celui-ci est demandé sur
le scanner ou I'imprimante.

¢ Dans la zone ID du compte, mettre le numéro de compte avec lequel les
données d'utilisation du support seront retrouvées, comme 3.1 ou le numéro de
compte donné dans les Options Travail > Onglet Configuration > Zone Numéro
de compte et dans Récupération de document > Zone Numéro de compte. Pour
retrouver les données d'utilisation du support de tous les comptes, utiliser —1
comme numéro de compte et entrer un mot de passe. Utiliser “0” comme mot
de passe par défaut.
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101010,

. Sélectionner le bouton de la barre d’outiisDemander a l'imprimante
les données du compte. Les données d'utilisation du support, pour le numéro
de compte spécifié, seront indiquées sur la fenétre Facturation.

. @ Pour Enregistrer ces données dans un fichier, sélectionner le bouton
de la barre d'outils Ecrire les données de compte au fichier. Sur I'écran
Rapport de compte, zone Fichier de sortie, mettre un répertoire et un dossier
dans lesquels le fichier sera Enregistrer, suivi par un nom de fichier avec une
extension .xlIs (pour utilisation dans un tableur Microsoft Excel).

*  Pour un apprentissage plus précis et pour apprendre & créer un rapport a partir
des données d'utilisation du support enregistrées, se reporter a la section
“Utilisation de I'outil Facturation de ce guide.

*  Se reporter & '’Annexe pour le tableau des réglages par défaut et des acces de
navigation aux différentes options du logiciel Outils Client AccXES.

La section suivante de ce guide donne plus de détails sur chacun des Outils Client
AccXES.
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Outil Gestionnaire de Boutons de barre d’outils DMT

périphériques*

Ci-dessous, un récapitulatif des fonctions de chaque bouton de la barre d'outils.

L’outil Gestionnaire de périphériques (DMT) liste tous les périphériques (imprimante
et scanner) avec lesquels le logiciel Outils Client AccXES de la station de travail

peut se connecter. Le graphique ci-dessous, indique les choix d’un utilisateur, avec E | Q rk ‘ ﬁ *
les détails pour le périphérique sélectionné et présenté dans la section Réseau au JEi g g E

bas de I'écran.
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Se reporter aux pages suivantes pour plus de détails.

Sections de I'onglet Gestionnaire de
périphériques

L'onglet Gestionnaire de périphériques contient les sections suivantes (du haut vers
le bas) :

e Boutons de barre d’outils- Les commandes incluent Créer un nouveau
périphérique, Modifier périphérique sélectionné, Accepter les paramétres du
périphérique, Annuler I'activité en cours, Supprimer un périphérique
sélectionné, Obtenir ID d'imprimante, Mettre a jour I'ID imprimante et
tous les périphériques réseau, Afficher paramétres de relance et Aide.

e Section Périphériques disponibles - La liste des périphériques
disponibles affiche les imprimantes et scanners disponibles. La liste inclut
automatiquement les imprimantes pouvant étre connectées a des ports
locaux (identifiées par une étiquette de port local tel que LPT1) et Imprimer
au fichier. Les imprimantes et scanners en réseau figurent apres les
imprimantes locales. lls peuvent étre ajoutés, modifiés ou effacés.

Les onglets Soumission de document, File d'impression et Facturation
utilisent 'imprimante par défaut pour communiquer avec une imprimante.

L’onglet Facturation et I'onglet File d'impression ne sont pas capables de
communiquer de fagon bidirectionnelle avec I'imprimante lorsqu'il y a
sélection d’'une imprimante & port paralléle ou Imprimer au fichier.

L’onglet Récupération de document utilise le scanner par défaut choisi pour
sa communication bidirectionnelle avec un scanner réseau.

e Section Réseau - Cette section affiche les propriétés du périphérique
sélectionné. Les parametres affichés dépendent du type de connexion du
périphérique (paralléle, série ou réseau). Pour une imprimante avec port série
ou paralléle, les parameétres ne peuvent pas étre modifiés. Pour un périphérique
réseau, le Nom du périphérique et I'’Adresse IP, ainsi que la case
“Communications AccXES vers client” peuvent étre modifiés. Lors de 'édition
ou de la création d’'un périphérique réseau, il est possible de désélectionner
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cette case si le périphérique ne supporte pas la communication bidirectionnelle,
par exemple lors de la connexion a un serveur d'impression externe. Si cette
case est désélectionnée, I'Outil de gestion de périphérique ne va pas tenter
d’obtenir les informations d’identification de I'imprimante du périphérique réseau.
Il va plutét lister afficher la derniere facturation identique a celle du périphérique
réseau le plus récemment mis a jour. Lorsque cette case est désélectionnée, il
ne sera pas possible d'utiliser la file d'impression ou I'Outil de facturation (les
boutons de barre d’outil ne peuvent pas étre activés).

Pour Imprimer au fichier, aller a la section Imprimer au fichier ci-dessous.

Section Identification de 'imprimante (pour Outils Client AccXES, version

7.0 et plus récente). Cette fonction est nécessaire pour déterminer quelle
version du micrologiciel AccXES l'imprimante utilise. Pour la version 7.0 et plus
récente, I'onglet Facturation sera désactivé et I'outil Gestion de comptes
AccXES sera utilisé pour les fonctions de facturation. Si la version du
micrologiciel AccXES est antérieure a 7.0, les fonctions de facturation du
logiciel Outils Client AccXES peuvent encore étre utilisées.

Si Outils Client AccXES est la premiere installée, le logiciel essaie de mettre a
jour les informations d’identification d’imprimante pour tous les périphériques en
réseau listés dans I'onglet Gestionnaire de périphérique.

Les périphériques de port série (COM1, COM2) ne sont pas mis a jour lorsque
le logiciel Outils Client AccXES est installé ; par conséquent, le modéle et la
version d'imprimante apparaissent comme “INCONNUS". Avant d'utiliser un
périphérique de port série comme imprimante par défaut, I'utilisateur devra
mettre a jour les informations d’identification de I'imprimante en appuyant sur le
bouton de la barre d’'outils Obtenir ID d’imprimante.

Lorsqu’un périphérique ne supportant pas la communication bidirectionnelle
(LPT1, LPT2, ou Imprimer au fichier) est sélectionné, les informations
d’identification de I'imprimante du dernier périphérique bidirectionnel s’affichent
dans la section Identification de I'imprimante.

Si un nouveau périphérique est ajouté a la liste de Nom de périphérique, le
logiciel se connecte a I'imprimante, lit Iidentification d'imprimante et place ces
informations dans la section Identification de I'imprimante. Un message d’erreur
apparait si le logiciel ne peut établir une connexion avec I'imprimante.
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¢ Laligne Etat du périphérique (au bas de I'écran) - Affiche I'état de la commande
apres avoir appuyé sur les boutons de barre d'outils. Cliquer sur le bouton
Annuler dans cette ligne pour annuler la commande.
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Utilisation de I'outil Gestionnaire de
périphériques

Ajout d’'un nouveau périphérique

Il est uniquement possible de créer de nouveaux périphériques avec connexions aux
imprimantes et scanners de réseau.

E Sélectionner le bouton de la barre d’outils Création d’un nouveau

périphérique .
Le dialogue Périphérique de réseau suivant s'affiche.
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Taper le nom de périphérique et I'adresse IP.

r

g Accepter les informations et la liste des types de supports acceptés (pour
imprimantes versions 8.0 ou plus avancé) en sélectionnant le bouton de la barre
d’outils Accepter les parametres de périphérique. Le logiciel obtient les
informations d'identification d'imprimante pour le périphérique ajouté. Ces
informations apparaissent ensuite dans la section Identification d'imprimante au bas
de I'écran. Un message d’erreur apparait si I'adresse IP est incorrecte et ne permet
donc pas la connexion du logiciel & l'imprimante.

Cliquer sur les colonnes Imprimantes par défaut et Scanner par défaut pour
indiquer a quels périphériques l'ordinateur sera relié.
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Edition d’'un périphérique de réseau existant

Cliquer sur le nom de périphérique listé pour le mettre en évidence (Sélectionner).

|J Cliquer sur le bouton de la barre d’outils Modifier.

Le dialogue Périphérique de réseau s’affiche avec les parameétres de I'adresse IP et
du nom de périphérique existants ; ceux-ci peuvent étre changés.

r

g Accepter les informations et la liste des types de supports acceptés (pour
imprimantes versions 8.0 ou plus avancé) en sélectionnant le bouton de la barre
d’outils Accepter les parametres de périphérique. Le logiciel obtient les
informations d'identification d'imprimante pour le périphériqgue modifié. Le numéro de
version de I'imprimante sélectionnée (micrologiciel AccXES) apparait ensuite au bas
de I'écran.

i) Les informations d’identification d’imprimante et la liste des types de
supports acceptés (pour imprimantes versions 8.0 ou plus récentes) sont également
obtenues apres avoir sélectionné un périphérique série ou de réseau et apres avoir
appuyé sur le bouton Obtenir ID d’'imprimante du périphérique sélectionné.

il Sélectionner le bouton de barre d'outils Mettre a jour I'ID imprimante et
tous les périphériques réseau Ceci permet de mettre a jour les informations
d’identification d'imprimante AccXES et la liste des types de supports acceptés
(pour imprimantes versions 8.0 ou plus récentes) pour chacun des périphériques
réseau dans la liste "Périphériques disponibles” qui supporte la communication bi-
directionnelle.
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Suppression d'un périphérique existant

Cliquer sur le nom de périphérique listé pour le mettre en évidence (Sélectionner).

*
Sélectionner le bouton de la barre d’outils Supprimer.
REMARQUE : Tous les types de supports téléchargés associés uniqguement &

un périphérique supprimé continue d’'étre associé a des périphériques non bi
directionnels tant que I'application ACT existe.

Imprimer au fichier

Quand I'option “imprimer au fichier” est sélectionnée sur I'onglet Gestionnaire de
périphériques, une zone d’entrée de texte s’affiche au bas de I'écran. Entrer 'acces
par défaut de I'option Imprimer au fichier ou I'acces au serveur d'impression en
utilisant la convention universelle de dénomination (UNC: \\serven\printer). UNC n’est
valide que sur les systémes d’exploitation Windows.

Réglage des options Retentative de connexion réseau

EI:El Sélectionner le bouton Afficher le dialogue Parameétres de retentative
de connexion de connexion.

Le dialogue suivant s'affiche.

Egjg Gesztionnaire de pénphéngues
Parameétres de retentative de connexion

Nombre de tentatives : @%
Intervalle : @%

oK || Annuler |
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Sélectionner combien de fois (Nombre de tentatives) I'outil Gestionnaire de
périphériques doit essayer de se connecter a I'imprimante ou au scanner, si la
premiére connexion ne s’établit pas. 10 correspond au nombre maximum.

Sélectionner le laps de temps, en secondes, avant un nouvel essai de connexion.
60 secondes correspond au temps maximum. Sélectionner OK.

Ci-dessous, un exemple du message de retentative qui s'affiche dans la barre d’état
en bas de I'écran Gestionnaire de périphériques.

ERTT e v w Cires  Rrln Tt e 1w Fr

Sélection de I'imprimante et du scanner par défaut

Dans les colonnes de I'imprimante et du scanner, cliquer a cété du nom de
périphérique choisi comme nom par défaut.

Annulation de I'activité du gestionnaire de périphériques

éPour annuler 'activité en cours sur la page Gestionnaire de périphériques,

sélectionner le bouton de la barre d’outils Annuler.




Outil Récupération de document*

Boutons de barre d’outils DRT

La page d’outil Récupération de document (DRT) est utilisée pour extraire des
images numérisées a partir du contréleur AccXES. Les images peuvent alors étre
enregistrées dans le systéme de fichiers ou déplacées vers la fenétre Soumission
de document, pour étre incorporées dans le jeu de document.

Ci-dessous, un tableau récapitulatif des boutons de la barre d’outils de 'onglet
Récupération de document.

wl B EY o] [

= L. -] ¥ ¢ | |
v - = - | . ; . . A :
L h=" 3 b -

W | e B UL =] IE’E' Lister toutes  Récupé Démarrer Arréter Supprimer les
e s les images ration de Récupération Récupération  images
i numérisées  toutes les  dimage dimage sélectionnées
ATt A | I B et images a t ti t i et leurs

_ T : = B I automatique - automatique.
e PR S A AR, A — bl 350 enregistrées  partir du fichiers.
AT s 11 a1 £ Bt AR 1 e 1 surle scanner.
scanner.

2 [ B
=5 :EJ
Donner un Lancer Enregistrer Montrer le Aide pour
apercu des I'éditeur de  toutes les dialogue de cette page.
images trame pour images et les configuration
sélection- sélection-  retirer de la de la
nées. ner une liste récupération.
image. Récupérés.

En plus des boutons de la barre d’outils, les options de Récupération de document
= sont accessibles dans les menus de la barre d’outils et en cliquant a I'aide du
[E=r = bouton droit de la souris sur un nom de fichier dans les fenétres Numérisé ou
Récupéré. Un récapitulatif de ces choix se trouve dans les tableaux suivants.
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Boutons de barre d’outils DRT et choix de menu

Fenétre Numériser

Sélectionner un nom de fichier dans la fenétre Numériser avant d'effectuer ce qui suit.

Options Fichier

Bouton de barre
d’outils

Menu de barre d’outils

Fenétre Numériser - Menu en
cliquant a droite

Apercu d'image numérisée

Image > Apercu

Apergu

Dé-sélectionner toutes les images

Modifier > Dé-
sélectionner tout

Dé sélectionner tout

Récupération de toutes les images numérisées mémorisées sur
le controleur. (Il n'est pas nécessaire de sélectionner les noms
de fichier en premier.)

Récupérer > Récupérer
tout

Récupérer tout

Récupérer les images numérisées sélectionnées.

Sélectionner toutes les images

Supprimer un fichier numérisé

Récupérer > Image

Modifier > Sélectionner
tout

Modifier > Supprimer

Récupération d'image

Sélectionner tout

Supprimer

Zone Répertoire de numérisation — Indiquer le nom de répertoire
ou les fichiers numérisés sont temporairement enregistrés sur le
controleur. Il s’agit du méme nom de répertoire que celui qui a
été entré dans le scanner aprés sélection du bouton Mode, avant
de numériser des images.

Zone Répertoire de récupération — Indiquer ou les fichiers
numérisés doivent étre enregistrés dans le systeme de fichiers.




Fenétre Récupérer

Sélectionner un nom de fichier dans la fenétre Récupérer avant d’effectuer ce qui suit.

Options fichier

Bouton de barre d’outils

Menu de barre d’outils

Fenétre Récupérer

Ajouter des fichiers au travail de jeu de document
dans la fenétre Soumission de document

Apercu d'image récupérée

Arréter la récupération d’image automatique

Dé-sélectionner toutes les images

Dialogue Configuration de la récupération

Ajout d'un fichier :
Image > Assembler image

Ajout de fichiers multiples :

Image > Assembler tout
Image > Apercu

Récupérer> Arréter

Modifier > Dé-sélectionner
tout

Récupérer > Configuration
récupération

Apergu

Dé sélectionner tout

Enregistrer 'image sélectionnée
Enregistrer toutes les images

Image > Garder 'image
Image > Garder tout

Garder l'image
Garder tout

Lister toutes les images numérisées sur le
contréleur

Récupération > Liste

Modifier la trame avant d’enregistrer le fichier

Image > Editeur de trame

Editeur de trame

Récupération d’image automatique

Récupérer > Interrogation
automatique

Renommer le fichier

Modifier > Renommer

Renommer

Sélectionner toutes les images
Supprimer un fichier récupéré

Modifier> Sélectionner tout
Modifier > Supprimer

Sélectionner tout
Supprimer
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Utilisation de I'outil Récupération de
document

Etapes de base pour numériser et récupérer des images

1.

Régler les options de récupération, comme expliqué dans la section

“Réglage des options de récupération’, qui se trouve a la section suivante de ce

guide.

Vérifier que la case “Apergu automatique” est cochée sur la boite de dialogue

Configuration de récupération.

REMARQUE : Pour activer la fonction Apergu sur le scanner, appuyer sur le

bouton Mode pour sélectionner "Mode de numérisation". Passer a Qualité

d’image sur le panneau de commande du scanner et sélectionner Photo,

Ligne, ou Photo & Normal. Sur I'écran du panneau de commande du scanner,

sélectionner la touche Apergu > Entrer. Les images a prévisualiser sont

ensuite créées.

Numeériser les images comme suit.

* Sur le scanner acceptant AccXES, si Facturation est activé, introduire I''D
utilisateur et I''D de compte. (Pour les versions de micrologiciel AccXES
antérieures a 7.0, il s’agit d’'un numéro de compte et de sous-compte.)

e Pour sélectionner le format de fichier pour une numérisati on en couleur,
appuyer sur le bouton Mode pour sélectionner "Mode de numérisation".
Passer a Qualité d’'image sur le panneau de commande du scanner et
sélectionner Photo & Normal. Sur I'écran du panneau de commande du
scanner, sélectionner la touche Suivant > Format > la touche Entrer
>JPEG ou TIFF > la touche Entrer.

* Lors de la numérisation d’'une image, un fichier TIFF sera, par défaut, le
format du fichier d'image. Pour choisir CALS, JPEG ou PDF comme format
de fichier souhaité, passer a Qualité dimage sur le panneau de commande
du scanner et sélectionner Ligne. Sur I'écran du panneau de commande
du scanner, sélectionner CALS, JPEG ou PDF > la touche ENTRER.

» Utiliser le bouton Mode pour sélectionner le mode de numérisation. Entrer
le nom du Répertoire de numérisation.
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¢ Numériser les documents dans le scanner. lls sont temporairement
enregistrés sur le disque dur du contrdleur AccXES, dans le répertoire de
numérisation spécifié, jusqu’ace qu'ils soient récupérés dans le systéme
de fichiers a l'aide de I'outil Récupération de document.

4. Récupérer les images manuellement ou automatiquement comme suit.

Récupérer les images manuellement :

Si des images JPEG ont été numérisées au scanner, sélectionner le
bouton de barre d'outils Options de récupération. A partir du menu déroulant,
sélectionner I'extension de fichier a attacher aux images JPEG qui seront
récupérées du scanner. Sélectionner le bouton OK.

—WJ Aprés avoir numérisé les images, retourner a la station de travail.

Sélectionner le bouton de la barre d’outils Lister tout pour obtenir une liste des
documents numérisés. Avant de décider la récupération de ces images, il est
possible de les sélectionner et d’obtenir un apercu.

‘ﬁ Sélectionner le bouton de la barre d’outils Récupérer tout ou

sélectionner Récupérer > Tout. Il est aussi possible de mettre en évidence
certains noms de fichier dans la fenétre Image, puis de sélectionner
Récupération > Récupérer image. Les titres d'image quittent alors la fenétre
Image pour passer dans la fenétre Récupérer. Un apercu de I'image s’affiche a
chaque récupération d'image, si la fonction Apercu est activée sur le scanner et
si la fonction “Apergu automatique” est sélectionnée sur I'écran Configuration de
la récupération.




Récupérer des images automatiguement :

i

*
=+ IPour que les documents numérisés soient automatiquement récupérés
sur la station de travail, sélectionner le bouton de la barre d'outils
Récupération d’'image automatique. Il est également possible de
sélectionner Récupérer > Interrogation automatique. Les images numérisées se
rendent d’abord & la fenétre Numériser, puis sont transférées automatiquement
a la fenétre Récupérer.

° Sélectionner le bouton Arrét pour arréter la récupération automatique.

5. Une fois qu'une image a été récupérée, elle peut étre renommeée, supprimée,
ajoutée a un travail sur la page d’outil Soumission de document, modifiée au
niveau de la trame ou enregistrée sur le systeme de fichiers. Pour accomplir
cela, sélectionner le fichier désiré dans la fenétre Récupérer, puis utiliser les
boutons de la barre d’outils, le menu de la barre d’outils ou les menus du
bouton droit de la souris pour modifier ce fichier. Pour plus de détails, se
reporter a la table précédente ou a I'annexe 5.

Noter que le scanner enléve automatiquement les documents numérisés apres une
période n'excédant pas 24 heures (le réglage courant est défini par I'utilisateur &
I'interface utilisateur du scanner). Il faut récupérer les documents numérisés avant
gu'il soient enlevés.

Réglage des Options de récupération

Certaines fonctions de récupération doivent étre personnalisées dans la section
“Options de récupération” de la page Récupération de document avant de récupérer
des images numérisées. Les choix établis seront enregistrés pour des sessions
ultérieures du logiciel Outils Client AccXES.

OPTIONS DE RECUPERATION

Dans la section “Options de récupération” de la page Récupération de document,
régler les Répertoire de numérisation, Préfixe de fichier et Zones de récupération.
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Répertoire de numérisation — Dans cette zone de texte, entrer le répertoire de
numérisation a partir duquel les documents numérisés seront récupérés. Il s’agit du
méme identificateur entré dans le scanner avant la numérisation de documents.

Pour le micrologiciel AccXES, versions 7.0 ou plus récentes, le nom du répertoire
de numérisation peut étre constitué de 16 caractéres alphanumériques, y compris
un soulignement (), une virgule (.) et un tiret (-). Le point ne peut pas étre utilisé
comme premier caracteres.

Pour les versions du micrologiciel AccXES antérieures a 7.0, le répertoire de
numérisation est un numéro de compte et un numéro de sous-compe.

REMARQUES :

* Lavaleur par défaut du Champ Répertoire de numérisation est 0.1 dans
I'Outil de récupération de document. Néanmoins, la valeur par défaut a
I'interface utilisateur du scanner est images en utilisant Révision AccXES
7.0 ou plus récent. Lors de la numérisation et la récupération d'images au
répertoire de numérisation par défaut, vérifier que ces deux valeurs
correspondent. Soit, changer le nom du répertoire au scanner pour une valeur
0.1 ou changer ce nom dans I'Outil de récupération de document aimages.
Pour les révisions AccXES 6.1 ou inférieures, les valeurs par défaut a la fois
pour l'interface utilisateur du scanner et I'Outil de récupération de document
sont 0.1.

*  Silimprimante utilise le micrologiciel AccXES version 7.0 ou plus récente, puis
gue la connexion sur I'onglet Gestionnaire de périphérique change pour une
imprimante ayant une version antérieure a 7.0, alors le logiciel tente de convertir
la valeur du répertoire de numérisation a un numéro de compte et de sous
compte. Si la tentative n’aboutit pas, un message d’avertissement apparait. Il
faut alors entrer le numéro de compte dans la zone Répertoire de numérisation.
Le logiciel va également tenter de convertir les numéros de compte et de sous
compte a une valeur du Répertoire de numérisation lors du passage d'une
imprimante utilisant une version de micrologiciel AccXES inférieure a 7.0, a une
imprimante utilisant une version du micrologiciel AccXES 7.0 ou plus récente.

Préfixe de fichier — Taper le préfixe de fichier désiré dans les noms de fichiers
rappelés (par défaut : MYSCAN).
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Répertoire de récupération — Sélectionner I'endroit, sur le systeme de fichiers,
ou les fichiers sont enregistrés lorsqu'’ils sont récupérés. Utiliser le bouton
Parcourir pour localiser I'accés au répertoire.

DIALOGUE CONFIGURATION DE LA RECUPERATION

! Cliquer sur ce bouton pour accéder a I'écran Configuration de la

récupération. Il est aussi accessible en sélectionnant Récupérer > Configuration
de la récupération sur le menu de la barre d’outils. Chaque fonction est décrite ci-
dessous.
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Intervalle d’appel — Choisir le laps de temps en secondes entre chaque
interrogation automatique, ou les images numérisées sont automatiquement
extraites du scanner vers la fenétre Récupération de document. La plage se situe
entre 15 et 3 600 secondes.

Apercu automatique — Cocher cette case pour activer I'apergu automatique des
images numérisées qui sont récupérées.

REMARQUE : L'option “Créer apergu” doit aussi étre activée sur le scanner pour
que l'option Apercu automatique fonctionne.

Effacer liste et conserver en quittant — En quittant I'application Outils Client
AccXES, cocher cette case pour annuler la fenétre Récupération des fichiers listés.
En méme temps, ces fichiers rappelés seront enregistrés sur le systeme de fichiers
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dans le répertoire et le dossier précédemment spécifié dans la zone Répertoire de
récupération de la page Récupération de document. Si cette fonction n’est pas
sélectionnée, la liste des fichiers rappelés reste dans la fenétre Récupérer quand
I'application Outils Client AccXES est de nouveau ouverte.

Extension de fichier récupéré JPEG — Sélectionner I'extension du fichier qui sera
utilisée pour nommer les fichiers JPEG récupérés du scanner. Les extensions
valides sont .JFI, .JFIF, .JPE, .JPEG, .JPG. L'extension par défaut est JPG.

REMARQUE : Lorsque le fichier de prévisualisation est récupéré au systéme
de fichiers de I'utilisateur, I'extension de fichier passera de “.JPG” a “.PJPG",
par exemple :

XXX_2000704_0001.PJPG. Ceci va différencier le nouveau fichier d'image
JPEG du fichier de prévisualisation et également permettre a I'utilisateur
d'utiliser I'extension “.JPG” courante pour le fichier d'image principal.

Inclure la date dans le nom de fichier - Si cette case est cochée, la date
actuelle et un numéro d’index sont ajoutés au nom du préfixe de fichier. Dans le cas
contraire, seul un numéro d’'index est ajouté au préfixe de fichier. Ce qui suit est un
exemple de nom de fichier rappelé (image_001) contenant MYSCAN comme préfixe
de fichier avec la date du 25 avril 2000. La sauvegarde se fera dans le dossier
“Images ACT” du répertoire C. Un nom de fichier peut étre modifié en cliquant &
I'aide du bouton droit de la souris sur la fenétre Récupérer, puis en sélectionnant
Renommer.

C:\Images ACT\MYSCAN_20000425_0001.TIF

La section Editeur de trame permet de préciser quel éditeur de tracé (tel que
Photo Shop ou Paint Shop Pro) sera utilisé pour modifier les documents retrouvés
avant de les enregistrer.

Chemin de I’éditeur — Entrer dans cette zone le chemin complet correspondant a
'emplacement du fichier exécutable de I'éditeur de trame. Utiliser le bouton
Parcourir pour pouvoir sélectionner 'emplacement.

Options - Entrer les options de la ligne de commande a utiliser lors du
fonctionnement de I'éditeur de trame. Cela permet au fichier image d’étre affiché a la
suite des options de la ligne de commande. Pour certains éditeurs, aucune entrée
n’est nécessaire.



e
5
H; Lorsqu’'un nom de fichier d'image rappelé est sélectionné dans la fenétre
Récupérer et qu’ensuite le bouton de la barre d’outils Editeur de trame est active,
I'éditeur de trame spécifié sera lancé.

REMARQUES :

Si I'éditeur de trame est ouvert, mais que le fichier rappelé ne s’ouvre pas dans
I'éditeur. Sélectionner Fichier > Ouvrir dans I'éditeur. Puis sélectionner le fichier, qui
a été écrit dans le systeme de fichiers alors qu'il était transféré a la fenétre
Récupérer.

Un message “Format de fichier incorrect” s'affiche quand les éditeurs de trame ne
supportent pas certains formats de fichier.

Le bas du dialogue Configuration de récupération contient les boutons suivants :

OK — Appuyer sur ce bouton pour accepter (et enregistrer) tous les changements
apportés aux parametres Configuration de la récupération et pour quitter ce
dialogue.

Annuler - Appuyer sur ce bouton pour ignorer tous les changements apportés au
dialogue Configuration de la récupération et pour quitter ce dialogue.

Réinitialiser - Appuyer s ur ce bouton pour réinitialiser les paramétres de la fenétre
en cours avec les paramétres par défaut.

Aide - Appuyer sur ce bouton pour obtenir de I'aide en ce qui concerne le dialogue
Configuration de la récupération et passer a des hyperliens vers d’autres sujets.

Guide de I'utilisateur Outils Client AcCXES
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Outil Soumission de document*

L’onglet Soumission de document est I'endroit ou créer un jeu de document qui
sera envoyé comme un seul travail d’impression a I'imprimante. Le jeu peut étre

enregistré sous forme de fichier unique sur le systéme de fichiers. Les réglages de

document par défaut s’appliquent aux documents ajoutés dans la fenétre

Soumission de document. Un X apparait dans la colonne Valeurs par défaut, a coté

du nom de fichier. La colonne Options contient toutes les informations données
dans la zone Description de I'onglet Configuration des documents.
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* La section Travail en bas de I'écran permet de préciser le nom du travail
d’impression, le nombre d’exemplaires a imprimer, la priorité du travail
d’'impression et le numéro de compte a attribuer au travail d'impression. Les
options Ordre d'impression inverse ou d’assemblage peuvent aussi étre
choisies. Sélectionner le bouton de la barre d’outils Options Travail pour
sélectionner d’autres Options Travail d'impression.

e Les réglages par défaut des documents peuvent étre modifiés en sélectionnant
le bouton de la barre d'outils Options par défaut modifiées.

*  Cliquer deux fois sur un nom de fichier dans la fenétre Soumission de document
pour modifier les options du document sélectionné. Un X a c6té du nom de
fichier apparait dans la colonne Modifié. Le document ne possede plus les
réglages par défaut.

Boutons de barre d’outils DST

o B B o S

Couper Copier Coller Ajouter Insérer
documents documents documents documents documents

B
=

Imprimerun  *Modifier * Options Aide pour
jeude Options par Travail cet écran
document défaut

*En plus des boutons de la barre d'outils, les options Soumission de document sont
accessibles a partir des menus de la barre d’outils et en cliquant & I'aide du bouton
droit de la souris sur un nom de fichier dans la fenétre Soumission de document. Un
récapitulatif de ces choix se trouve dans les tableaux suivants.



Bouton de la barre d’outils DST et choix de menus

Chagque fonction principale de DST est listée dans la premiére colonne du tableau suivant. A c6té de chaque fonction se trouve le bouton de la barre d'outils, le menu de

barre d’outil et/ou le menu obtenu en cliquant a l'aide du bouton droit de la souris qui doivent étre utilisés pour accéder a la fonction.

Fonction des onglets DST

Bouton de
barre d’outils

Menu de barre d’outils

Menu en cliquant sur le
bouton droit de la souris

Afficheur

Modifier > Configurer I'afficheur
Modifier > Lancer l'afficheur

Ajout de document du systeme de fichiers a la fin du jeu de
document

Ll

Document > Ajout de document

Annuler la fenétre Soumission de document

Fichier > Nouveau ou

Modifier > Annuler tout

Annuler la fenétre Soumission de document des fichiers
listés et de leurs options.

Annuler la soumission de document a I'imprimante — Cliquer
sur le bouton Annuler

Fichier > Nouveau

Annuler tout — retirer tous les documents du jeu de document,
mais garder les sélections d’option

Assemblage — Sélectionner I'ordre des pages des documents a
imprimer (voir Annexe 3 pour savoir comment combiner cette
fonction avec I'Ordre d’'impression inverse)

Modifier > Annuler tout

Coller - insérer un document du presse-papiers dans un jeu de
document

Modifier > Coller

Coller

Colonne Options d'information dans la fenétre Soumission de
document : Cliquer deux fois sur un titre de document ou
sélectionner le bouton Modifier Options par défaut. Sélectionner
'onglet Configuration > Zone Description.

Document > Modifier. Sélectionner
I'onglet Configuration > Zone
Description.

Configurer I'afficheur

Modifier > Configurer I'afficheur

Guide de I'utilisateur Outils Client AcCXES
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Fonction des onglets DST

Bouton de
barre d’outils

Menu de barre d’outils

Menu en cliquant sur le
bouton droit de la souris

Copier dans le jeu de document, un document sélectionné
dans le presse-papiers

B

Modifier > Copier

Copier

Copier les options d’'un document sélectionné dans le presse-
papiers du jeu pour le coller a un autre document

Document > Options Copier

Options Copier

Copies — Sélectionner le nombre de copies a imprimer.

Couper — déplacer un document du jeu vers le presse-papiers
du jeu de document

Modifier > Couper

Couper

Dé-sélectionner tout document dans le jeu de document

Modifier > Dé-sélectionner tout

Dé-sélectionner tout

Effacer la fenétre Soumission de document

Enregistrer les options d'impression d’'un document
sélectionné comme fichier .xpt

Eichier > Nouveau ou
Editer > Effacer tout

Document > Enregistrer sous

ID de compte — ajouter I'ID de compte attribuée a laquelle
affecter I'utilisation de supports du travail d'impression. Pour les
versions de micrologiciel AccXES antérieures a 7.0, il s'agit de
numéros de compte et de sous-compte.

ID utilisateur — pour le micrologiciel AccXES, version 7.0 ou
plus récente, introduire I'ID utilisateur attribuée par
I'administrateur systeme.

Imprimer un jeu de document

Insérer Document a partir du systeme de fichiers dans le jeu
de document

B3
=

2

Fichier > Impression

Document >
Insérer document

Lancer I'afficheur

Modifier > Lancer I'afficheur
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Bouton de
barre d’outils

Menu de barre d’outils

Menu en cliquant sur le
bouton droit de la souris

Mettre a jour les valeurs par défaut de document —
Sauvegarde les valeurs par défaut du document de toutes les
options d’'impression Edition des options d'impression de
document par défaut.

E)- > Onglet

Configuration >
Mettre a jour les
valeurs par
défaut

Mettre a jour les valeurs par défaut — Sauvegarde les
valeurs par défaut du document de toutes les options Edition
des options d'impression de document (cliquer deux fois sur le
titre du document. Double clic sur un nom de fichier > Onglet
Configuration > bouton Mise a jour des valeurs par défaut).

Mettre a jour les valeurs par défaut — Sauvegarde les
valeurs par défaut de tous les onglets Edition des options de
travail.

Options Coller - Remplacer les options de document des
documents sélectionnés (en surbrillance) par les options de
document du presse-papiers interne.

[

= >
Configuration >
Mettre a jour les
valeurs par
défaut

Document > Options Coller

Options Coller

Options de document — Cliquer deux fois sur le nom du fichier

Document > Modifier

Options de document — Modifier de la boite de dialogue
Options de document pour le document sélectionné

Document > Modifier

Options de document — Enregistrer Sous — Enregistrer les
options de document du document sélectionné (en surbrillance)
dans un fichier nommé.

Document > Enregistrer sous

Options de document — Ouvrir — pour remplacer les Options
de document des documents sélectionnés (en surbrillance) avec
les options de document d’un fichier nommé.

Options de document par défaut — Modifier la boite de
dialogue Options de document des Options de document par
défaut actuelles

Document > Ouvrir

Document > Modifier Valeurs par
défaut

Guide de I'utilisateur Outils Client AcCXES
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Fonction des onglets DST

Bouton de
barre d’outils

Menu de barre d’outils

Menu en cliquant sur le
bouton droit de la souris

Options Travail — Ajouter le nom d’'un travail d'impression

Travail > Options Travail

Ordre d’'impression inverse — imprimer les documents listés
sur I'écran Soumission de document listed on the Document en
commengant par le document au bas de la liste.

Ouvrir un jeu de document enregistré

Fichier > Ouvrir

Priorité — Sélectionner la priorité du travail d'impression.
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Sauvegarder les options d'impression du document
sélectionné comme fichier .xpt

Document > Sauvegarder sous

Sélectionner tout document dans le jeu de document

Modifier > Sélectionner tout

Sélectionner tout

Supprimer les documents sélectionnés (

Modifier > Supprimer

Supprimer

Tracé d’orientation - Imprimer un tracé d'orientation pour le
document sélectionné (qui est listé sur l'onglet Soumission de
document).

Double clic sur un nom de fichier >
Menu Document > Tracé d’orientation

Valeurs par défaut — utiliser les options par défaut pour le
document sélectionné

Valeurs par défaut — Enregistrer les options par défaut de
document sous forme de fichier

Document > Utiliser Valeurs par
défaut

Document > Enregistrer Valeurs par
défaut sous

Utiliser Valeurs par défaut

Valeurs par défaut — ouvrir— pour remplacer les Options de
document des documents sélectionnés (en surbrillance) avec
les options de document d’un fichier nommé.

Guide de I'utilisateur Outils Client AcCXES

Document > Ouvrir Valeurs par
défaut. Localiser le fichier et I'ouvrir.
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Utilisation de I'outil Soumission de
document

Créer un jeu de document aimprimer sous
forme de travail unique

5=

. |@ Vérifier les réglages par défaut qui s’appliqueront a chaque
document ajouté a la fenétre Documents en sélectionnant ce bouton de
la barre d’outils. Changer tous les réglages sur les onglets Supports,
Configuration, Transformation, Composition, Rendu, Etiquettes et
Tampons. (Les fonctions Etiquette et Tampon doivent d’abord étre
activées sur les onglets Etiquettes et Tampons des Options Travail.)
Ces réglages par défaut s’appliquent & chaque document ajouté a la
fenétre Documents. Un X apparait dans la colonne Valeurs par défaut a
c6té du nom de fichier, ce qui signifie que les réglages par défaut ont
été appliqués a ce document. Toutes les explications sur ces onglets
sont détaillées dans la section “Options d’'impression de document par
défaut” de ce guide.

*  REMARQUE : Pour changer les options de documents individuels,
cliquer deux fois sur le nom de fichier pour passer aux onglets Modifier
les options d’'impression de document. Tous les changements
effectués s'appliqueront uniquement au document sélectionné.

e Créer un jeu de document en appliquant ce qui suit :

- Glisser & déplacer un fichier du systéme de fichiers, comme
par exemple de I'explorateur Windows, a la fenétre Documents de
'onglet Soumission de document.

L"% Utiliser le bouton Ajout de document pour créer une
liste de documents & imprimer comme un seul travail d'impression.
Dans la fenétre “Ajouter document”, sélectionner le répertoire, puis
un nom de fichier & ajouter au jeu de document. Pour sélectionner
plusieurs documents, maintenir appuyée la touche CTL ou Maj.
tout en faisant les sélections dans I'ordre dans lequel ils
apparaissent dans la fenétre. Cliquer sur le bouton Ajouter. Le
document sera ajouté a la fenétre Soumission de document.
Répéter jusqu’a ce que tous les documents soient ajoutés. Cliquer
sur Terminer.

REMARQUE : Sélectionner Modifier > Configurer I'afficheur. Entrer le
chemin et tout paramétre en option requis pour I'afficheur exécutable
(externe a ACT). L'afficheur vous laisse visualiser les fichiers listés sur
'onglet Soumission de document.

-'%I Pour insérer un document dans une liste de documents,
sélectionner ou insérer le document dans la liste. Sélectionner le bouton de
la barre d'outils Insérer document. Pour sélectionner plusieurs
documents, maintenir appuyée la touche CTL ou Maj. tout en faisant les
sélections dans l'ordre dans lequel ils apparaissent dans la fenétre. Cliquer
sur Insérer. Les documents seront ajoutés a la fenétre Soumission de
document. Cliquer sur Terminer.

- Ouvrir un fichier de jeu de document enregistré. Des
documents peuvent étre ajoutés ou supprimés pour modifier un jeu
enregistré. Pour ouvrir un jeu de document enregistré, sélectionner
Fichier > Ouvrir. Dans la fenétre “Ouvrir un jeu de document*,
sélectionner le nom de fichier et cliquer sur Ouvrir. Les noms de
fichier de document enregistrés comme jeu, s’affiche dans la
fenétre Soumission de document.

REMARQUE : Si un fichier enregistré dans un jeu de document
est supprimé du systéme de fichiers, le nom de fichier apparaitra
guand méme dans la fenétre Soumission de document lors de la
réouverture du jeu. Le titre d'un document supprimé sera mis en
évidence et un message signalant que le fichier ne peut étre
trouvé, s’affiche. Mettre en évidence le nom de fichier, cliquer avec
le bouton droit et sélectionner Supprimer pour le sortir de la liste
des fichiers de ce jeu de document.

- Transférer une image numérisée de la fenétre Récupérer de
I'onglet Récupération de document a la fenétre Soumission de
document. Pour ce faire, sélectionner (mettre en évidence) les
noms de fichier dans la fenétre Récupérer. Sélectionner Image >
Assembler image. Pour transférer tous les fichiers rappelés,
sélectionner Image > Assembler tout.

e Passer a la section Travail au bas de I'écran Soumission de
document. Taper le nom du travail. Indiquer le nombre
d’exemplaires a imprimer et la priorité du travail. Les valeurs par
défaut sont priorité 5 et une copie. Les mémes sélections sont
faites sur I'onglet Configuration des Options Travail.

Guide de l'utilisateur Outils Client AccXES
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- Les imprimantes compatibles avec AccXES impriment les
documents face vers le haut ; chaque document envoyé a
'imprimante se place au-dessus du document précédent. Pour
gue les documents imprimés se présentent dans le méme
ordre que sur la liste de I'écran Soumission de document, il
faut alors sélectionner le bouton Ordre d'impression inverse.

- Pour imprimer plusieurs copies, sélectionner Assemblage dans
le menu déroulant. Si I'option “Aucun” est sélectionnée, le
premier document sera imprimé suivant le nombre
d’exemplaires désiré, suivi par les exemplaires du second
document, etc. Quand I'assemblage “normal” ou “inverse” est
sélectionné, les documents dans le travail d'impression seront
imprimés dans des jeux assemblés pour le nombre
d’exemplaires désiré. Pour 'assemblage de documents avec
une seule page, il est recommandé d’activer Ordre
d'impression inverse et d'utiliser I'assemblage “inverse”. Cela
permet d’obtenir des résultats plus rapides. Sinon, pour les
documents constitués de plusieurs pages, utiliser I'ordre
d’'impression normal (case Ordre d'impression inverse non
cochée) et sélectionner Assemblage “Inverse”. Cette option
d'assemblage peut aussi étre choisie dans les Options Travail,
onglet Finition. Voir Annexe 3 pour une liste de toutes les
combinaisons possibles des options Assemblage et
Impression inverse et de leurs résultats.

Valeurs de I'ID utilisateur et de I'ID de compte

Si le périphérigue auquel l'ordinateur est connecté possede un micrologiciel
AccXES 7.0 ou plus récent, alors I'ID utilisateur et I'ID de compte doivent
étre fournies. Entrer les valeurs attribuées par I'’Administrateur systeme sur
I'outil Gestion de comptes AccXES.

Si le périphérique auquel I'ordinateur est connecté posséde une version de
micrologiciel AccXES antérieure a 7.0, alors I'écran Soumission de
document montre uniqguement la zone ID ou entrer les numéros de compte
et de sous compte. Le numéro de compte est converti en ID de compte et
le numéro de sous-compte est converti en ID utilisateur pour les versions
7.0 ou plus récentes.
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REMARQUE :

Lors du changement de I'imprimante par défaut d’une imprimante utilisant
une version de micrologiciel AccXES antérieure a 7.0, a une imprimante
utilisant le micrologiciel AccXES 7.0 or plus récent, le logiciel ACT essaie
de convertir les valeurs de compte et de sous-compte dans les zones ID de
compte et ID utilisateur. L'inverse est également vrai si I'on passe d’'une
imprimante utilisant le micrologiciel AccXES 7.0 et plus récent, a une
imprimante utilisant une version de micrologiciel antérieure a 7.0.

Le processus de conversion est également essayé par I'outil Soumission
de document lorsqu’un utilisateur ouvre un jeu de document enregistré
précédemment dans une version de micrologiciel AccXES différente de
celle sélectionnée sur I'imprimante actuellement. Un message apparait
signalant la tentative de conversion.

Si I'outil Soumission de document n’est pas capable de convertir les
valeurs, un message d’erreur apparait et il sera nécessaire de taper les
valeurs.

* Personnaliser les Options Travail d'impression

.’) Sélectionner le bouton de la barre d’outils Options Travail
pour changer des réglages de travail d'impression qui ne sont pas listés
en bas de I'écran Document, avant d’envoyer le jeu de document &
limprimante (Noter que les options qui sont dans les Options Travail,
onglet Configuration se trouvent aussi au bas de I'onglet Soumission de
document). Passer a la section “Options d’'impression de travail” de ce
guide pour plus de détails concernant les fonctions Option de travail.

e Imprimer un jeu de document

E

. Pour imprimer un jeu de document listé dans la fenétre
Soumission de document, sélectionner le bouton de la barre d’outils
Imprimer un jeu de document, ou Travail > Impression.

e Enregistrer un jeu de document comme fichier unique

- Pour enregistrer la liste de documents comme fichier unique dans
la fenétre Soumission de document, sélectionner Fichier >



E'E_%Emegishement du jeu de document sous B

Enregistrer. Le travail et les réglages de document seront aussi
enregistrés avec le jeu.

Chercher dans : ‘ = - ‘ Qﬂ @ @ __EIEI ':EZ:

- Le fichier s'ouvre avec les documents individuels listés dans la
fenétre Soumission de document.

- Sélectionner le bouton de la barre d’outils Imprimer un jeu de
document ou Travail > Impression.

Pour observer les progrés des travaux imprimés, cliquer sur I'onglet File
d’attente et appuyer sur le bouton de la barre d’outils “Obtenir la liste des
travaux actifs dans la file d’'impression”.

Nom dufichier : | | Enregistrer

Fichiers de type ‘ Tous les fichiers (*.*) - | | Annuler ‘

- Utiliser la fleche 2] “Chercher dans” en haut de I'écran Enregistrer
pour localiser le répertoire et le dossier dans lesquels le fichier sera
enregistré.

- Taper un nom de fichier et sélectionner Enregistrer.

- Un fichier .xds sera créé sur le systeme de fichiers et les
documents resteront affichés sur I'écran Soumission de document.

¢ Annuler la fenétre Soumission de document et réinitialiser les
parametres.

- Pour cela, sélectionner Fichier > Nouveau.
* Imprimer un jeu de document enregistré
- Sélectionner Fichier > Ouvrir.

- Sur I'écran “Ouvrir un jeu de document®, utiliser la fléche [z
“chercher dans” pour localiser le fichier.xds enregistré dans le
systeme de fichiers.

- Sélectionner Ouvrir.

Guide de l'utilisateur Outils Client AccXES
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Options d’outil de soumission de
document

L’outil Soumission de document posséde trois jeux de page d’onglets
accessibles pour changer soit les options d'impression du document par
défaut, soit les options d'impression de document individuel ou les Options
Travail.

Les options du travail ou du document, dans le groupe des onglets qui sont
ouverts sera réinitialisé aux valeurs par défaut définies par I'utilisateur
lorsque le bouton Réinitialiser est sélectionné.

Pour restaurer tous les onglets, dans le groupe des onglets ouverts, a
valeurs par défaut usine, appuyer sur le bouton Usine.

Options de document par défaut

.’) Sélectionner ce bouton de la barre d’outils pour passer aux
options d'impression de document par défaut. Ces options par défaut,
ainsi que tous les changements effectués sur celles-ci sont applicables aux
documents listés dans la fenétre Soumission de document possédant un X
dans la colonne par défaut. Les options sont aussi appliqués a tous les
documents ajoutés a la fenétre Soumission de document.

Edition des options d'impression de document par défaut

Se reporter a la section “Options d'impression de document par défaut” de
ce guide, pour plus de détails.
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Options de document

3 Cu:unfiguratiu:unl Transfu:urmatiu:unl Cnmpnsitiunl Rendul Etiquettesl Tampuns' Finitiun'

Cliquer deux fois sur le nom de fichier de la fenétre Soumission de
document pour passer aux onglets Option d'impression de document
individuel. Ceci permet de modifier les options par défaut de documents
individuels.

Edition des options d'impression de document (PJL-Sufix.txE =1

I Cunﬁguratlunl Transfu:urmatu:unl Cu:ump05|t|0n| Rendul Ethuettesl Tampu:unsl FII‘lItIDI‘lI

Se reporter a la section “Options d’'impression de document” de ce guide,
pour plus de détails.

Options Travail

! Sélectionner ce bouton de la barre d’outils pour accéder aux
onglets Option de travail. Ces options s’appliquent a tous les documents
dans le jeu de document.

Edition des options de travail '

FII‘IItIDI‘II Campasmunl Ethuettesl Tamponsl Rendul Cauleuri

| Se reporter a la section “Options d’impression de travail” de ce guide, pour

plus de détails.

X

| 5¢



Options Impression de document par
défaut

Les options Impression par défaut s'appliqguent a chaque fichier ajouté a
I’écran Soumission de document. Un X dans la colonne Valeurs par défaut
permet de les identifier.

Pour changer les options Impression par défaut, sélectionner le
bouton de la barre d'outils Modifier les options par défaut. Le jeu
d’onglets “Modifier les options d’'impression de document par défaut”
s'affiche. Les explications se trouvent dans cette section.

Edition des options d'impression de document par défaut

| Cu:unfiguratiu:unl Transfu:urmatiu:unl Cnmpnsitiunl Rendul Etiquettesl Tampuns' Finitiun'

REMARQUE : Pour changer les options Impression d’un document
individuel, cliquer deux fois sur le titre du document de la fenétre
Soumission de document ou cliquer une fois sur le titre, puis sélectionner
Document > Modifier. Pour changer les mémes options dans des
documents multiples, sans changer les options par défaut de tous les
documents, mettre en évidence les noms de fichier dans la fenétre
Soumission de document, puis sélectionner Document > Modifier. Les
onglets qui apparaissent affichent les options du premier document. Ces
options sont expliqguées dans la section “Options d'impression de document
par défaut”, mais les changements ne toucheront que le(s) document(s)
sélectionné(s).

x|
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Options Supports/Couleur — pour réglages de
document par défaut

Chemins de navigation :

Options par défaut: Al 1 ez a |’ ongl et Soum ssi on de
document > Bouton Editer |es options par défaut> Ongl et
Supports

Options Document simple : Al 1l ez & |’ ongl et Souni ssion de
docurment > Cliquez deux fois sur un document > Ongl et
Supports

L'onglet Support permet de choisir le format, le type la couleur et la source
du support a utiliser pour les documents qui seront imprimés comme
documents séparés ou sur un support utilisant I'imbrication de tracé.

Edition des options d'impreszion de document par défaut

Configurationl Transformationl Compos'rtion! Rendul E‘liqueﬂesl Tamponsl Fin'rtionl
¢ Supports

Format de support: [Tout

Type de support ; Tout

Source du support : [Sélection autarmatique

RIEIE

Couleur

cLimite toner{%) —— -Gamma
I Retplacer paratetres thaye [T Retiplaner patametres thaysi
() 100 ELEK 1.0
fEHEmtE 100 Iegerta: [1.0
Jaune 100 Jatifie 1.0
el 100 Tl 1.0
OK Annuler Reinitialiser Uszine Aide
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Format du support — Choisir le format du support approprié au travail
d’'impression. TOUT permet a I'imprimante de sélectionner le format support
le mieux adapté selon la taille de I'image et le support installé sur
'imprimante. Lorsqu’un format spécifique est choisi, I'option “Mise a
I'échelle variable” est ajoutée comme option dans le menu déroulant sur
I'onglet Transformation.

REMARQUE : Vérifier que le support sélectionné est placé dans
limprimante.

Type de support - Cliquer sur cette boite de liste pour sélectionner le type
de support. Les options dépendent du périphérique sélectionné sur I'onglet
Gestionnaire de périphériques. Tout permet a I'imprimante d'utiliser tout
type de support lors de I'impression de ce document. La valeur par défaut
est Supérieur pour les imprimantes monochromes et Tout pour les
imprimantes couleur.

REMARQUE : Le micrologiciel AccXES ne peut pas plier les supports
calque ou film. Si ces derniers sont spécifiés ici comme type de support
pour le jeu et si une plieuse va étre utilisée pour le travail d'impression, un
message d’erreur apparait lors de I'envoi du travail a 'imprimante.

Source de support — Sélectionner le tiroir de I'imprimante pour le support
a utiliser pour le travail d'impression. Avec “Sélection automatique”,
l'imprimante sélectionne le rouleau le plus large dans I'imprimante pour
imprimer le format support désiré, tournant I'image si nécessaire. Un
rouleau de format spécifique est sélectionné, les zones Type de support et
Format support sont désactivées sur cet écran.

Couleur (uniguement pour les imprimantes couleur jet
d’encre)

Pour spécifier la limite de toner et/ou les réglages gamma pour le document
ou les options par défaut, sélectionner tout d’abord un type de support
spécifique qui supporte la couleur. Ces réglages d’options Document ou
Par défaut ne peuvent étre spécifiés a moins d’avoir été activés sur les
options Travail, Onglet Couleur.

Cocher la case Remplacer parametres travail pour réécrire les
paramétres couleur du travail pour les options Par défaut ou Document
individuel.




Effectuer les sélections d’encre de couleur cyan, magenta, jaune et
noir nécessaires pour régler la limite de toner et la correction gamma
qui seront appliqguées a I'image.

Limite toner est utilisé pour changer la quantité maximale d’encre
utilisée en impression. Les valeurs valides pour Limite toner sont de
1% a 100%.

Gamma est utilisé pour modifier toute la courbe des couleurs sans
en déplacer les points finaux. Cela permet de régler les demi-teintes
(un gamma plus élevé produit des demi-teintes plus foncées), avec
un effet minimal sur les ombres et les surbrillances. Les valeurs
valides pour la correction gamma de sortie sont de 0,5 a 2,2.
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Options Configuration — pour réglages de document
par défaut

En commencant avec la version ACT version 8.0, la section Support de
cette page a été déplacée sur le nouvel onglet Support.

Edition des options dimpression de document par défaut

Supports  Configuration | Transformation Composﬂion!RendulE’tiqueﬂes Tamponlein'rtionI
~Description :

- Format de fichier :

Options PostScript

<] IV Optimisation POF [ Utiliser couleur GIE

Méthode de tramage: ITram defni-teinte ® I

PDF

~Valeurs par défaut systéme

hiettre & jour les waleurs par défaut

Ok | Annuier | Reéiritialiser | Uszing | Aidle |

* Description — Chaque information tapée dans la zone de description
apparait dans la colonne Options de I'écran Soumission de document.

« Format de fichier — Utiliser la fleche [Z] pour afficher et sélectionner le
type de fichier. Les choix sont Détection automatique, CalComp,
Calsl, Cals2, NIRS, HPGL, HPGL/2, CGM, TIFF, JPEG, PDF (option),
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PostScript (option). L'option Détection automatique permet a
l'imprimante de déterminer le format de fichier. Les autres types de
fichier doivent étre convertis avant I'impression dans un des formats
acceptés. Quand CalComp, HPGL ou HPGL/2 sont choisis, une page
supplémentaire d’onglet avec des choix d’options est disponible.

Options de PostScript

Optimisation PDF - Dans la liste déroulante des formats de fichiers,
sélectionner tout d'abord le type de fichier PDF. Cette fonction est
sélectionnée par défaut pour commander certains traitements "en
arriere plan" dans le chemin de rendu PostScript. En cas de probléeme
pour imprimer un fichier PDF, désélectionner cette fonction pour voir si
cela régle le probleme.

Utiliser Couleur CIE - Dans la liste déroulante des formats de fichiers,
sélectionner le type de fichier PostScript. Avec une imprimante
couleur, la sélection de cette fonction produit des couleurs vives pour
les types de documents Auto ou Graphique. Pour les documents de
type Ligne et Texte, les couleurs apparaissent plus saturées (sur gras).
Pour les types de documents Photo, les couleurs semblent plus vraies
gue la photographie d'origine.

Méthode de tramage (imprimantes couleur seulement) : Dans la
liste déroulante des formats de fichiers, sélectionner le type de fichier
PostScript. Cliquer sur cette zone de liste pour sélectionner Tramage
Ecran demi-teintes ou Diffusion d’erreur.

Tram demi-teinte rend des images comme avec une presse
standard d'impression. Ceci est le réglage par défaut usine.

Diffusion d’erreur rend des images avec plus de tonalités
continues (apparence photographique). Noter que les images
d’erreur diffuse, trés denses en calcul, prennent plus longtemps
pour le traitement.

Mettre a jour les valeurs par défaut — Sélectionner ce bouton pour
sauvegarder les réglages du document en cours (& partir de tous les
onglets Edition des options d'impression de document par défaut ou de
tous les onglets d’options d’impression Madifier le document) pour que
ces valeurs deviennent les valeurs par défaut systeme. Elles peuvent
étre créées pour trois types différents d'imprimantes par défaut :




couleur, monochrome ou inconnue. Ces valeurs vont étre utilisées
guand le bouton Réinitialiser est sélectionné (sur tout onglet
Soumission de document) ou lorsqu’un nouveau jeu de documents est
crée.

Guide de l'utilisateur Outils Client AccXES
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. . ) I'échelle variable met I'image a I'’échelle pour qu’elle rentre exactement
Options Transformation — pour réglages de sur le support. Quand I'option Désactivé est sélectionnée, limage est

4 imprimée utilisant le format de support sélectionné sur I'onglet
document par defaut Configuration. Quand I'option Fixe est sélectionnée, un pourcentage

L'onglet Transformation permet de préciser la mise & I'échelle, la rotation, le doit étre entré pour préciser le rapport de mise a I'échelle. 100%
miroir et la justification d’'un document. représente un rapport 1:1 ou l'impression de l'image au format réel.
L'image s'imprime sur le format de support sélectionné sur I'onglet

Edition des options ilimptess DRl SRR ENHEE R Configuration avec une image écrétée ou justifiée, selon les besoins.

supparts | Configwation Transtoneton | Conposton | Rend| Ewetes | Tanpons | P | Rotation — Le menu rotation permet de préciser la rotation de I'image
~Transformati o L ,
FANSTrTAton par incréments de 90 degrés. L'image est tournée dans le sens

Echelle: Fixe w |l ﬁ contraire des aiguilles d’'une montre.

— _ _ _ Rotation automatique — Si la case Rotation automatique est cochée,

s i e I'imprimante choisit la meilleure rotation pour 'image dans I'espace du
- s e support prévu. Avec cette option sélectionnée, le menu rotation sera

Mirair I Mirair % I Miroir

désactivé et la rotation fixée ignorée.

Largeur de igne: T Mods déchells de ligne Miroir : X, Y — L'option de miroir X permet & I'image d'étre réfléchie le long
de I'axe du grand bord d’'une feuille standard ou autour de I'axe paralléle a
la direction d’alimentation du rouleau. L'option de miroir Y permet a I'image
d’étre réfléchie autour de I'axe du petit bord d'une feuille standard ou autour
L de I'axe perpendiculaire a la direction d'alimentation du rouleau.

rJustification

Position X [Absolue

Largeur de Ligne :
Pasttion ' : _ 0.0 Mode d'échelle de ligne - Sélectionner la case a cocher Mode de

mise a I'échelle de ligne pour mettre a I'échelle les largeurs (de
plumes) ainsi que le reste du dessin.

Options Justification :

Position X, Y — Sélectionner les positions X,Y pour placer 'image a
I'endroit désiré avec I'espace prévu sur le support. Par défaut X et Y
sont centrés, ce qui place I'image au centre de I'espace prévu.

REMARQUE : Pour les documents imprimés séparément, I'espace
prévu correspond au support entier sur lequel les documents seront
imprimés. Si les fonctions d’emboitement de tracé ou de Composition
i | e | REmRIEer | tine i de page sont utilisées, I'espace prévu correspond a la place sur le
support qui a été réservée pour I'impression du document.

Options Transformation : " . A .
o ) L e Unités — Si Absolu est sélectionné, entrer un nombre de pouces ou de
Echelle — Préciser la méthode de mise a I'échelle “Désactive”, “Fixe millimétres que I'mprimante doit utiliser en placant Iimage dans

ou . . o ) . 'espace prévu.
“Mise a I'échelle variable®. L'option Mise a I'échelle variable n'apparait

gue si une source ou un format de support précis (pas pour les choix

“TOUT") est sélectionné sur I'onglet Configuration. L'option Mise a

K

Unités : Pouces

K




Options Composition — pour réglages de document
par défaut

L’onglet Composition de document permet de préciser comment le
document (appelé une “page constituante”) sera placé sur le support
(appelé le “Canevas”) pendant la composition.

Edition des options d'impression de d

Supportsl Configurationl Transformation ;% Rendu! E‘liqueﬂesl Tamponsl Fin'rtioni

Format de suppoart : |ANS| E w |
Rotation : ID w |

Mise & l'échelle variakle : [

Position X : 0o

Pozition ¥ 0.0

Unités : Pouces v |

OK | Annler I Reinitializer | LUsite I Aicle: |

Cet onglet est activé seulement quand la page de composition est activée
sur Options de travail > Composition de page, comme suit.

* Sélectionner le bouton de la barre d’outils Options Travail.

» Sélectionner I'onglet Composition.

* Régler Emboitement de tracé sur Hors fonction.

* Dans la section Composition de page, sélectionner la case Images de
recouvrement .

* Cliquer sur OK.

Sur Options Travail > Composition de page, si I'option Composition
automatique est sélectionnée, aucun changement ne sera apporté sur cette
page “Modifier Composition ....par défaut”, mais le format du support, la
rotation et les réglages de position X,Y seront automatiqguement ajustés sur
tous les documents listés dans la fenétre Soumission de document. En
sélectionnant Mise a I'échelle variable sur Options Travail > Composition de
page, les documents individuels seront automatiquement mis a I'échelle
pour convenir et aussi sélectionnés sur la Composition de page de
document. Pour vérifier ces changements, double-cliquer sur un titre de
document, puis sélectionner I'onglet Composition pour voir les
changements.

REMARQUE : Si des documents sont ajoutés au jeu apres la sélection
des fonctions Composition des documents existants, ces fonctions doivent
étre appliquées aux documents ajoutés.

Si les options Composition automatique ou Mise a I'échelle variable ne sont
pas sélectionnées sur Options Travail > Composition de page, il est
possible d’effectuer les sélections suivantes pour les documents dans le
jeu de document. Si les changements sont faits sur le jeu d’onglets
“Edition....par défaut”, ils s’appliquent a tous les documents de la fenétre
Soumission de document utilisant les réglages par défaut, ainsi qu’a tous
les documents ajoutés qui utiliseront les réglages par défaut.

REMARQUE : Si les sélections demandent plus d’espace que le format
entier du support et que I'option Mise a I'échelle variable n’est pas
sélectionnée, alors certaines images seront réduites pour rentrer sur le
support.

Format de support — Sélectionner le format de support a attribuer sur le
canevas pour I'impression de document individuel. Si I'option Composition
automatique est sélectionnée sur Options Travail > Composition de page,
ce format sera automatiquement sélectionné.

Rotation — Pour faire pivoter la page constituante dans I'espace prévu sur
le support, indiquer la rotation choisie : 90, 180 ou 270 degrés. Si la
sélection Composition automatique est choisie sur Options Travail > Page
de composition, la rotation sera automatiqguement sélectionnée.
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Mise a I’échelle variable — Effectuer cette sélection pour que la page
constituante soit mise a I'échelle afin de convenir a I'espace prévu. Pour le
support en rouleau, I'image est mise a I'échelle pour que la largeur
corresponde au support et la longueur soit coupée pour convenir. Avec les
feuilles, I'image est mise a I'échelle pour utiliser le plus possible de support
sans coupure ou changement d'image. Si la sélection Composition
automatique est choisie sur Options Travail > Page de composition, la
mise a I'échelle variable sera automatiquement sélectionnée.

Positions X, Y — Effectuer les sélections X, Y pour préciser la localisation
de la page constituante sélectionnée sur le canevas.

Unités - Sélectionner les unités, pouces ou millimetres, utilisées en
installant les documents sur le support.
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Options Rendu - options par déefaut et options
document simple

(en commencant par AccXES 8.0)

Chemins de navigation: :

Options Travail : Al l ez a |’ ongl et Souni ssion de docunent >
Bouton Options Travail> Ongl et Rendu

Options Document par défaut : Al l ez a |’ ongl et Soum ssi on de
docunent > Bouton Options Travail > Ongl et Rendu> cochez
|l a case "Appliquer rendu" > Bouton Editer options par
déf aut > Ongl et Rendu

Options Document simple : Al 1l ez a |’ ongl et Souni ssion de
docunent > Bouton Options Travail > Onglet Rendu >
cochez | a case "Appliquer Rendu" > cliquez deux fois
sur un titre de docunent > Onglet Rendu

Appliguer Rendu - Sélectionner cette case pour activer les fonctions de
rendu sur cet onglet. Les choix effectués dans les options Travail, onglet

Rendu, s’appliquent & tout le travail d'impression et permettent d’effectuer
les choix sur la page Rendu des options Par défaut ou Simple document.

Edition des options d'impression de document par défaut

Supportsl Configuration | Transtarmstion | Composition  Rendu I Etiqueﬂesl Tamponsl Fini‘tionl

¢ Couleur et Monochrome

Type de docurment Sélection Auto

Demi-teinte vecteur Fempliszage de zone

Méthode de tramage: Trarn detni-teinte

Largeur de ligne minimurn (pixels): |'1

Rendu lignes fines éch .de gris (Cantone

+

Seuil de pixels lignes fines I? j
+

Contraste ID j
4 N 1
Clarte 3

KN [RN{ENIEN(E]

- Couleur
Maocle Rendu Couleur > |
Mode Gualité dimprezzion  |Rapide v I
QK | Annler | Réinitialiser Uzine Aicle |
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Couleur et Monochrome

Type de document - Cliquer sur cette zone de liste pour régler le Type de
document a sélection auto, graphiques, photo, ou lighes et texte.

Demi-teinte vecteur - Ce paramétre établit la méthode a utiliser lors du
traitement d’'images en demi-teinte. Sélectionner Remplissage des zones
pour une reproduction optimale des remplissages de larges polygones.
Sélectionner Lighe optimisée pour accentuer les fines lignes, plus
particulierement celles dessinées dans des zones remplies. Remplissage
des zones est le réglage par défaut usine.

Méthode de tramage : Ce parameétre permet la sélection du type de
trame utilisée dans les images raster multibit. L'option tram demi-teinte
permet une impression plus rapide que lors de l'utilisation de la méthode en
diffusion d'erreur mais produit des impressions avec une apparence
granulée. L'utilisation de la méthode de diffusion d'erreur produit
généralement des images plus douces.

Largeur de ligne minimum (pixels)— Utiliser ce paramétre pour améliorer
la visibilité des lignes fines. Selon la résolution de I'imprimante, les lignes
qui sont larges de quelques pixels peuvent apparaitre claires et/ou étre plus
difficiles a voir. Ce paramétre permet d’améliorer la visibilité en définissant
la largeur minimum des lignes dessinées, partout entre 1 (la valeur par
défaut) et 10 pixels. Les lignes rendues plus larges peuvent ne plus étre
considérées pour la fonction Seuil de pixels lignes fines (voir ci-dessus).
Ce paramétre n'aura aucun impact si les données sont rendues en format
trame.

Rendu lighes fines échelle de gris - Sélectionner Contone ou Noir
comme paramétre pour spécifier combien de lignes fines doivent étre
rendues lorsque le mode Rendu est réglé a Echelle de gris. En mode
Rendu Echelle de gris, les lignes fines qui sont tracées dans une couleur &
luminance claire, jaune par exemple, apparaissent trés pales si ce
parameétre est réglé sur Contone. Si ce paramétre est réglé sur Noir, ces
lignes seront tracées en noir.

Seuil de pixels lignes fines - ce parameétre spécifie la largeur de ligne
maximum a traiter comme ligne fine. La plage est de 1 a 25.
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Contraste - Utiliser cette zone de liste pour régler le contraste en spécifiant
un nombre entier entre -10 et +10. Une valeur de "0" indique qu'aucune
correction de contraste n'est appliquée. L'augmentation de valeurs
négatives réduit le contraste de I'image rendue, alors que I'augmentation de
valeurs positives augmente le contraste de I'image rendue.

Clarté - Spécifier le réglage de clarté dans cette zone de liste. Une valeur
de "0" indique qu’aucune correction de clarté n’est appliquée.
L'augmentation de valeurs négatives réduit la clarté de I'image rendue, alors
gue 'augmentation de valeurs positives augmente la clarté de I'image
rendue.

COULEUR
Cette section est désactivée si I'imprimante par défaut est monochrome.

Mode Rendu - Cliquer sur cette zone de liste pour régler le mode
Rendu pour les imprimantes couleur a couleur ou échelle de gris.
Pour les imprimantes monochromes, "échelle de gris" est la seule
option valide.

Mode Qualité d’impression - En général, plus I'imprimante effectue
des passages bidirectionnels pour créer une image, plus la qualité de
cette image sera bonne, mais plus il faudra de temps pour la produire.
La sélection RAPIDE est une impression bidirectionnelle simple qui
utilise la technologie RACER, NORMAL est une impression
bidirectionnelle a deux passages et OPTIMUM est une impression
bidirectionnelle a quatre passages.
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Options Etiquettes — pour réglages de document

par défaut
L’onglet Etiquettes de document par défaut permet de créer une étiquette
qui fera partie des options par défaut qui sont appliquées aux documents _
ajoutés a la fenétre Soumission de document. Pour activer cette i |
fonction, il faut d’abord a partir de la page Etiquettes des Options Police |Hp Stick Fant 1]
Travail, sélectionner la boite Appliquer étiquette, puis cliquer sur
OK. Puis retourner a cette page Etiquettes de document par défaut et Posilion X |’L‘""§"E Ll IE'“
cocher Appliquer étiquette. Les différentes sélections d’option pour créer S IElasse Ll IG'E
les étiquettes sont décrites apres le graphique suivant. Sans étiquette
correspond au réglage par défaut. it IPDUCBS L'
Riotation : IQD ﬂ
Etiquette — Pour introduire le texte désiré dans I'étiquette, taper celui-ci Taile : |14 :II
dans la zone Etiquette. Ou cliquer avec le bouton droit de la souris dans la W— Im—ﬂ
zone d'étiquette pour accéder aux éléments suivants du menu contextuel. ' 3
Lorsque chacun d'entre eux est sélectionné, le code lui correspondant
apparait dans la zone Etiguettes.
Date
Nom du travall
Nom du fichier
Nombre de page ok Annuler Reintislizer Lsine Aicle

Heure
Signe pour-cent

Police - Sélectionner la police d'étiquette désirée dans le menu déroulant.

Guide de l'utilisateur Outils Client AccXES
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Position X, Position Y correspondent a la position de I'étiquette en
fonction du support. En étant debout a gauche de I'imprimante, avec les
jeux de documents imprimés sortant de I'imprimante et se dirigeant sur la
gauche, les positions X et Y sont les suivantes.

Position d’étiquette pour tout format, tout
rouleau & bord d’'attague =C6té court

Y =Haut . | i
X=Gauche X=Droit mprlmante
«—

X,Y =Centre AccXES
A4 ‘
L Y =Bas r\
" ,
Bord4—Recept|on Support Bord A
d’ attaque arriere Debout

ici

Position d’étiquette pour bord d’'attaque de
feuille=Cété long

Y=Droit
X=Haut | X,Y =Centre X=Bas
- Debout
Y=Gauche ret

<%— Réception support
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Si I'option Absolu est sélectionnée pour la position X ou Y, entrer un
nombre dans la boite de texte a droite qui représente la distance absolue
(pouces ou millimetres) entre le bord X et Y du support.

Unités — Sélectionner les unités, pouces ou millimétres, utilisées quand
I'étiquette est installée.

Rotation - Sélectionner I'angle de rotation pour I'étiquette correspondant a
'image.

Taille - Sélectionner la taille du point de police pour I'étiquette.

Trame de fond - Entrer le pourcentage d’ombrage pour I'étiquette. La

gamme se situe entre 0 a 100 %. O correspond a aucune trame de fond
(blanc) et 100, au noir complet.



Options Tampons — pour réglages de document par
défaut

L'onglet Tampons permet de préciser quel fichier tampon sera appliqué aux
documents. Tout fichier de tampon chargé sur I'imprimante peut étre utilisé.
Les tampons peuvent étre dans n’'importe quel Format de fichier supporté
par le logiciel Outils Client AccXES, qui sont listés dans la section Format
de fichier de I'onglet Configuration, comme TIF, HPGL et Calsl. Les
tampons peuvent étre par exemple des logos ou un message
d’avertissement sur un document.

Cette section du guide explique comment sélectionner un tampon qui sera
attribué uniqguement aux réglages de document par défaut. Pour activer
cette fonction par défaut, il faut d’abord a partir de la page Tampons
des Options Travail, sélectionner la boite “Appliquer un tampon®,
puis cliquer sur OK. Les différentes sélections d’option pour créer les
tampons par défaut sont décrites aprés le graphique suivant. Sans tampon
correspond au réglage par défaut

REMARQUE : Pour changer les options de tampon des documents
individuels, sélectionner la boite Appliquer un tampon sur I'onglet Tampons
des Options Travail. Puis cliquer deux fois sur le titre du document dans la
fenétre Soumission de document pour passer a la fonction Tampons pour
le document sélectionné.

Pour changer les options de tampon pour un jeu complet (travail),
sélectionner le bouton de la barre d’outils Options Travail, puis effectuer les
sélections sur I'onglet Tampons.

Edition des options d'imprezsion de document par défaut

Tampan :

Rotation: 90

+
100 1

Position X : [Centre

Position % : [Centre

Pouces

Echelle : |Re lative
Unités : I

KH[KNEN(EN(EN

Ok | Anruler I Reinttizliser | Uzine | Aide |

Exemple : Onglet Tampons de I’écran Modifier un document
par défaut

(avec le nom d’'un tampon qui apparaitra sur le centre de tous les
documents qui utilisent les réglages par défaut)

Appliquer tampon — Dans I'onglet Tampons des Options Travail, cocher la
case Appliquer Tampon pour activer cette fonction. Retourner ensuite a cet
onglet Tampons de document par défaut et cocher cette case Appliquer
Tampon.

Guide de l'utilisateur Outils Client AccXES
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Tampon —Taper le nom d’'un tampon qui existe sur I'imprimante, comme
suit :

Sur le Gestionnaire d'imprimante Web PMT, sélectionner Valeurs
par défaut de I'imprimante > Configuration d’'imprimante >
Tampons.

Pour utiliser un tampon qui se trouve déja sur I'imprimante,
écrire le nom de fichier d’un des tampons de la liste Tampons
résidants de I'imprimante, comme dans I'exemple suivant.

Tampons résidants de U'imprimante:

Starnp-AccxesLogo tif

Retourner dans la zone Tampon du logiciel Outils Client
AccXES et taper le méme nom de tampon dans la zone
Tampon.

Pour télécharger un tampon sur le Gestionnaire d’imprimante
Web PMT et pouvoir I'utiliser dans la liste Tampons résidants, passer
a I'écran Facturation du Web PMT. Sélectionner Modes de facturation.
Veérifier que le mode de facturation n’est pas réglé sur

“Activé.” S'il est activé, le mettre sur “Facultatif” pendant le chargement
du tampon. Cliquer sur Charger tampon sur la page Tampon du
Gestionnaire d’'imprimante Web PMT pour localiser le fichier du
tampon. L'écran suivant apparait.

mélectionner le nom de fichier du tampon:

Farcourir... |

kise & jour de l'imprimante |

Utiliser le bouton Parcourir pour localiser le nhom de fichier.
Cliquer sur Mise a jour de I'imprimante.

Un message “Téléchargement du fichier en amont réussi”
s'affiche.
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Retourner a la page de tampons du Gestionnaire d’'imprimante
Web PMT. Le fichier est maintenant sur la liste Tampons
résidants de I'imprimante et peut étre utilisé a partir de la
fonction Tampons du logiciel Outils Client AccXES.

Remettre le Mode de facturation du Web PMT dans son état initial s’il avait
été modifié pour charger un tampon.

Rotation - Le menu déroulant de rotation permet de préciser I'angle de
rotation du tampon correspondant a I'image de tracé.

Echelle - Sélectionner le mode de mise a I'échelle a utiliser pour le
tampon. Le mode Relatif met le tampon a I'échelle en fonction du format
de papier. Le mode Absolu met le tampon a I'échelle avec un pourcentage
absolu du format normal du tampon.

Pourcentage de mise a I’échelle — Entrer le pourcentage de mise a
I'échelle. Sile mode de mise a I'échelle est Relatif, le tampon sera mis a
I'échelle avec le pourcentage de zone de page imprimable. 100%
correspond a la valeur de mise a I'échelle automatique. Si le mode de mise
a I'échelle est Absolu, ce pourcentage représente le pourcentage de mise a
I'échelle absolu qui sera appliqué au tampon.

Position X, Position Y — Sélectionner la position du tampon. Pour les
valeurs Absolu, entrer un nombre dans la zone d’entrée de texte a droite qui
représente la distance absolue (pouces ou millimétres) a partir du bord X ou
Y du support.

Unités — Sélectionner si les unités, pouces ou millimétres, doivent étre
utilisées la ou le tampon est positionné.



Options Finition - pour réglages de document par
défaut

(Les sélections de pliage concernent uniqguement les imprimantes
monochromes avec une plieuse reliée.)

Si les réglages de finition qui sont indiqués sur cet onglet doivent étre
changés pour les réglages par défaut ou les réglages du document,
effectuer ce qui suit.

Chemins de navigation:

Options par défaut: Al ez a | ' ongl et Souni ssi on de docunent >
Bout on Options de travail> Onglet Finition>

sél ectionnez le type de plieuse> (Si |'inprimnte

sél ectionnée sur |'onglet Gestionnaire de périphérique
possede le mcrologiciel AccXES, version antérieure a
9.0 et si elle supporte une conmunication bi-
directionnelle, sélectionner égal ement une méthode de
pliage.)> OK> Bouton Editer options par défaut> Ongl et
Finition> cochez |a case Appliquer Finition

Options Document simple: Allez a |'ongl et Souni ssion de
document > Bouton Options de travail> Onglet Finition>
sélectionnez |l e type de plieuse> (Si |'inprimnte

sél ectionnée sur |'onglet Gestionnaire de périphérique
posséde |l e micrologiciel AccXES, version antérieure a
9.0 et si elle supporte une conmuni cation bi -
directionnelle, sélectionner égal ement une néthode de
pliage.)> OK> cliquez deux fois sur un titre de
docurent > Ongl et Finition> cochez | a case Appliquer
Finition.

Appliquer la finition - Sélectionner tout d'abord les options dossier sur
I'onglet Finition des options du travail, comme indiqué ci-dessus.
Sélectionner cette case pour effectuer les sélections sur cet onglet pour les
réglages individuels ou les réglages de document par défaut. Ceci va
remplacer les options de finition du travail.

Si l'imprimante sélectionnée sur l'onglet Gestionnaire de périphériques
possede le micrologiciel AccXES version antérieure a 9.0, seule I'option

Bloc de titre peut étre sélectionnée (aprés la sélection de la case Appliquer
la finition).

Guide de l'utilisateur Outils Client AccXES

61



Guide de I'utilisateur Outils Client AccXES

Edition des options d'impression de document par défaut

héthode de pliage : 3,5 x 11" =ans marge d'archiv... | %
Triguse DeéfaLt i
Titre : Et bas & droite .

V¥ Bloc de titre inteligent

¥ Eliendisgarisle = Ferfarer [~ O

=g felge

Pli d'accordéon : Comp. win., comp. interne
Pli en diagonale : Z, dos de dessous

216 x 279 mm avec marge de 0 mm

Gans perforations et sans onglet

Ok I Annuler | Reintializer ! Lisine | Aide |

Méthode de pliage - Cliquez dans cette zone de liste pour sélectionner la
méthode de pliage & appliquer au tirage. Les options dépendent du type de
plieuse sélectionné.

Trieuse - Cliquez dans cette zone de liste pour sélectionner le bac.

Titre - Cliguez dans cette zone de liste pour indiquer I'emplacement du
bloc de titre.

Bloc de titre intelligent - (Si I'imprimante utilise le micrologiciel AccXES
version 9.0 ou plus récente.)

Pour plier des documents avec les blocs de titre dans les angles standard :

Cocher la case Bloc de titre intelligent pour ajuster I'emplacement du bloc
de titre afin qu'il soit visible, une fois le document plié.
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Pour plier des documents avec les blocs de titre dans une position autre
gue l'angle standard : Ne pas cocher la case Bloc de titre intelligent.

REMARQUE : Pour déterminer l'orientation du document et I'emplacement
du bloc de titre, sélectionner un document listé sur I'onglet Soumission de
document. Sélectionner Document > Tracé d'orientation ou cliquer avec
le bouton droit de la souris et sélectionner a partir du menu en incrustation.
Le travail d'impression contient des réglages par défaut usine pour les
options du travail et du document a I'exception de ce qui suit : Rotation
automatique sera désactivé et Rotation sera défini a 0. Format support sera
défini & 36 pouces.

Une bréve description du programme de finition est donné au bas de l'onglet
Finition. Les cases a cocher qui suivent indiquent les opérations du
programme de finition pour la Méthode de pliage sélectionnée. Chaque
case a cocher ne sera activée que si le programme de finition supporte
l'option associée.

Pli en diagonale - Lorsque cette case est cochée, le programme du
module de finition propose l'option premier pli uniqguement.

Marge - Lorsque cette case est cochée, une marge est incluse par le
programme du module de finition.

Perforer - Lorsque cette case est cochée, le programme du module de
finition propose des options de perforation.

Onglet/Renfort - Lorsque cette case est cochée, le programme du module
de finition propose des options d'onglet ou de bande de renfort.



Options Impression de
document individuel*

Pour changer les options d’'impression d’'un document individuel, cliquer
deux fois sur le titre du document de la fenétre Soumission de document ou
une fois sur le titre, puis sélectionner Document > Modifier. Pour changer
les mémes options sur des documents multiples, mettre en évidence les
noms de fichier dans la fenétre Soumission de document, puis sélectionner
Document > Modifier. Cependant, tous les changements faits sur ce jeu
d'onglets ne changeront que les options Impression de document du
document sélectionné. lls ne changeront pas les réglages par défaut.

Edition des options d'impression de document (PIL-Sufix.bxE = CHLEKS

| CDnFigurationl Transformationl Compositiunl Rendul Etique.ttesi Tampunsl Finitionl

*  Aprés avoir modifié les options du document, un X & c6té du nom de
fichier apparait dans la colonne Modifié de la fenétre Soumission de
document.

*  Pour appliquer ces mémes options a un autre document, sélectionner
(mettre en évidence) le document, dans la fenétre Soumission de
document, qui posséde les options désirées. Cliquer sur le titre a
I'aide du bouton droit de la souris. Sélectionner Copier les
options. Sélectionner le document dans lequel les options seront
copiées. Cliquer a I'aide du bouton droit de la souris sur le titre.
Sélectionner Coller les options.

e Pour utiliser les options par défaut sur un document modifié, cliquer
avec le bouton droit de la souris sur le nom de fichier. Sélectionner
Utiliser les options par défaut.

X

Pour plus de détails sur chaque option, se reporter a la section “Option
impression de document par défaut” de ce guide. Les mémes options
disponibles y sont décrites, sauf que ces réglages par défaut s’appliquent a
tous les documents qui ont, ou auront, des réglages de document par
défaut.

Guide de l'utilisateur Outils Client AccXES
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Options Impression de travail*

Les options Impression de travail concernent tout le travail,
tel que I'assemblage, les étiquettes, la Composition de page,
I'emboitement de tracé et le pliage. L'éditeur des Options

Travail permet de modifier ces options pour commander
I'impression d’un jeu de document. Pour changer les Options
Travail, sélectionner le bouton de barre d’outils Options Travail. Les
onglets des Options Travail sont Configuration, Finition, Composition
etiquettes, Tampons, Rendu et Couleur. L'explication de chaque onglet est
donnée ici.

Options Configuration — pour travaux d’'impression

Toutes les informations qui peuvent étre entrées sur cet onglet
Configuration de travail, peuvent aussi étre ajoutées en bas de I'onglet
Soumission de document.

Section Informations sur le travail

Nom du travail — Entrer le nom du travail d'impression. Par défaut, il
s’agit du nom du premier document de la liste de la fenétre Soumission
de document.

Nombre d’exemplaires — Entrer le nombre d’exemplaires (de 1 a 999) a
imprimer. S’il y a plus d’une copie, les copies multiples de chaque page
s'impriment séparément. Si I'assemblage est sélectionné sur I'onglet
Finition, chaque copie correspondra a un jeu assemblé.

Priorité — Entrer la priorité d'impression (de 1 & 10). Plus le nombre est
élevé, plus la priorité I'est.

Section Compte

Valeurs ID utilisateur et ID de compte

Si I'option Facturation est activée et que le périphérique auquel
I'ordinateur est connecté posséde un micrologiciel AccXES 7.0 ou plus
récent, alors I'ID utilisateur et I'ID de compte doivent étre fournies. Entrer
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les valeurs attribuées par I'Administrateur systéme sur I'outil Gestion de
comptes AccXES.

Si le périphérique auquel I'ordinateur est connecté posséde une version
de micrologiciel AccXES antérieure a 7.0, I'écran Soumission de
document affiche uniquement la zone ID de compte ou entrer les
numéros de compte et de sous-compte. Le numéro de compte est
converti en ID de compte et le numéro de sous-compte est converti en ID
utilisateur pour les versions 7.0 ou plus récentes.

Edition des options de ravail

initionl Composi‘tioni E‘tiqueﬁesl Tamponsl Rendul Couleurl
‘Informations sur le travail

Maom du travail :

Mombre d'exemplaires {1

|||+

Priorité : 5

-Compte

ldertification de [utilisateur :

Muméro de compte

“Valeurs par défaut systéme

Mettre & jour les valeurs par défaut |

Ok I Annuler | Reéintializer | Usine | Aicle

Valeurs par défaut systéme

Mettre a jour les valeurs par défaut - Sélectionner ce bouton pour
sauvegarder les réglages d'option du travail en cours (a partir de tous les
onglets Edition des options de travail) pour que ces valeurs deviennent les
valeurs par défaut systéme. Elles peuvent étre créées pour trois types




différents d'imprimantes par défaut : couleur, monochrome ou inconnue.
Ces valeurs vont étre utilisées quand le bouton Réinitialiser est
sélectionné (sur tout onglet Edition des options de travail) ou lorsqu’un
nouveau jeu de documents est créé.

Options Finition — pour travaux d’impression

Edition des options de travail

Canfiguration  Finiior | Cu:umpu:us'rtionl E’liqueﬁesl Tampnnsl Rendul Cnuleuri

[ Ordre irveetse Dizcordance de supparts :iMise 4 I'échelle variable LI

H Page de garde Azzamblage i.&.ucune _:_I
-Plieuse

Type de plieuse Xerox 85330 Folder ‘ll

Méthode de pliage 5.5 x 11" =anz marge d'archiv... W

Triguze : Défaut b

Titre : Er bas & drote b

[+ Bl erndisnnrise [ fiaroe [T Berfarer [ ErpletRentart

Pli d'accordéon : Comp. min., comp. interne
Pli en diagonale @ 2, dos de dessous

216 x 279 mm avec wmarge de 0 mm

Sans perforations et sans onglet

Ok Annuler Réinitializer Uzine Aicle

Exemple : Onglet Finition avec options sélectionnées

Ordre inverse — En cochant cette case, les documents de la fenétre
Soumission de document sont envoyés a I'imprimante dans I'ordre inverse

de la liste. L'option “Ordre inverse d’'impression” est aussi disponible en bas
de I'onglet Soumission de document.

Page de garde— En cochant cette case, les pages de garde pour le travalil
sont activees. Une page de garde correspond a la page d'information qui
s'imprime en premiére page d’un travail d’'impression. Elle contient
l'identification interne du travail créé, ainsi que d’autres informations
disponibles et utiles comme la date et I'heure de I'impression, le format en
octets, le format de données et le port d’entrée du travail.

Discordance de supports — Une Discordance de supports se produit
guand les documents envoyés a I'imprimante ne s'impriment pas a cause
du format et du type du support qui ne sont pas installés dans I'imprimante.
Ce menu déroulant permet de préciser comment gérer le probléeme de
discordance. Le réglage par défaut est “Mise a I'échelle variable”. Les choix
sont les suivants :

Mettre I'image a I’échelle variable — mise a I'échelle du format le
plus proche possible du support du méme type

Bloquer I'impression — jusqu’au placement du support correct

Remplacer le type de support — remplacement du support par un
autre (non disponible pour les support couleur)

Pour résoudre la discordance, sélectionner le nom de fichier du fichier
discordant dans la file d’attente de I'imprimante, puis le bouton Annuler.
Ou bien, dans la file d’attente du Gestionnaire d'imprimante Web PMT,
sur la page principale, sélectionner le fichier discordant. Ceci permet
d’afficher une fenétre indiquant comment résoudre la discordance avant
de pouvoir imprimer le travail.

REMARQUE : Si I'option Discordance de supports est activée sur
'imprimante, les choix de discordance du logiciel Outils Client AccCXES
sont prioritaires sur les options de discordance de I'imprimante.
Cependant, la fonction de discordance de I'imprimante doit étre
activée pour que les travaux d’'impression discordants passent
dans la file d’attente de discordance, permettant ainsi I'impression
des autres travaux. Pour activer la file d’attente de discordance de
limprimante sur le Gestionnaire d’'imprimante Web PMT, sélectionner
VALEURS PAR DEFAUT IMPRIMANTE> VALEURS PAR DEFAUT DE
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TRAITEMENT > Support > Discordance de file d’attentes
(sélectionner la boite "Activée").

Assemblage — Ce menu déroulant active I'assemblage électronique sur
limprimante. Quand I'assemblage “normal” ou “inverse” est sélectionné, les
documents dans le travail d'impression seront imprimés dans des jeux
assemblés pour le nombre désiré de copies. Quand I'option “Aucun” est
sélectionnée, le premier document est imprimé suivant le nombre désiré de
copies, suivi par les copies du second document, etc. Pour I'assemblage
de documents ne contenant qu’une seule page, il est recommandé d’activer
Ordre d'impression inverse et d'utiliser 'assemblage ‘inverse”. Cette option
d'assemblage peut aussi étre choisie sur I'onglet Soumission de document.

REMARQUE : Voir Annexe 4 pour les résultats d’'impression des fichiers
Postscript avec des réglages pour les options d’assemblage et de finition.

Options plieuse permet de spécifier si le pliage des impressions est
nécessaire et la méthode a utiliser quand le pliage est demandé.

Les sélections de pliage concernent uniquement les imprimantes
monochromes avec une plieuse reliée.)

REMARQUE : Pour éviter les incidents papier, utiliser uniqguement un
papier de qualité avec la plieuse AccXES. Le micrologiciel AccXES ne plie
pas le calque ou le film. S’ils sont spécifiés comme type de support sur
'onglet Réglage de document et si une plieuse est utilisée pour le travalil
d’'impression, alors un message apparait lorsque le travail d'impression est
envoyé a l'imprimante.

Type de plieuse — Sélectionner le type de plieuse connecté a l'imprimante
sélectionnée sur I'outil Gestionnaire de périphériques. Si elle n’est pas sur
la liste, faire ce qui suit pour ajouter ce type de plieuse dans la liste.

* Sélectionner Ajouter une plieuse.

Sur I'écran “Sélectionner un module de finition”, localiser le fichier .FIN
pour le type de plieuse. Le fichier .FIN se trouve ou le logiciel ACT est
installé (ex. Fichiers de programme/AccXES/ACT 5.1/etc/module de
finition/Nom du module de finition & installer.) Cliquer sur OK. La plieuse
sera ajoutée dans la liste Type de plieuse.
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REMARQUE : Aller a 'annexe 1 pour savoir comment créer un fichier
FIN pour la plieuse.

Les méthodes de pliage appropriées pour ce type seront listées dans le
menu déroulant Méthode de pliage. Le dernier fichier de finition
sélectionné par I'utilisateur restera dans le menu Type de plieuse entre
les sessions d'utilisation du logiciel Outils Client AccXES.

Méthode de pliage - Cliquer sur la fleche [ pour afficher la liste des
options de pliage disponibles avec le type de plieuse connecté a
limprimante. Le réglage par défaut est sur le Gestionnaire d'imprimante
Web PMT. La sélection est limitée a Sans pli lorsqu’aucune plieuse n’est
installée. Une breve description du programme du module de finition se
trouve au bas de I'onglet Finition.

Plieuse - Sélectionner quel casier la plieuse doit utiliser.

Titre - Sélectionner I'emplacement des titres sur les documents pour
gu’ils soient au-dessus une fois le travail plié.

Bloc de titre intelligent : (Si I'imprimante utilise le micrologiciel
AccXES version 9.0 ou plus récente.)

Pour plier des documents avec les blocs de titre dans les angles
standard :

Cocher la case Bloc de titre intelligent pour ajuster I'emplacement du
bloc de titre afin qu'il soit visible, une fois le document plié.

Pour plier des documents avec les blocs de titre dans une position
autre que l'angle standard : Ne pas cocher la case Bloc de titre
intelligent.

Les cases a cocher suivantes indiquent les fonctions supplémentaires
de plieuse pouvant étre disponibles.

Pli en diagonale — Le support imprimé sera plié en deux a la fin
du processus de pliage.

Marge — Une marge sera laissé sur un bord du document plié
(comme pour perforer afin de rentrer le document imprimé dans un
carnet sans devoir percer de trous dans le document entier).

Perforer — Des trous seront perforés dans la sortie imprimée et
plie.



Onglet/Renfort — Une bande de renforcement sera ajoutée a un
bord du document plié.
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Edition des options de travail

OptlonS CompOSItIOn - pOUr travaux d’lmpreSSIOn Configurationi Finition Composition | E‘tiqueﬂesl Tamponsl Rendul Couleurl

Des documents multiples peuvent étre combinés sur un seul support, en

utilisant soit I'option Emboitement de tracé, soit I'option Composition de
. e . i riade dembatement de ttans s IDé&-adivé "i Travail simple page: IDésac‘tivé 'I
page. Les options Composition de page faites sur cet onglet sont pour le ;

support entier (appelé le

“Canevas”) sur lequel les images individuelles ou les documents (appelés OB Ce

“Page Constituante”) sont Imprlmés v Images de recouvrermert = Cotnpostion sutarmsticue

REMARQUE : Composition automatique change automatiquement les Format de support : ANSIE v
options des documents individuels qui seront imprimées ensemble sur un
seul support. Pour changer manuellement les options de document
individuel, cliquer deux fois sur chaque titre de document dans la fenétre
Soumission de document, puis passer a lI'onglet Composition.

Type de support Tout

v
Source du support =élection automatique v

Composition automaticue

Mize enpage——

 2en — b —

Cigend —s = = -wf—

™ Mise & léchele variable

Ok Annuler Réinitializer Lzing Aicle:




Mode d’emboitement de tracé — Le réglage “Désactivé” entraine
I'impression des documents sur des pages individuelles. Si I'option “Travail
unique” est choisie, le contréleur emboitera (groupera) automatiquement les
documents soumis dans une rangée, sur un seul support. Avec la sélection
“Valeurs par défaut”, 'imprimante utilisera 'emboitement de tracé par
défaut. Le réglage “Désactivé” doit étre sélectionné afin d’activer les options
Composition de page sur cette page et sur la page de composition du
document individuel.

Travail simple page — Avec cette fonction, I'imprimante tente d’'imprimer
séquentiellement les pages adjacentes de méme largeur d'un travail, pour
produire une simple copie longue pour le travail. Le réglage de la fonction a
I'un des formats de rouleau va réécrire chaque sélection de support de
page, assurant que le travail sera bien imprimé sur une seule page. Si la
largeur ou le type du support de page est différent de la page précédente ou
si la longueur maximum de l'imprimante est atteinte, I'imprimante coupe le
travail entre les pages. Le réglage de la fonction a Activé signifie que le
traitement AccXES normal sera utilisé pour sélectionner le support. La
valeur par défaut de cette fonction est Désactivé.

Cette fonction peut étre utilisée avec Imbrication de tracé pour produire une
matrice d’images sur une simple feuille de support.

Composition de page — L’emplacement des images sur le support peut
étre précisé avec I'option de Composition de page.

Images de recouvrement - Sélectionner cette option pour superposer
les images les unes sur les autres. Le format, le type et la source du
support doivent étre précisés.

REMARQUE : La case Images de recouvrement doit étre sélectionnée
sur cet onglet Composition des options Travail pour activer les options
Document individuel ou Document par défaut, sur leur onglet
Composition.

Composition automatique — Cocher la case Composition
automatique pour accéder aux options Disposition prédéfinies. Pendant
la sélection d’une disposition (2 en 1, 4 en 1, 8 en 1), un exemple sera
donné a c6té de la sélection pour illustrer comment les documents
soumis seront arrangés sur le support. Les options de Composition de
page seront aussi automatiquement réglées pour les documents listés
dans la fenétre Soumission de document. Pour vérifier les

changements, cliquer deux fois sur chaque titre et se reporter a I'onglet
Composition pour voir ce qui a changé.

Mise & I’échelle variable - Sélectionner Mise a I'échelle
variable afin que le format de chaque page constituante
corresponde complétement a I'espace prévu sur le canevas. Ceci
entraine aussi la sélection de Mise a I'échelle sur les documents
individuels de I'onglet Composition.

REMARQUE : Les options Composition automatique et Mise a I'échelle
variable doivent étre sélectionnées quand des documents sont ajoutés
dans un jeu ouvert auquel ces options ont déja été appliquées. La case
Composition automatique sera non-cochée a chaque entrée dans le
dialogue Options Impression de travalil.
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Edition des options de travail

Options Etiquettes — pour travaux d’'impression

Les options Etiquette de travail ajoutent une étiquette a chaque document
du jeu de document. Exception faite pour les documents utilisant une
étiquette différente. Pour activer cette fonction, sélectionner Appliquer
étiquette. Se reporter & la section “Onglet Etiquettes — Réglages de

Configuratic-ni Fin'rtinnl Camposition  Efiquettes I TamponSI Rendul Couleurl

P . . . g Etiquette : I
document par défaut” de ce guide pour une explication des options
Etiquettes semblables. Police ; HP Stick Font LI
REMARQUE : La case Appliquer étiquette doit d’abord étre sélectionnée Pasition X : I*“\”iére ﬂ IM
ici sur I'onglet Etiquettes des Options Travail afin d’activer les options
d’étiquettes sur les étiquettes de document par défaut et les onglets Postion*:  |Basse LI |C'-“

d’étiquettes de document individuel.

Unités ; Pauces ﬂ
r— =

90 j

*

Taille : |14 E_j
%

Trame de fond |1 ao j

Raotatiar :

K Antuler Réintislizer Uzing Aide




Options Tampons — pour travaux d’'impression

L’onglet Tampons des Options Travail permet d’ajouter un tampon sur le jeu
entier de document. Le tampon des Options Travail s’appliquera a chaque
document du travail d’impression en cours, sauf si les documents utilisent
un tampon précis. Le tampon du travail est prioritaire sur le tampon par
défaut de I'imprimante.

Pour activer cette fonction, sélectionner Appliquer tampon. Se reporter a
la section “Onglet Tampons — Réglages de document par défaut” de ce
guide pour une explication des options Tampons similaires.

REMARQUE : La case Appliquer tampon doit étre sélectionnée afin
d’accéder aux options de tampon pour les tampons de document par défaut
et les tampons de document individuel.

Edition des options de travail

Configuratic-ni Fin'rtinnl Camposition | Etiquettes  Tampons IRenduI Couleurl

Tampon : I
Raotation:  [490 w |

; 1+
Echelle : IReIatwe w | |1 ali} ﬂ
Position ¥ : [Centre S | IG.D
Pozition % : |Centre v | 0o
Unités : Fouces w |

K Antuler Réintislizer Uzing Aide
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Options Rendu — pour travaux d'impression

Appliquer Rendu - Sélectionner cette case pour activer les fonctions de
rendu sur cet onglet. Les choix effectués sur 'onglet Rendu - Options
Travail s'appliqueront & tout le travail et permettront d’effectuer les choix de
rendu sur les options Par défaut ou Document simple de la page Rendu.

Edition des options de travail | X|

Configuraﬁon' Fin'rtion' Composition' E‘liqueﬁes' Tampons  Rendu I Couleurl

Couleur et Monochrome

Sélection Auto

Type de document

Demi-teinte vecteur Rempliszage de zone

méthode de tramage: Tram demi-teinte

Largeur de ligne minimum (pixels) 1

Rendu lignes fines ech.de aris Contone

KN [RR{ENIEN(E]

=1

Seuil de pixels ignes fines

Ll Ll [l

Contraste
Clarté 0
Couleur
Maode Rendu Couleur v |
iode Guslite dimpresszion  |Rapide w I
Ok | Annuler | Réinitializer | Usine i Aicle |

Pour obtenir une explication des options de rendu, consulter la page
intitulée “Rendu pour travaux, options Par défaut et Document simple”.
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Options Couleur - pour travaux d’'impression

Les paramétres couleur par défaut de I'imprimante sont réglés sur le Web
PMT. Les réglages couleur pour les travaux d'impression individuels ou les
documents individuels, sont effectués sur I'onglet Soumission de e Sélectionner OK.
document, de la maniére suivante.

e |l est possible de répéter ce processus pour chaque type de support de
couleur listée.

Chemins de navigation :
Options Travail : All ez a |’ ongl et Souni ssion de docunent
> Bouton Options Travail > Onglet Coul eur Edition des options de travail
Couleur Options par défaut: Al l ez a |’ ongl et Souni ssi on de Configuration | Finition | compostion | Etiqusttes | Tampons | Rendu  Coulsur
docunent > Bouton Options Travail > Onglet Coul eur >

OK > Bouton Editer |es options par défaut > Ongl et

Support s Type de suppart : IPRESENTATION_?ED v|
Couleur Options Document simple : Al l ez & |’ ongl et
Soum ssi on de docunent > Bouton Options Travail > Limite toner{%)

Ongl et Couleur > OK > Cliquez deux fois sur un titre

de docunment > O]g| et SUppOftS v Appliguer Limite toner

Cyan 100 Cyan 1.0
* Type de Support - Cliquer sur cette liste déroulante pour sélectionner
e . Magenta 100 Magenta (1.0
le type de support utilisé pour les réglages couleur.
Jaune |1 an Jaune I‘l .0

e Sélectionner les cases Appliquer Limite toner et Appliquer
Gamma pour effectuer les réglages de couleur pour les travaux Mair Imn Mair !1.0
d’'impression qui utilisent le type de support sélectionné. L'utilisateur
peut spécifier les réglages d'option de travail Limite toner et/ou Gamma
pour plus d’'un type de support.

* Faire les sélections d’encre de couleur cyan, magenta, jaune et noir.

Limite toner est utilisé pour modifier la quantité maximale
d’encre utilisée pour I'impression. Les valeurs valides pour
Limite encre sont de 1% a 100%.

Ok Annuler Reinitializer Usine Aicle

Gamma est utilisé pour modifier toute la courbe des couleurs
sans en déplacer les points finaux. Cela permet de régler les
demi-teintes (un gamma plus élevé produit des demi-teintes
plus foncées), avec un effet minimal sur les ombres et les
surbrillances. Les valeurs valides pour la correction gamma de
sortie sont de 0,5 a 2,2.
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Outil File d’impression*

Sélectionner I'onglet File d'impression pour voir I'état des documents
envoyés a lI'imprimante a partir de la fenétre Soumission de document.
Avec cet outil, il est aussi possible d’annuler un travail d'impression. Les
rouleaux de papier qui sont dans I'imprimante AccXES sont listés en bas
de la page de I'outil File d'impression.

L'illustration ci-dessous est un exemple de file d'impression contenant un
travail en attente d’impression. Il y a 4 rouleaux de papier listés pour le
WIDE FORMAT PRINT SYSTEM 8855 auxquel est connecté le logiciel
Outils Client AccXES. Des colonnes d'information se trouvent & c6té de
chaque rouleau : la largeur du rouleau, le type de support (papier, calque,
film) et I'état du rouleau (plein, vide, niveau bas).
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, . .
Boutons de barre d’outils — File
. .

d’'impression

E E M &
Obtenir la Obtenir la Changer la Annuler le Aide pour
liste des liste des priorité du travail cet écran
travaux actifs travaux actifs travail d’'impression
et terminés dans la file d'impression  sélectionné
dans la file d'impression  sélectionné
d’'impression

REMARQUE : L'onglet File d'imprimante est désactivé lorsque I'imprimante
par défaut sur I'onglet Gestionnaire de périphérique est Impression au
fichier ou Port paralléle. L'onglet File d'imprimante est également désactivé
guand l'imprimante par défaut est un périphérique en réseau dont la case
“Communications AccXES a Client” est désélectionnée. Ceci parce qu’il n'y
a aucune communication bi-directionnelle pour les informations de files
d’attente a récupérer de I'imprimante.



Utilisation de I'outil File d’impression

. Sélectionner ce bouton de la barre d’outils pour visualiser tous les
travaux dans la file d'impression (travaux terminés et actifs). Au fur et a
mesure des changements, sélectionner de nouveau ce bouton pour voir
I'état de la progression. Ceci correspond a la méme fonction que celle du
bouton Obtenir état du Gestionnaire d'imprimante Web PMT.

! i Sélectionner ce bouton de la barre d’'outils pour voir uniquement
les travaux actifs. Continuer a le sélectionner pour vérifier la progression
de la soumission de travail.

' By

Pour changer la priorité d’un travail d’'impression, mettre en
évidence le nom du travail dans la fenétre File d'impression et sélectionner
ce bouton de la barre d’outils.

‘ @ ‘ Pour annuler un travail soumis , mettre en évidence le nom du

travail dans la fenétre File d'impression. Sélectionner le bouton de la barre
d’outils Annuler.
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Outil Facturation *

(L’Outil de facturation n’est activé que pour le micrologiciel AccXES
versions antérieures a 7.0)

Regarder dans la section Identification d’imprimante de I'onglet
Gestionnaire de périphériques pour localiser le numéro de version de
I'imprimante (micrologiciel AccXES) du périphérique sélectionné. Pour le
micrologiciel AccXES, version 7.0 et plus récent, I'onglet Facturation n’est
pas accessible. Dans ce cas, 'outil Gestion de comptes AccXES gere
I'utilisation de supports pour plusieurs imprimantes. Consulter le Guide du
responsable - Outil de gestion de comptes AccXES pour obtenir des
détails.

Les informations de la section “Outil Facturation” ne sont

nécessaires que pour les versions de micrologiciel antérieures a 7.0.
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A partir de la page d’outil Facturation, il est possible de demander au
contréleur AccXES les données d'utilisation du support du scanner et de
limprimante. Le mode Facturation doit étre réglé sur “Activé” ou
“Facultatif”, a la fois sur le scanner et sur I'imprimante, pour pouvoir
suivre I'utilisation du support avec des nombres de compte précis.
Autrement toutes les données d’utilisation de support seront attribuées au
compte par défaut 0.1. Les informations de facturation du contr6leur sont
accessibles et affichées dans la fenétre Rapport de facturation aprés avoir
sélectionné le bouton de la barre d’outils “Requéte...”. Chaque rangée
dans la fenétre Facturation correspond a I'utilisation de support pour un
numéro de compte et de sous-compte. Elle sera listée en pieds carrés ou
décimetres carrés par la quantité actuelle du type de support imprimé
(papier, calque, film) ou la zone numérisée utilisée. Les données
demandées peuvent étre imprimées sur un rapport.

Boutons de barre d’outils Facturation

Questionner Ecrire les données de  Aide pour cette page.
limprimante pour compte sur un fichier

connaitre les données (pour créer un rapport)

de compte




Options Facturation

MOT DE PASSE - Si un mot de passe est utilisé pour I'imprimante ou le
scanner, taper ce mot de passe dans la zone de mot de passe. Un mot de
passe est nécessaire pour accéder aux informations de facturation pour
des sous-comptes multiples ou si le numéro de sous-compte est O.

NUMERO DE COMPTE - Taper le numéro de compte.sous-compte pour
pouvoir récupérer les données d'utilisation de I'imprimante et du scanner.
Ces numéros de compte doivent étre identiques a ceux attribués par
'administrateur systéme et écrits sous forme décimale. Le numéro de
compte peut aller de 0 & 999999 et est écrit avant le point décimal. Le
numeéro de sous-compte peut aller de 0 a 9999 et est écrit apres le point
décimal. Par exemple, pour 2.3, 2 représente le numéro de compte, 3, le
numeéro de sous-compte. Zéro est utilisé pour le compte du systeme.

REMARQUE : Les numéros de compte demandés a partir de la zone
Numéro de compte de I'onglet Compte, ne pourront accéder gu’aux données
accumulées a partir de numéros de compte précis qui ont été créés sur le
scanner ou I'imprimante. Ces mémes numéros de compte doivent étre
attribués sur le scanner, le Gestionnaire d’'imprimante Web PMT ou
l'interface utilisateur de I'imprimante, ainsi que sur I'écran Options Travail
de Soumission de document pour que I'utilisation de support soit sur ces
comptes. Si un numéro de compte n’'est pas attribué au scanner, les
données d'utilisation par défaut seront attribuées au compte 0.1 du
systéme par défaut. Pour attribuer un numéro de compte lors de
l'impression d’un travail, passer a I'onglet Soumission de document >
Bouton de barre d’outils Options Travail > Onglet Configuration >
Zone ID de compte.

UNITES — Sélectionner I'affichage des données du rapport de facturation,
soit en pieds carrés, soit en décimeétres carrés.

Utilisation de I'outil Facturation

Demander des données de compte

* Taper le mot de passe, si nécessaire sur I'imprimante ou le scanner
(dans l'interface utilisateur de I'imprimante ou le Gestionnaire
d’'imprimante Web PMT), ou pour accéder aux données a partir de
comptes multiples.

e Vérifier que le Mode Compte est réglé sur “Activé” ou “Facultatif”
a la fois sur le scanner et l'interface utilisateur d’imprimante, ou bien
sur le Gestionnaire d'imprimante Web PMT.

* Demander a 'administrateur systéme quels numéros de compte et de
sous-compte utiliser pour soumettre, numériser ou récupérer des
documents. S'assurer d’ajouter ces numéros de compte aux zones
ID de compte de I'onglet Soumission de document > Bouton de barre
d'outils Options Travail > Onglet Configuration et sur I'onglet
Récupération de document.

e Sur I'onglet Facturation, taper le numéro de compte et de sous-
compte pour récupérer les données d'utilisation de support, par
exemple 3.0.

Si le compte ou le sous-compte n’est pas valide, un message
d’avertissement s’affiche et aucune information ne sera récupérée.

Pour récupérer les données de tous les comptes, utiliser le numéro de
compte —1.

Si une valeur autre que zéro est entrée pour le sous-compte, les
informations de facturation seront récupérées uniquement pour ce
compte et sous-compte précis. Si un zéro est entré pour le sous-
compte, les informations de facturation seront récupérées pour tous les
sous-comptes existants avec le numéro de compte précisé.

e Sélectionner les données, soit en pieds carrés, soit en
décimétres carrés.
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]| [eTe]}
100000,

. Appuyer sur “Requéte” pour accéder aux données de
facturation pour le(s) compte et sous-compte(s) demandés.

L’exemple qui suit correspond a une demande de données, numéro de
compte 3, qui montre toutes les données pour le compte principal 3.0 et
chaque sous-compte. Dans ce cas 3.3 est le seul sous-compte pour lequel
une utilisation de support (papier) a été attribuée.

REMARQUE : Tous les documents numérisés au scanner dans le mode
“Numeérisation pour imprimer” (les documents numérisés sont imprimés)
seront comptés dans les colonnes d'utilisation de support pour Papier,
Calque et Film. La colonne Numérisation affiche les données sur les
documents qui ont été numérisés en mode “numeérisation au réseau” (le
document numérisé est enregistré dans le contrdleur et récupéré a l'aide de
I'outil Récupération de document).

Facturation rRécupéra'iinn-de documerr’t"rﬁest'ibnna'ii'_e_de-pii'r.inhériques'_]
@ File d'impression

Soumission de document
i, %

Compte Linités

Mot de passe i ® Pieds carrés

Numéro de compte : 1 ) Décimitres carrés

Compte | Sous-compte | Papier de qualité | Calgue Filrm Murmérisation

ik o 138 o |0 1o
1 [ 38 o o o

Enregistrer les données de facturation

. @ Une fois que les données d'utilisation d'impression et de
numérisation demandées s’affichent dans la fenétre de la page
Facturation, appuyer sur le bouton de la barre d’outils Ecrire les
données de compte au fichier pour demander le dialogue Rapport de
facturation. Ce dialogue est utilisé pour préciser le format de fichier des
Données de facturation a Enregistrer pour créer un rapport. Il se trouve
a I'emplacement ou le nom de fichier est toujours précisé et ou le
fichier des données sera enregistré.
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E"Eﬁﬂappurt de facturation
Format du rapport

Séparateur : Tahulation

Guillemets : Aucuns -

Fichier de sortie

CATEMPIRapport! xls Parcourir...

Enregistrer

Annuler Ride

FORMAT DU RAPPORT

Séparateur — Choisir soit un espace (tabulation), soit une virgule entre
chaque colonne de données.

Guillemets — Choisir des guillemets autour de chaque jeu de données.

L’'exemple qui suit représente un format de rapport qui utilise une virgule
comme délimiteur entre les données et des doubles guillemets autour de
chaque piéce de données. Les nombres indiquent que le numéro de
compte 125 (colonne 1), les sous-comptes 11, 12 et 101 (colonne 2) ont
été demandés. Les autres colonnes donnent les données pour ces
comptes en fonction de I'utilisation du support pour le papier, le calque, le
film et les documents numérisés au réseau respectivement.

"125","11","364","44", "0","0"

"125", "12","274""48", "0","0"

"125","101", "0","0", “0","275"
Fichier de sortie — Taper un nom de fichier de rapport a utiliser lors de la
sauvegarde des données de facturation. Le bouton Parcourir peut servir a
sélectionner un répertoire ou un dossier dans lequel le rapport sera
enregistré. Pour Enregistrer les données dans un fichier Excel, ajouter une




extension de fichier .xIs au nom de fichier. Pour I'enregistrer avec Microsoft

Word, ajouter une extension .doc.

Si aucune extension n’est ajoutée, le document sera enregistré en texte,

avec les délimiteurs spécifiés. Il pourra étre ouvert avec WordPad ou Excel.
Autrement, pour ouvrir un fichier sans extension, il sera demandé de choisir

un type de fichier.

Créer et imprimer un rapport de facturation

Si les données de facturation sont enregistrées avec une extension de
fichier ajoutée au nom de fichier, ouvrir le document dans le logiciel ou
il est enregistré.

Ajouter tous les détails désirés, comme par exemple un titre descriptif
ou les en-tétes de colonne pour expliquer ce que représentent ces
nombres.

Enregistrer le fichier.

Imprimer le fichier normalement.

Supprimer des données dans un compte

Une fois les données de facturation enregistrées sur un fichier, il est
possible de supprimer le compte afin que seules les nouvelles données
apparaissent dans les futures demandes.

Pour remettre un compte a 0, passer & Facturation dans le
Gestionnaire d'imprimante Web PMT > option Remise a zéro du
compte. Entrer les numéros de compte et de sous-compte pour
lesquels la remise a zéro des données est désirée. Sélectionner le
bouton Remise a zéro.

Sur 'onglet Facturation du logiciel Outils Client AccXES, interroger le
méme numéro de compte et de sous-compte qui a été remis a zéro.
Vérifier qu’aucune donnée n'est encore dans le compte remis a zéro.
Cette interrogation peut aussi se faire sur le Gestionnaire d’'imprimante
Web PMT > Facturation > écran Rapports.
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Annexe 1 : Créer un fichier .FIN pour se connecter a une plieuse

REMARQUE IMPORTANTE : La plieuse doit étre connectée a I'imprimante de fagon a ce que le fichier exécutable puisse accéder a la plieuse pour créer le fichier .FIN correct
Création d'un fichier pour que le logiciel Outils Client AccXES se connecte ala plieuse :

*  Aller a http://www.xerox.com.

¢ Choisir Support et Pilotes.

* Aller a la section Grand format.

e Sélectionner le lien hypertexte qui se rapporte & “AccXES 88xx/ X2-Tech/ 510/ 721P".

* Sous le type de pilote, sélectionner Pilotes et téléchargement.

e Sélectionner le systeme d'exploitation et la langue. Appuyer sur le bouton Aller.

* Dans la section Utilitaires & Applications, choisir le “Créateur de fichier du module de finition”. Sauvegarder le fichier compressé au PC.

e Ouvrir le fichier .zip téléchargé pour extraire le fichier xesfin.exe. Sauvegarder celui-ci dans [Install Folder — tout comme Program Files)\AccXES\ACT10.0\etc\finisher (ou a
I'endroit ou les fichiers ACT ont été téléchargés). Le fichier exécutable va créer le fichier .FIN qui suit.

e Surle PC, aller au fichier exécutable téléchargé en sélectionnant Démarrer > Programmes > Invite de commande.

¢ Dans la fenétre Session (Command prompt), taper I'emplacement du fichier xesfin.exe téléchargé. L'écran suivant illustre le chemin au fichier xesfin.exe qui a été
téléchargé dans le dossier C:\Program Files\AccXES\ACT6.0\etc\finisher (voir fleches).



inisher

1 1m 1 e akim.

L
r.fim w

Program Fi

¢ Sélectionner le fichier exécutable xesfin.exe géneére les instructions ci-dessus pour créer le fichier FIN, a I'aide du format de xesfin adresse IP  folder.fin (voir
I'exemple dans le cercle ci-dessus, ou I'adresse IP est 13.142,199.2). Un message “Créé avec succes” indique quand le fichier FIN est créé et il peut étre sélectionné dans
le logiciel Outils Client AccXES comme suit.

¢ Aller a 'onglet Soumission de document > bouton Options Travail > onglet Finition.
e Sélectionner “Ajouter plieuse* dans la liste Type de plieuse.

e Sur la boite de dialogue “Sélectionner un module de finition”, localiser le fichier .FIN qui vient d’étre créé dans le dossier : Program Files/AccXES/ACT v#/etc/finisher folder.
(v# est le numéro de version ACT en cours). Cliquer sur “OK”.

* Laplieuse est ajoutée a la liste Type de plieuse et peut étre sélectionnée. Les méthodes de pliage appropriées pour ce type de plieuse sont indiquées dans le menu
déroulant Méthode de pliage.

REMARQUE : Seule la derniére plieuse ajoutée restera dans la liste Type de plieuseentre les sessions d’utilisation du logiciel Outils Client AccXES. Elle restera également
apres la désinstallation et l'installation d’ACT.

Guide de l'utilisateur Outils Client AcCXES 81



Guide de l'utilisateur Outils Client AccXES

Annexe 2 : Formats de papier

Papiers et formats de rouleaux compatibles avec
ACcXES

Pour visualiser la liste en cours des formats pour votre imprimante, dans le Web
PMT, sélectionner les menus déroulants VALEURS PAR DEFAUT IMPRIMANTE >
VALEURS PAR DEFAUT DE TRAITEMENT> Support > Format de support et
Type de support.
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Annexe 3 : Assemblage et Ordre d’'impression inverse

Combinaisons d’Assemblage et d’Ordre d'impression inverse

Trois documents (A, B, C) ont été envoyés a partir de I'écran Soumission de document a I'imprimante qui imprime les documents avec face vers le haut. Chaque page qui sort
de I'imprimante, s’empile avec la face vers le haut au-dessus de la derniére page imprimée. Deux copies ont été demandées et chacun des trois documents contenait trois
pages, comme indiqué ci-dessous.

Document A : Pages Al, A2, A3
Document B : Pages B1, B2, B3
Document C : Pages C1, C2, C3

Le tableau ci-dessous présente les différentes combinaisons d’assemblage et d’ordre d’'impression inverse qui peuvent étre sélectionnées dans la partie inférieure de I'onglet
Soumission de document, ou sur I'onglet Options Travail > Finition. La ligne en caractéres gras indique le choix le plus courant pour obtenir des copies multiples de
plusieurs documents. Ce choix génére une pile de documents imprimés qui se trouve dans le méme ordre de documents et de page que dans la liste de la fenétre Soumission
de document. La premiére copie triée sera imprimée en premier lieu, puis la seconde.

Assemblage | Ordre d'impression Ordre de sortie de I'imprimante
inverse
Aucun Case non cochée Al,A1,A2,A2,A3,A3, B1B1,B2B2B3B3 C1,C1C2C2C3,C3
Inverse Case non cochée Al,A2,A3, B1,B2,B3, C1,C2,C3, AlA2A3, B1,B2B3, C1,C2.C3
Normal Case non cochée C3,C2,C1, B3,B2,B1, A3,A2A1 (C3,C2,Cl, B3,B2,B1, A3A2A1l
Aucun Case cochée C1,C1,C2,C2,C3,C3, B1,B1,B2,B2,B3,B3, Al,A1,A2A2A3A3
Inverse Case cochée C1,C2,C3, B1,B2,B3, Al,A2A3, C1,C2,C3, B1B2B3, AlA2A3
Normal Case cochée A3,A2,Al, B3B2B1, C3,C2,Cl, A3A2Al, B3,B2B1, C3,C2C1

REMARQUE : Pour les tracés d’'une seule page, choisir Assemblage inverse et Ordre d’impression inverse.

REMARQUE : Certains fichiers PostScript peuvent influencer les résultats de sortie de I'imprimante. Voir Annexe 4 pour plus d’'informations.

Guide de l'utilisateur Outils Client AcCXES 83



Guide de l'utilisateur Outils Client AccXES 84

Annexe 4 : Impression de fichiers PostScript

Le langage PostScript supporte la capacité de modifier des options de copies, d’assemblage et de finition (Module de finition Gera uniquement). Ces commandes peuvent étre
utilisées pour tout le travail, pas uniquement les parties PostScript. Cette annexe décrit les regles utilisées pour fusionner les demandes du logiciel Outils Client AccXES et
PostScript.

Cette annexe est nécessaire uniquement si un fichier PostScript contient un ou plusieurs des éléments suivants :
¢ Réglage du parametre de périphérique de la page Assemblage (via setpagedevice)

* Réglage du paramétre de périphérique de la page Pliage (via setpagedevice)

¢ Réglage du parametre de périphérique de la page NomCopies (via setpagedevice ou via #copies)

REMARQUE: Si votre fichier PostScript ne contient pas ces opérateurs, alors il ne faut pas tenir compte de cette annexe.

Interaction entre les options Copies, Assemblage et Finition PostScript

Les commandes PostScript pour Assemblage, Pliage et Copies peuvent étre utilisées 1) pour le fichier PostScript uniqguement ou 2) tout le travail :

e Pour un travail a format de données unique* contenant un entéte PJL et un fichier PostScript, les paramétres de copies, d'assemblage et de finition spécifiés dans le fichier
PostScript priment pour le travail et fonctionnent selon le Manuel de référence du langage PostScript. [Si le parameétre d’assemblage PostScript est vrai, la copie PostScript
est un parametre de travail — si I'assemblage PostScript est faux, la copie PostScript est un parametre de page.]

e Pour un travail a plusieurs brmats de données* contenant un en-téte PJL, le fichier 1 est de n'importe quel format SAUF PostScript et le fichier 2 (ou plus avancé) est de
n’'importe quel format y compris PostScript. Les parameétres d’en-téte PJL pour copies, assemblage et finition priment pour tous les fichiers du travail. Si le fichier 2 (ou plus
avanceé) est un fichier PostScript spécifiant 'assemblage ou la finition, alors ces valeurs PostScript d’assemblage et de finition sont ignorées. Si le fichier PostScript spécifie
les copies, cette valeur est appliquée au fichier PostScript uniquement.

e Pour un travail a plusieurs formats de données* contenant un en-téte PJL, si le fichier 1 est un travail PostScript spécifiant les copies, 'assemblage ou la finition, les valeurs
PostScript pour 'assemblage et la finition priment pour TOUS les fichiers du travail et fonctionnent selon le Manuel de référence du langage PostScript [voir I'élément 1].
* Unréglage PostScript d’Assemblage = True maps pour un réglage AccXES d’Assemblage = Auto.

*REMARQUE : Si les pages de garde sont activées AVANT le travail, celui-ci est traité comme un travail a plusieurs formats de données avec la page de garde comme fichier
1.




Impression des fichiers PostScript avec le DST dans le logiciel Outils Client AccXES

Si le fichier PostScript ne contient pas les réglages pour Assemblage, Pliage ou Copies :
¢ Les réglages de I'outil Soumission de document priment toujours par rapport aux réglages de I'imprimante par défaut et sont utilisés pour le(s) fichier(s) PostScript.

Si le fichier PostScript est le premier fichier de la liste de documents de I'outil Soumission de document et qu’il contient les réglages pour Assemblage et
Pliage :

* Les réglages du fichier PostScript priment par rapport aux réglages de I'outil Soumission de document et de I'imprimante. Ces réglages sont également utilisés comme
paramétres de TRAVAIL et s’appliquent & TOUS les fichiers du travail d’'impression de I'outil Soumission de document.

Si le fichier PostScript est le premier fichier de la liste de documents de I'outil Soumission de document et qu’il contient les réglages pour Copieset
Assemblage:

e Le réglage Assemblage=Faux du fichier PostScript prime par rapport aux valeurs par défaut d’imprimante ou au réglage de I'outil Soumission de document.

* Lorsque Assemblage=Faux est utilisé en méme temps que le réglage Copies dans un fichier PostScript, le réglage Copies affecte UNIQUEMENT ce fichier PostScript de la
liste de documents.

* Sile réglage d’assemblage est vrai (p. ex. Assemblage=Vrai), le réglage de copie du fichier PostScript s'applique a TOUS les fichiers du travail d'impression de I'outil
Soumission de document.

Si le fichier PostScript n’est PAS le premier fichier de la liste de I'outil Soumission de document et s’il contient les réglages pour Assemblage, Pliage et Copies :

e Les réglages de I'outil Soumission de document priment toujours par rapport au réglage du fichier PostScript. Les réglages Soumission de document sont considérés
comme paramétres de TRAVAIL et s’appliquent & TOUS les fichiers de la liste de documents.

* Le réglage de copies du fichier PostScript s’applique au fichier PostScript UNIQUEMENT quelque soit le réglage de copie de I'outil Soumission de document.
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Exemples

EXEMPLES avec Copieset Assemblage réglés dans DST et avec le fichier PostScript en premier dans la liste de documents.

EXAMPLE 1:
Les parameétres sont :
- Dans I'outil Soumission de document, Copies = 2
Dans le fichier PostScript, Assemblage est FAUX
- Dans le fichier PostScript, Copies = 3.
- Les documents de la liste de documents sont :
<Fichier PostScript>
<Fichier #1 Non-PostScript>
<Fichier #2 Non-PostScript>
La sortie est : 6 copies de - <Fichier PostScript>
2 copies de - <Fichier #1 Non-PostScript>
2 copies de - <Fichier #2 Non-PostScript>
Ceci est d au fichier PostScript contenant les paramétres : Assemblage = Faux et Copies = 3

EXEMPLE 2 :

Les parameétres sont :
- Dans I'outil Soumission de document, Copies=2
- Dans le fichier PostScript, Assemblage est VRAI
- Dans le format de fichier PostScript, copies = 3
- Les documents de la liste de documents sont : <Fichier PostScript> <Fichier #1 non-PostScript> <Fichier #2 non-PostScript>
La sortie est :

1 copie de - <Fichier PostScript>

1 copie de - <Fichier #1 non-PostScript>

1 copie de - <Fichier #2 non-PostScript>

1 copie de - <Fichier PostScript>

1 copie de - <Fichier #1 non-PostScript>

1 copie de - <Fichier #2 non-PostScript>

1 copie de - <Fichier PostScript>

1 copie de - <Fichier #1 non-PostScript>

1 copie de - <Fichier #2 non-PostScript>

Ceci est d0 au fichier PostScript contenant les paramétres : Assemblage = Vrai et Copies = 3
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EXEMPLES avec Pliage réglé dans DST et un fichier PostScript est en premier dans la liste de documents.

EXEMPLE 3 :
Les paramétres :
- Incluent “Pli ISO — 210 mm” dans l'outil Soumission de document
- Fichier PostScript régle le pliage sur DESACTIVE.
- Les documents de la liste de documents sont :
<Fichier PostScript>
<Fichier #1 non-PostScript>
<Fichier #2 non-PostScript>

La sortie est :
1 copie de - <Fichier PostScript>
1 copie de - <Fichier #1 non-PostScript>
1 copie de - <Fichier #1 non-PostScript>

TOUS les fichiers ne sont PAS pliés . Cela est di au fichier PostScript contenant un réglage NE PAS plier les documents envoyés sur le pont.

EXEMPLE 4 :
Les parametres sont :
- “Pliage — DEVIATION PLIEUSE" dans I'outil Soumission de document
- Fichier PosScript régle le pliage sur ACTIVE.
- Les documents de la liste de documents sont :
<Fichier PostScript>
<Fichier #1 non-PostScript>
<Fichier #2 non-PostScript>

La sortie est :
1 copie de - <Fichier PostScript>
1 copie de - <Fichier #1 non-PostScript>
1 copie de - <Fichier #1 non-PostScript>

TOUS les fichiers sont PLIES. Cela est dii au fichier PostScript contenant un réglage Plier les documents et NE PAS envoyer les documents sur le pont.
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EXEMPLES avec Assemblage réglé dans DST et un fichier PostScript est en premier dans la liste de documents.

EXEMPLE 5:
Les paramétres sont :
- L’outil Soumission de document inclut : Assemblage = AVANT/INVERSE, Copies = 3
- Dans le fichier PostScript, Assemblage = DESACTIVE
- Les documents de la liste de documents sont :
<Fichier PostScript>
<Fichier #1 non-PostScript>
<Fichier #2 non-PostScript>
La sortie est :
3 copies de - <Fichier PostScript>
3 copies de - <Fichier #1 non-PostScript>
3 copies de - <Fichier #1 non-PostScript>

Cela est d@ au fichier PostScript contenant un réglage NE PAS assembler les documents.

EXEMPLE 6 :
Les paramétres :
- Dans I'outil Soumission de document, Assemblage = AUCUN, Copies =3
- Dans le fichier PostScript, Assemblage = ACTIVE.
- Les documents de la liste de documents sont : <Fichier PostScript> <Fichier #1 non-PostScript> <Fichier #2 non-PostScript>
La sortie est :

1 copie de - <Fichier PostScript>

1 copie de - <Fichier #1 non-PostScript>

1 copie de - <Fichier #2 non-PostScript>

1 copie de - <Fichier PostScript>

1 copie de - <Fichier #1 non-PostScript>

1 copie de - <Fichier #2 non-PostScript>

1 copie de - <Fichier PostScript>

1 copie de - <Fichier #1 non-PostScript>

1 copie de - <Fichier #2 non-PostScript>

Cela est di au fichier PostScript contenant un réglage pour assembler les documents.



Annexe 5: Accées de navigation et valeurs par défaut

pour les options Outils Client AccXES

FONCTION DEFAUT ACCES DE NAVIGATION POUR LOCALISER LA FONCTION

QZ%ZS a Iéditeur de Onglet Récupération de document > I!Z' ou (Récupération > Configuration de la récupération) > Bouton
Parcourir pour localiser I'accés a I'éditeur de tracé (comme Photo Shop)

Adresse IP Adresse IP =0.0.0.0 Onglet Gestionnaire de périphériques
Modifier >, Configurer I'afficheur

Afficheur

Modifier >, Lancer I'afficheur

Ajouter documents au
jeu

Annuler la liste
numérisée et Oui
continuer sur Quitter

Cliquer et déplacer le nom du fichier du systéme de fichier a la fenétre Soumission de document ou

sélectionner I'onglet Soumission de document > L% I, (ou sélectionner Document > Ajout de Document).
Utiliser les touches du clavier “Ctrl” ou “Maj.” pour sélectionner plusieurs documents dans I'ordre dans lequel ils
sont listés. Cliquer sur le bouton “Ajouter”. Cliquer sur le bouton “Terminé”.

Onglet Récupération de document > I:’;: > case a cocher

Annuler le travail

Onglet File d'impression > sélectionner le titre du travail > @ ou le bouton Annuler en bas de I'écran de

d’impression File d’impression. S'il est trop tard, annuler la page principale de Web PMT (Sélectionner fichier dans la File
d’impression pour pouvoir annuler I'écran).
Apercu auto Oui (Voir Apercu, Automatique)

Apercu, arrét
automatique

Apercu, image
numeérisée

Onglet Récupération de document > 'ﬂ ! ou Récupération > Arrét

Onglet Récupération de document > Double clic sur un titre de document dans les fenétres Numérisés ou
Récupérés (ou choisir un titre, puis Image > Apercu) ou cliquer avec le bouton droit de la souris sur Nom de
fichier > Apercu. Si l'apercu ne s’affiche pas, vérifier si “Créer un apergu” est activé sur le scanner.
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FONCTION DEFAUT ACCES DE NAVIGATION POUR LOCALISER LA FONCTION
Assemblage Aucun Onglet Soumission de document EZI ou (ou Travail > Options Travail) > Onglet Finition
Bloc de titre, options Non @
par défaut Onglet Soumission de document > =i > Onglet Transformation
{B.lzsa?le titre, Options Non Onglet Soumission de document > EZ' > Onglet Finition, ou double clic sur un nom de fichier > Onglet
Finition
Blocs de t|tr_e sur Non Onglet Soumission de document > double clic sur Nom de fichier > Onglet Transformation
documents individuels
Boite de liste de mise . L
Désactivé

al'échelle

Checksum=Oui

Ty
Onglet Soumission de document > = ou double clic sur le titre du travail > Onglet Transformation

EOM Text=13
Compte EOP =2
ForcePlot =Oui
manuel = Non E\j
CalComp ’F\,‘;)S::iuc;ﬁce: Non Onglet Soumission de document > = ou double clic sur un nom de fichier > Onglet Configuration (Il est
SearchAddress=les 2 aussi possible de sélectionner un nom de fichier sur la fenétre Soumission de document, puis Document >
StartPlot=Ovui Modifier.) > Format de fichier : sélectionner CalComp > Onglet CalComp.
StepSizeText=2032
SYNC count=2
SYNC Text=22
Haut du formulaire=Oui
Calsl. Cals? Onglet Soumission de document > === ou double clic sur un nom de fichier > Onglet Configuration (Il est
’ aussi possible de sélectionner un nom de fichier sur la fenétre Soumission de document, puis Document >
Modifier.) > Format de fichier : sélectionner Cals1 ou Cals2
CGM Onglet Soumission de document > ="l ou double clic sur un nom de fichier > Onglet Configuration > (Il est

aussi possible de sélectionner un nom de fichier sur la fenétre Soumission de document, puis Document >
Modifier.) > Format de fichier : sélectionner CGM

Coller les options de
document copiées

Onglet Soumission de document > Sélectionner un titre de document dans lequel les options copiées seront
collées > Document > Coller Options (ou cliquer avec le bouton droit de la souris sur le nom de fichier > Coller
Options)




FONCTION DEFAUT ACCES DE NAVIGATION POUR LOCALISER LA FONCTION

Coller un document Onglet Soumission de document > ﬂ !, (ou cliquer avec le bouton droit de la souris sur le nom de fichier) ou
Modifier > Coller

Composition Non E”)

automatique Onglet Soumission de document > , (ou Travail > Options Travail) > Onglet Composition

Composition de page

Pour un travail : Onglet Soumission de document > Eb (ou sélectionner Travail > Options Travail) > Onglet
Composition

Pour des documents : Double clic sur un nom de fichier, (ou sélectionner un nom de fichier > Document >
Modifier) > Onglet Composition

Configurer l'afficheur

Modifier > Configurer I'afficheur

Configuration de récu-
pération (préférences
utilisateur)

=
Onglet Récupération de document > E}J

Connexions de réseau

Adresse IP =0.0.0.0
Nom de périphérique =
Nouveau périphérique

Onglet Gestionnaire de périphériques

Copier document d’un
jeu de document

Couper un document
a partir d'un jeu

Date, incluse dans le
nom fichier numérisé

Onglet Soumission de document > sélectionner un titre de document (ou cliquer avec le bouton droit de la

souris sur le nom de fichier) > Ih" ou Modifier > Copier
Onglet Soumission de document > sélectionner un titre de document (ou cliquer avec le bouton droit de la

souris sur le nom de fichier) > 'li'é' ! ou Modifier > Couper

=
Onglet Récupération de document > I:ij > case a cocher

Dé-sélectionner tous
les fichiers de jeu de
document

Onglet Soumission de document > Modifier > Dé-sélectionner tout (Tous les noms de fichier mis en évidence
seront dé-sélectionnés.)

Discordance de
supports

Discordance de
supports

Mise a I'échelle
variable
Mise & I'échelle
variable

Onglet Soumission de document > E\;’}' (ou sélectionner Travail > Options Travail ) > Onglet Finition

Onglet Soumission de document > E?,I (ou sélectionner Travail > Options Travail ) > Onglet Finition
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FONCTION DEFAUT ACCES DE NAVIGATION POUR LOCALISER LA FONCTION
Document, ajouter au QJ
jeu Onglet Soumission de document > Ld], (ou sélectionner Document > Ajout de document)

Document, insérer
dans un jeu

Onglet Soumission de document > '.'%!: ou Document > Insérer document

Document, modifier
les options
Document - Ouvrir jeu
document enregistré

Onglet Soumission de document > Double clic sur le titre d’'un document ou sélectionner un nom de fichier >
Document > Modifier pour modifier les écrans

Fichier > Ouvrir

Imprimante par

Emboitement de tracé défaut

Onglet Soumission de document > E£ , (ou sélectionner Travail > Options Travail)> Onglet Composition

Enregistrer le jeu de
document

Onglet Soumission de document > Fichier > Enregistrer

Enregistrer jeu de
document sous
nouveau nom

Onglet Soumission de document > Fichier > Enregistrer sous

Enregistrer les images
récupérées

Onglet Récupération de document > || ou Image > Garder tout, (ou sélectionner images > Image > Garder
Image)

Etat du support

Onglet File d'impression > -Iou ﬂ

> voir au bas de I'écran

Applig. étiquette= Non
Police =Police HP Stick
Rotation = 90 degrés
Ombrage =100

Taille de police = 14
Unités = Pouces

Pos. X = Bord arriére
Position Y = Bas
Texte X,Y = 0.0

Etiquette par défaut

Onglet Soumission de document > E£ , (ou sélectionner Travail > Options Travail ) > sélectionner Appliquer

B
Etiquette , OK > IEJ ou ===1 ou double clic sur un nom de fichier, (ou sélectionner un nom de fichier >
Document > Modifier) > Onglet Etiquettes

Etiquettes — pour
documents uniques

Onglet Soumission de document > E?j (ou sélectionner Travail > Options Travail). Sélectionner Appliquer
étiquette, OK. Puis, double clic sur un nom de fichier, (ou sélectionner un nom de fichier > Document >
Modifier) > Onglet Etiquettes pour les étiquettes de document individuel
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Etiquettes — pour un Onglet Soumission de document > Eﬁl , (ou sélectionner Travail > Options Travail ) > Sélectionner Appliquer
document par défaut E‘f]
étiquette, OK > = > Onglet Etiquettes
Etiquettes — pour un @
travail Onglet Soumission de document > !, (ou sélectionner Travail > Options Travail ) > Onglet Etiquettes
Facteur de mise a 100 Eb
I'échelle Onglet Soumission de document > === ou double clic sur le titre du travail > Onglet Transformation
Le fichier .FIN se trouve dans le dossier etc., ou le logiciel ACT est installé (p. ex. : Fichiers de
Fichier FIN programme/AccXES/ACT 5.1/etc/module de finition/Nom du module de finition & installer.) Cliquer sur OK pour
ajouter la plieuse.
Onglet File d'impression > utiliser les boutons de la barre d’outils pour mettre a jour I'état des travaux actifs
File d'impression et/ou terminés (pendant que le travail est dans la file d’attente, aprés avoir changer les rouleaux de papier ou
avoir soumis plus de travaux)
i Lol
Fonctions d_e Onglet Soumission de document > D ou double clic sur un nom de fichier, (ou sélectionner un nom de
transformation - - .
fichier > Document > Modifier) > Onglet Transformation
- &
Format de fichier glit:rf]g%gue Onglet Soumission de document > E\j ou double clic sur un nom de fichier, (ou sélectionner un nom de

Format de support,
type, source - travail

Format de support,
type, source (valeurs
par défaut ou
document simple)

Format= ANSI E
Type couleur=Tout

Type monochrome =
Supérieur
Source=Sélection
automatique

Format=Tout

Type couleur =Tout
Type mono = Sup.
Source=Sélection
automatique

fichier > Document > Modifier) > Onglet Configuration > menu déroulant Format de fichier

Onglet Soumission de document > @ (ou sélectionner Travail > Options Travail ) > Onglet Composition

Imprimante compatibles AccXES : Installer pour chaque rouleau, les mémes types de support dans l'interface
utilisateur de I'imprimante.

WIDE FORMAT PRINT SYSTEM 8855 : Appuyer sur les boutons de type de support des plateaux de réception
de l'imprimante, a c6té de chaque rouleau : dessin industriel ou d’architecture et papier, calque ou film.

&
Onglet Soumission de document > Eﬁ' ou double clic sur un nom de fichier, (ou sélectionner un nom de
fichier > Document > Modifier) > Onglet Support
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FONCTION DEFAUT ACCES DE NAVIGATION POUR LOCALISER LA FONCTION
AF = Oui
AH = Oui
FR = Oui
NR = Non .
PG = Oui :
HPGL RP = Oui Onglet Soumission de document > === ou double clic sur un nom de fichier, (ou sélectionner un nom de
SISPO =Non ) fichier > Document > Modifier) > Onglet Configuration > Format de fichier : sélectionner HPGL > onglet HPGL
Traceur hors fonction =
Oui
Détection support de
zone dessinée = Non
ID de compte 0.1 Onglet Soumission de document > E;)’ , (ou Travail > Options Travail)> Onglet Configuration. Si I'option
' Facturation est activée et que I'imprimante utilise le micrologiciel AccXES 7.0 ou plus récent, il faut également
entrer I'ID utilisateur attribuée.
D utilisateur IDUtilisateurGeénériq  Onglet Soumission de document ou IEZ) . (ou Travail > Options Travail) > Onglet Configuration. Si I'option

ue

Facturation est activée et que I'imprimante utilise le micrologiciel AccXES 7.0 ou plus récent, il faut également
entrer I'ID de compte attribuée.

Image récupérée,
ajouter au jeu

Images de
recouvrement

Non

Onglet Récupération de document > sélectionner un nom de fichier récupéré > Image > Assembler Image

Onglet Soumission de document > @ (ou sélectionner Travail > Options Travail ) > Onglet Composition

Images numérisées,
ajouter au jeu de
document

Onglet Récupération de document > mettre en évidence d’un nom de fichier Récupéré > Image > Fusionner
Image (ou cliquer avec le bouton droit de la souris > Sélectionner tout > Image > Fusionner tout). Les
documents seront copiés de la fenétre Soumission de document, retirés de la fenétre Récupération de
document et enregistrés dans le systeme de fichiers.

Images numérisées,
apercu

) s h . .
Onglet Récupération de document > ﬁ| ou Image > Apercu, (ou cliquer avec le bouton droit de la souris >
Apercu)

Images numérisées,
Enregistrer images
récupérées

~ |
Onglet Récupération de document > =Ml oy Image > Garder tout, (ou Image > Garder Image) ou cliquer avec
le bouton droit de la souris > Garder tout

Images numérisées,
liste

=
Onglet Récupération de document > ¥ [ ou Récupération > Liste
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Images numérisées,
récupération

Images numérisées,
supprimer

Images récupérées,
ajouter toutes les
images au jeu

Onglet Récupération de document > L= ou Récupération > Récupérer tout, (ou Récupération > Récupération
Image)

Onglet Récupération de document > mettre en évidence un nom de fichier dans la fenétre Image ou Récupérés

*
> B oy Modifier > Supprimer

Onglet Récupération de document > Image > Assembler tout

Images, superposition Non

Onglet Soumission de document > Eb (ou sélectionner Travail > Options Travail) > Onglet Composition

Imprimante, défaut

Onglet Gestionnaire de périphériques

Imprimer au fichier

Imprimer un jeu de
document enregistré

Imprimer un nouveau
jeu de document

Onglet Gestionnaire de périphériques

Onglet Soumission de document > Fichier > Ouvrir > Sélectionner un nom de fichier .xds > bouton Ouvrir > Les
e

documents dans le jeu seront listés dans la fenétre Soumission de document. > 2| ou Fichier > Imprimer,

(ou Travail > Impression)

Onglet Soumission de document > Utiliser | &=l pour ajouter des documents & la fenétre. Sélectionner — ||

ou Fichier File > Impression, (ou Travail > Impression)

Insérer le document
dans le jeu

Onglet Soumission de document > '.'%!: ou Document > Insérer document

Jeu de document,
créer un jeu

Jeu de document,
Options Travail

Onglet Soumission de document > Fichier > Nouveau > Utiliser les boutons Ajouter | ‘-tl_%'_ et Insérer "% L
est aussi possible de cliquer et de faire glisser un nom de fichier du systéme de fichiers ou bien d’envoyer un
fichier de la fenétre Récupération de document & la fenétre DST.

Onglet Soumission de document > E"\j ou sélectionner Travail > Options Travail

Jeu de document,
ouvrir un jeu existant

JPEG

Onglet Soumission de document > Fichier > Ouvrir

£
Onglet Soumission de document > Eﬁ ou double clic sur un nom de fichier > onglet Configuration > Format
de fichier : JPEG
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FONCTION DEFAUT ACCES DE NAVIGATION POUR LOCALISER LA FONCTION
Unités = Pouces @:\j

Justification X, Y = Centre Onglet Soumission de document > = ou double clic sur un nom de fichier, (ou sélectionner un nom de
Texte = 0.0 fichier > Document > Modifiers) > Onglet Transformation

Lancer I'afficheur Modifier > Lancer l'afficheur

Miroir X, Y Non

Mise a I'échelle

Tampon = Relatif

kLl
Onglet Soumission de document > D ou double clic sur un nom de fichier > Onglet Transformation

Onglet Soumission de document > @I (ou sélectionner Travail > Options Travail ) > Onglet Tampons

Transformer = @
Désactivé Onglet Soumission de document > =1 ou double clic sur un nom de fichier, (ou sélectionner un nom de
fichier > Document > Modifier) > Onglet Transformation et Onglet Tampons
Mise a I'échelle Onglet Soumlssmn_de document > === lou dou_ble clic sur le titre du travallr (ou selectlc_)nner un nom de fichier
Non > Document > Modifier) > Onglet Composition. Si un format de support précis est sélectionné sur I'onglet

variable

Mise a I'échelle
variable, discordance
de file d’attente

Mise & I'échelle
variable

Support, I'option Mise a I'échelle variable sera aussi ajoutée au menu déroulant de mise a I'échelle sur I'onglet
Transformation.

Onglet Soumission de document > EE' (ou sélectionner Travail > Options Travail ) > Onglet Finition

NIRS

E
Onglet Soumission de document > I:f:' ou double clic sur un nom de fichier > Onglet Configuration > Format
de fichier : NIRS

Nom de travail

Onglet Soumission de document ou Eﬁ' ou sélectionner Travail > Options Travail > Onglet Configuration

Nom de travail
d’impression, pour
créer

Onglet Soumission de document > E\E’" (ou sélectionner Travail > Options Travail ) > Onglet Configuration

Nombre
d’exemplaires,
nombre de

Onglet Soumission de document @ ou (ou Travail > Options Travail) > Onglet Configuration
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Options couleur —
pour document par
défaut

Options par défaut couleur: Allez & I'onglet Soumission de document > bouton Options du travail > Onglet
Couleur > Sélectionner le type de support > Sélectionnez les Appliquer Limite toner et/ou Appliquer Gamma >

m
OK > Allez a I'onglet Soumission de document > = > sélectionner I'onglet Support

Options couleur —
pour un travail

Options Travail : Allez & I'onglet Soumission de document > @" > onglet Couleur

Options de copie doc
au presse-papiers

Options de document

Onglet Soumission de document > sélectionner un titre de document > Document (ou cliquer avec le bouton
droit de la souris sur le nom de fichier) > Options de copie

Onglet Soumission de document > Double clic sur le nom de fichier ou sélectionner le nom de fichier et
sélectionner Document > Modifier

Options Travail

Onglet Soumission de document > Ebi ou sélectionner Travail > Options Travail

Options défaut,
Enregistrer comme
fichier

Onglet Soumission de document > sélectionner un titre de document > Document > Enregistrer Valeurs par
défaut sous

Options Finition de
travail

Onglet Soumission de document > EE' ou sélectionner Job > Job Options > Onglet Finition

Options Finition par
document défaut

Options Finition par
Document simple

Onglet Soumission de document > > Onglet Finition> sélectionnez le type de plieuse > (If the printer
selected on the Device Manager Tab has AccXES firmware prior to version 9.0, and it supports bi-directional
communication, you also need to select a Folding Method.) > OK > Bouton Editer options par défaut > Onglet
Finition > cochez la case Appliquer Finition

Onglet Soumission de document > Bouton Options de travail > Onglet Finition > sélectionnez le type de plieuse
> (If the printer selected on the Device Manager Tab has AccXES firmware prior to version 9.0, and it supports
bi-directional communication, you also need to select a Folding Method.) > OK > cliquez deux fois sur un titre
de document > Onglet Finition > cochez la case Appliquer Finition
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Options Imprimer — L Z A . o

document par défaut Ongle,t Soumission de document > === ou sélectionner un document, puis Document > Modifier de Valeurs
par défaut

Options Imprimer —

pour travail @

d’impression ou jeu de Onglet Soumission de document et | ou sélectionner Travail > Options Travail

document

Options Imprimer — Onglet Soumission de document > Double clic sur un nom de fichier ou sélectionner un document, puis

documents uniques Document > Modifier

Options par défaut de E\_’:l

document Onglet Soumission de document > = ou sélectionner Document > Modifier Valeurs par défaut

Options par défaut

pour tout document Eb

ajouté au jeu de Onglet Soumission de document > il

document

Options par défaut

pour un seul Onglet Soumission de document > Double clic sur le titre du document ou sélectionner un nom de fichier >

document, pour Document > Modifier pour modifier les écrans

changer

Options par défaut,

pour ouvrir les options Onglet Soumission de document > Document > Ouvrir Défaut > Sélectionner le fichier de réglages d'options par

par défaut défaut

enregistrées

Ordre d'impression Eb

inverse Onglet Soumission de document ou |, (ou Travail > Options Travail) > onglet Finition

Ouvrir un jeu de N Onglet Soumission de document > Fichier > Ouvrir

document enregistrés

Page de garde Non Onglet Soumission de document > E?j (ou Travail > Options Travail)> Onglet Finition

PDF Onglet Soumission de document > E\fﬁ 1 ou double clic sur un nom de fichier (ou sélectionner un nom de
fichier > Document > Modifier) > Onglet Configuration > Format de fichier : PDF et Optimisation PDF

Périphériques

disponibles

Onglet Gestionnaire de périphériques
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Type = Aucun
Méthode=sans pli
Plieuse Pli croise, Marge, Onglet Soumission de document > Eé': ou sélectionner Travail > Options Travail > Onglet Finition
Perforation,languette de
renforcement = dépend
du module de finition
Ports Onglet Gestionnaire de périphériques
PostScript Fonctlpn facultative, Onglet Soumission de document > l:\-/:' ! ou double clic sur un nom de fichier, (ou sélectionner un nom de
sous licence fichier > Document > Modifier) > Onglet Configuration > Format de fichier : sélectionner PostScript et Utiliser
Couleur CIE et/ou Mettre & jour les valeurs par défaut
Préfixe de fichier pour
noms de fichier MYSCAN Onglet Récupération de document
d’images récupérées
b |
Priorité de travail Onglet Soumission de document ou Onglet File d'impression > ou I'onglet Soumission de document >
d’'impression Ek'
| (ou sélectionner Travail > Options Travail ) > Onglet Configuration
_— . - - _ Hify -
Priorité de travail 5 Onglet Soumission de document ou onglet File d'impression > , (or Onglet Soumission de document >
d’impression E::I
!> Onglet Configuration
Récupération -

automatique des
images numérisées

Onglet Récupération de document > 4= ou Récupération > Interrogation auto

Récupération
automatique d'image
(interrogation auto)
Récupération de
toutes les ‘images
numérisées dans un
compte spécifié

15 secondes

=
hent: {
Onglet Récupération de document > 4=, Pour arréter Interrogation auto, sélectionner ﬂ |

Onglet Récupération de document > i ou Récupération > Récupération tout
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ACCES DE NAVIGATION POUR LOCALISER LA FONCTION

Récupération des
images numérisées
sélectionnées
Rendu — pour
documents simples

Onglet Récupération de document >sélectionner images dans la fenétre Image> Récupération > Récupération
Image

Options Document simple : Allez a I'onglet Soumission de document > E;' > Onglet Rendu > Cochez
"Appliquer Rendu" > OK > Cliquez deux fois sur un titre de document > Onglet Rendu

Rendu — pour un

document par défaut

Rendu — pour un
travail

Renommer une image

récupérée ou
numeérisée

Options Par défaut: Allez a I'onglet Soumission de document > E’\fh > Onglet Rendu > Cochez "Appliquer
rendu” > OK > Bouton Modifier les options par défaut > onglet Rendu

Onglet Soumission de document > @ > Onglet Rendu

Onglet Récupération de document > cliquer avec le bouton droit de la souris sur un titre de document >
Renommer ou mettre en évidence le titre de document et sélectionner Modifier > Renommer

Répertoire de
numérisation

0.1 dans le DRT et
les imagesau
scanner

Onglet récupération de document

Répertoire de

Onglet Récupération de document

récupération

Réseau, options 3 tentatives d'essai EE |

recommencer Intervalle = 10 secondes  Onglet Gestionnaire de périphériques > bouton de barre d’'outils > Ajuster Recommencer la limite et
connexions Recommencer l'intervalle

Rotation auto

Rotation, Document

Oui

Transformation Rotation
auto = Oui

Etiquettes = 90 degrés
Tampons = 90 degrés
Composition = 0
Transformation = 0

L] :-:,
Onglet Soumission de document > ou double clic sur un nom de fichier > Onglet Transformer

kLl
Onglet Soumission de document > D ou double clic sur un nom de fichier, (ou sélectionner un nom de
fichier > Document > Modifier) > sélectionner un onglet : Onglet Transformation, Onglet Composition, Onglet
Tampons, Onglet Etiquettes

Rotation, Options
Travail

Etiquettes =90 degrés
Tampons =90 degrés

)
Onglet Soumission de document > D (ou sélectionner Travail > Options Travail ) > Onglet Tampons,
Onglet Etiquettes
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Scanner, défaut

Sélectionner tout

Onglet Gestionnaire de périphériques
Onglet Soumission de document > Modifier > Sélectionner tout ou cliquer avec le bouton droit de la souris >
Sélectionner tout

Onglet Récupération de document > Modifier > Sélectionner tout ou cliquer avec le bouton droit de la souris >
Sélectionner tout

Supprimer des images
numeérisées ou
récupérées

¥
Onglet Récupération de document > sélectionner un titre de document > % | ou Modifier > Supprimer

Supprimer tous les
fichiers dans un jeu

Onglet Soumission de document > Quand des fichiers sont listés sur la fenétre Soumission de document,
sélectionner Modifier > Annuler tout.

Supprimer un
document dans un jeu

Onglet Soumission de document > Mise en évidence d’un titre de document > Modifier > Supprimer ou cliquer
avec le bouton droit de la souris sur le titre du document > Supprimer

Tampon, pour
documents uniques

Tampon, pour un
document par défaut

Onglet Soumission de document > @ (ou sélectionner Travail > Options Travail ) > Sélectionner
“Appliquer un tampon”, OK> Double clic sur un nom de fichier, (ou sélectionner un nom de fichier > Document >
Modifier) > Onglet Tampons

Onglet Soumission de document > @ (ou sélectionner Travail > Options Travail ) > Sélectionner “Appliquer
un tampon”, OK> Bouton Modifier les options par défaut > Onglet Tampons

Tampon, pour un
travail

Onglet Soumission de document > EE' (ou sélectionner Travail > Options Travail ) > Onglet Tampons

TIFF

m
Onglet Soumission de document > = ou double clic sur un nom de fichier, (ou sélectionner un nom de
fichier > Document > Modifier) > Onglet Configuration > Format de fichier : sélectionner TIFF

Tracé d’orientation

Travail simple page
Travaux d'impression,
actifs

Travaux d'impression,
annuler

Onglet Soumission de document > double clic sur un nom de fichier >
Menu Document > Tracé d’orientation

Allez a I'onglet Soumission de document> Bouton Options de travail> Onglet Composition

Onglet File d'impression > n

Onglet File d'impression > @ ou file d'impression de Web PMT > sélectionner un fichier pour annuler I'écran
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Travaux d’impression,
imprimer dans I'ordre
d’'impression inverse

Travaux d’'impression, .
liste compleéte Onglet File d’impression > =

Sauvegarde les valeurs par défaut de tous les onglets Edition des options de travail :

Onglet Soumission de document ou Eb (ou Travail > Options Travail) Onglet Finition

Valeurs par défaut —

(options de travail)

Valeurs par défaut — Sauvegarde les valeurs par défaut du document de toutes les options d'impression Edition des options

(options dimpression d'impression de document par défaut :
de document par

> Onglet Configuration > Bouton Mettre & jour les valeurs par défaut

défaut.)
> Onglet Configuration > Bouton Mettre a jour les valeurs par défaut
Valeurs par défaut — Sauvegarde les valeurs par défaut du document de toutes les options Edition des options d'impression de
(options d'impression document :
de document) Cliquez deux fois sur un document. Onglet Configuration > Bouton Mettre a jour les valeurs par défaut.

App. Tampor=Non
Rotation=90 degrés

Valeurs par défautde  Echelle = Relati . | D‘“ . . _—
tamponsp Texte = 32 Onglet Soumission de document > E"\j ou = ou double clic sur un nom de fichier (ou sélectionner un
Unités = Pouces nom de fichier > Document > Modifier) > Onglet Tampons

Position X,Y =Centre
Texte X,Y = 0.0

Valeurs par défaut —

Sauvegarde les

valeurs par défaut du

document de toutes

les options ” Onglet Soumission de document > @ > Onglet Configuration > Mettre & jour les valeurs par défaut
d’impression Edition

des options

d'impression de

document par

défaut.
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Valeurs par défaut —
Sauvegarde les
valeurs par défaut du
document de toutes
les options Edition
des options o . i - . . s
nglet Soumission de document > double clic sur un nom de fichier > Onglet Configuration > Mettre a jour les

dimpression qe valeurs par défaut
document (cliquer

deux fois sur le titre
du document. Onglet
Configuration > bouton
Mise & jour des
valeurs par défaut).

Valeurs par défaut —

Sauvegarde les

valeurs par défaut de @

tous les onglets Onglet Soumission de document > = > Configuration > Mettre a jour les valeurs par défaut
Edition des options de

travail.

Version micrologiciel
AccXES utilisée par Onglet Gestionnaire de périphériques > Zone “Version d'imprimante”

I'imprimante

Index

Voir également Annexe 5 pour laliste des fonctions et leur emplacement, ou sélectionnez “Aide > Rubriques d'aide” pour aller al'index
général (Sommaire) afin de consulter les fichiers d'aide.
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A

Accésdenavigation, 85
Activation nécessaire
Appliquer étiquette, 55, 67, 88
Appliquer tampon, 57, 67, 96, 98
Discordance de supports, 87
License Numérisation au réseau, 17
Permis d utilisation
Mode Numérisation, 17
Adressel|P, 19, 77,85
afficheur, 41
Annexe
Chemins de navigation, 78
Valeurs par défaut, 78, 85
Annuler lafenétre Soumission de document, 36, 43
Annuler un travail d’ impression, 71
Assemblage, 35, 36, 42, 79, 80, 81, 82, 86
Combiné avec Ordre d’impression inverse, 35
Assembler, 21, 64

B

Boutons de barre d’ outils
Outil Filed'impression, 70
Outil Gestionnaire de périphériques, 24
Outil Récupération de document, 28, 29
Outil Soumission de document, 35
Boutons debarre d’ outils DRT et choix de menu, 29

C

Chemins de navigation, 53, 69
Composition automatique, 51, 65, 66, 87
Composition automatique, 52
Composition de page, 62

Composition de page, 7, 50, 51
Canvas, 51, 52
Page constituante, 52
Composition de page, 65
Composition de page
Canvas, 65
Composition de page
Page constituante, 65
Composition de page
Canvas, 66
Composition de page, 87
Connexion al’imprimante et au scanner, 24
Contréleur, 6
Convention de dénomination universelle (UNC), 27
Copies, nombre de, 37, 80, 81, 82, 84

D

Demander |es données du compte, 23
Désinstallation du logiciel Outils Client AccXES, 15
Discordance de supports, 87
Données d’ utilisation de support

Sereporter al’outil Facturation, 72

E

Ecransd’ aide— Navigateur Web par défaut, 5
Editeur detrame, 28, 30, 32, 33, 34
Effacer lafenétre Soumission de document, 37
Emboitement de tracé, 65
Emplacement du fichier FIN, 64, 76, 77, 89
Etiquette

Etiquettes de document par défaut, 55
Etiquettes, 67, 96

Appliquer étiquette, 67, 88

Etiquettes detravail, 67
Etiquettes
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Appliquer étiquette, 55
Position de, 56
Exemplaires, nombre de, 62, 92

F

Fonction Facturation
Pour le micrologiciel AccXES 6.2 ou plus avancé, 23
Pour lesversions de micrologiciel AccXES antérieuresa 7.0, 72
Pour micrologiciel AccXES Version 7.0 et plusavancé, 5, 7, 11
Format de fichier, 21, 92
Format de fichier CalComp, 6, 8, 21, 48, 86
Format defichier Calsl, 6, 8, 21, 48, 57, 86
Format defichier Cals2, 6, 8, 21, 48, 86
Format de fichier CGM, 6, 8, 21, 48, 86
Format defichier HPGL, 6, 8, 21, 48, 57, 89
Format de fichier JPEG, 33
Format defichier NIRS, 6, 8, 21, 48, 92
Format defichier PDF, 6, 7, 8, 21, 48, 94
Format defichier PostScript, 48, 64, 94
Format de fichier TIFF, 48, 97
Format defichier TIFF, 6, 8, 21
Formats de papier et derouleau, 64
Formats Papier, 78
Formats papier et tailles de rouleau, 76

G

Glisser et déplacer, 41

ID de compte, 42, 62

ID utilisateur, 42, 62

Image récupérée, 90

Images couleur, 5, 6, 17, 19, 31, 46, 47, 54, 63, 69
IMAGES COULEUR, 54

Images de recouvrement, 51, 65
Images numérisées, 90
Impression detravail, 97
Nombre d’ exemplaires, 92
Impression test, 17
Imprimer au fichier, 27
Initiation rapide, 18
Utilisation de !’ outil Facturation, 23, 73
Utilisation de!’ outil Gestionnaire de périphériques, 19
Utilisation de I’ outil Récupération de document, 20
Utilisation del’ outil Soumission de document, 22
Installation du logiciel Outils Client AccXES, 11, 13
Interface utilisateur d’imprimante, 8
Interface utilisateur du scanner, 23, 32

J

Jeu de documert, 41, 42, 43, 46, 48, 50, 51, 55, 57, 64, 67, 91
Ajouter documents au jeu, 35, 85
Ajouter un document au jeu, 21
Ajouter un fichier récupéré, 41
Copier les options dans un autre document, 37
Créer un jeu de document, 22
Enregistrer un jeu de document comme fichier unique, 37
Imprimer jeu de document ouvert, 35
Imprimer un jeu de document ouvert, 21, 22, 37
Insérer un document dansun jeu, 41
Sauvegarder un jeu de document commefichier simple, 40
Supprimer un fichier du jeu de document, 40

M

Mettreajour lesvaleurs par défaut - Sélectionner ce bouton pour sauvegarder les
réglages d'option du travail en cours, 62

Mettreajour lesvaleurspar défaut — Sélectionner ce bouton pour sauvegarder les
réglages du document en cours, 48
Mirair, 50, 91
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Miseal’ échdle, 46, 58, 86, 89, 91
Miseal' échellevariable, 50, 51, 52, 63, 66, 87, 92
Mot de passe, 11, 13, 23, 73

o

Onglet Composition, 51, 65, 66, 87, 88, 89, 90
Onglet Configuration, 92
Options de document, 48
Onglet Etiquettes, 88
Onglet Finition, 62, 63, 77, 86, 92, 94
Onglet Transformation, 50, 86, 89, 91, 96

Options Coul eur — pour documents simples (voir onglet Support), 46
Options Couleur — pour réglages par défaut (voir onglet Support), 46
Options Couleur — pour travaux d'impression (voir Onglet Couleur), 69
Options d’impression de document par défaut, 15, 44

,44, 61

Options de document par défaut, 38, 41, 44, 45, 53, 69

Options de récupération, 31, 32

Options Finition - pour réglages de document par défaut, 59

Options Finition— pour travaux d'impression, 63
Options Impression de document, 61
Options Justification, 50, 91
Options Rendu, 53, 68
Options Transfor mation, 50
OptionsTravail, 62
Options Travail, 39, 44
Options Travail, 87
Options Travail, 91
Options Travail, 92
Options Travail, 96
Options Travail, 96
Options Travail, 96
Ordre d'impression inverse, 35
Combiné avec Assemblage , 79
Outil de gestion de comptes AccXES, 5, 7, 11
Outil File d'impression, 70

Annuler un travail d’impression, 71
Initiation rapide, 22

Outil Gestion de comptes AccXES, 23
Outil Gestionnaire de périphériques, 24

Configurer laconnexion au réseau, 18
Connexion au scanner et al’imprimante, 24
Initiation rapide, 18

Utilisation de !’ outil Gestionnaire de périphériques, 19
Outil Récupération de document
Liste récapitul ative des boutons et menus de barre d’ outils, 20
Outil Récupération de document

Utilisation de I’ outil Récupération de document, 20

Outil Récupération de document

Initiation rapide, 20

Outil Récupération de document, 28
Outil Soumission de document, 35

Annuler lafenétre Soumission de document, 36, 43
Effacer lafenétre Soumission de document, 37
Initiation rapide, 22

Utilisation del’ outil Soumission de document, 22
Voir Jeu de document, 35

Outils Client AccXES

Acces de navigation pour accéder aux fonctions, 85
Configuration minimum requise, 6

Contenu du Guide de |’ utilisateur, 5
Désinstallation, 15

Initiation rapide, 18

Instalation, 11, 12, 13, 14

Introduction, 5, 11, 13

Présentation, 7

Récapitulatif desfonctions, 85

Utilisation de |’ outil Facturation, 23, 73

Utilisation de!’ outil Gestionnaire de périphériques, 19

Utilisation de I’ outil Récupération de document, 20
Utilisation del’ outil Soumission de document, 22
Valeurspar défaut 85
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Outils Client AccXES
Comment les outils fonctionnent avec |e systéme de fichiers, le scanner, I'imprimante, le
controleur, 9
Ouvrir un jeu de document enregistré, 41

P

Page de garde, 63, 94
PDF file format 31
Plieuse
Ajouter plieuse, 77
Ajouter une plieuse, 64
Bac detri, 64
Méthode depliage, 64, 77
Titre, 64
Typed eplieuse, 64, 77
Positions X, Y, 50, 51, 52, 56, 58, 88, 93
Postscript
Format de fichier, 80
PostScript
Accesde navigation, 85
Avec les options Assemblage et Finition, 36, 42
Avec options Assemblage et Finition, 79
Avec options d’ assemblage et definition, 21
Format defichier, 79, 80, 81, 82, 83, 84
Format defichier, 6, 8, 21

R

Raccourci, 11, 12
Réglage des options de récupération, 31, 32
Réinitialiser , 44
Répertoire de numérisation, 32
Répertoire de récupération, 33
Requéte pour données de facturation, 72, 73
Réseau
Voir Outil Gestionnaire de périphériques, 19

Réseau

Connexion réseau, 10

Créer un nouveau périphérique, 19

Voir Outil Gestionnaire de périphériques, 10
Réseau

Voir Outil Gestionnaire de périphériques 24
Réseau

Voir Outil Gestionnaire de pér iphériques, 25
Résean

Voir Outil Gestionnaire de périphériques , 25
Réseau

Création d’ un nouveau périphérique, 26
Réseau

Voir Outil Gestionnaire de périphériques , 26
Réseau

Voir Outil Gestionnaire de périphériques, 26
Réseau

Voir Outil Gestionnaire de périphériques 26
Réseau

Voir Outil Gestionnaire de périphériques, 26
Réseau

Voir Outil Gestionnaire de périphériques, 27
Réseau

Voir Outil Gestionnaire de périphérique 27
Réseau

Voir outil Gestionnaire de périphériques, 87
Réseau

Voir outil Gestionnaire de péiphériques, 9%
Rotation, 50, 51, 56, 58, 88, 96, 98
Rotation automatique, 50, 96

S

Scanner, 19, 26, 27

Serveurs d’'impression externe, 10
Solaris, 2,6,7,12, 13
Superposition d’images, 90
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Support
Discordance de supports, 87
Format desupport, 6, 78
Format du support, 78
Type de support, 89
Support discordant, 63
Supprimer le document sélectionné, 40

T

Taillesderouleaux, 6, 78
Tampons, 57, 67, 91, 96, 98
Appliquer tampon, 57, 67, 96, 98
Chargement d’ un tampon, 58
Emplacement du tampon, 58
TCT/IP, 10
Télé&chargement — voir Installer lelogiciel Outils Client AccXES, 13, 14
Tiff file format, 37
Titre
pour tous les documents d’ un travail, 64
Tracéd'orientation, 60
Travail d’impression, 97
Annuler un travail d' impression, 71
Assemblage, 35
Attribuer un numéro de compte &, 35
Copies, 35, 37, 80, 81, 82, 84
Nom du travail d’impression, 35
Nombre d’ exemplaires, 62
Options Impression de travail, 62
Ordred’ impressioninverse, 35
Priorité, 8, 35, 39, 41, 62, 70, 71, 95
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Travail d'impression
Copies, o
Type de plieuse, 64, 76, 77, 89

U

Unités, 50, 52, 56, 58, 88, 91, 98

UNIX, 13, 15

Usine, 44

Utilisation del’outil Filed’impression, 71

Utilisation de I’ outil Gestionnaire de périphériques, 19, 26
Utilisation de |’ outil Récupération de document, 20, 31
Utilisation de |’ outil Soumission de document, 22, 41

\%

Valeurspar défaut — Enregistrer lesoptions par défaut de document sous forme de

fichier, 40

Valeurspar défaut —ouvrir— pour remplacer les Options de document des documents

sélectionnés, 40

Valeurspar défaut — utiliser les options par défaut pour le document sélectionné, 40

Viewer, 36
W
Web, 6, 13

X

Xerox.com, 10, 13, 14, 18
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